
 
 
 
 

 

 

 

 

 

 

VIPA System 500S 
 
 
 
 
 
 
 
 

SPEED7 - CPU | 517-4NE02 | Manual 
HB145E_CPU | RE_517-4NE02 | Rev. 10/23 

June 2010 
 

 
 
 
 



 

 

 

Copyright © VIPA GmbH. All Rights Reserved. 

This document contains proprietary information of VIPA and is not to be disclosed or used except in accordance with applicable 
agreements. 

This material is protected by the copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either 
internal or external to VIPA), except in accordance with applicable agreements, contracts or licensing, without the express written 
consent of VIPA and the business management owner of the material. 

For permission to reproduce or distribute, please contact: 
VIPA, Gesellschaft für Visualisierung und Prozessautomatisierung mbH 
Ohmstraße 4, D-91074 Herzogenaurach, Germany 
Tel.: +49 (91 32) 744 -0 
Fax.: +49 9132 744 1864 
EMail: info@vipa.de 
http://www.vipa.de 
 
Note 

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of 
publishing. Nevertheless, the authors retain the right to modify the information. This customer document describes all the hardware 
units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The 
exact scope of delivery is described in the respective purchase contract. 

 

CE Conformity 

Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant 
provisions of the following directives: 

• 2004/108/EC Electromagnetic Compatibility Directive 
• 2006/95/EC Low Voltage Directive 

Conformity is indicated by the CE marking affixed to the product. 

Conformity Information 

For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service 
organization. 

 

Trademarks 

VIPA, SLIO, System 100V, System 200V, System 300V, System 300S, System 400V, System 500S and Commander Compact are 
registered trademarks of VIPA Gesellschaft für Visualisierung und Prozessautomatisierung mbH.  

SPEED7 is a registered trademark of profichip GmbH. 

SIMATIC, STEP, SINEC, S7-300 and S7-400 are registered trademarks of Siemens AG. 

Microsoft und Windows are registered trademarks of Microsoft Inc., USA. 

Portable Document Format (PDF) and Postscript are registered trademarks of Adobe Systems, Inc. 

All other trademarks, logos and service or product marks specified herein are owned by their respective companies. 

 

Information product support 

Contact your local VIPA Customer Service Organization representative if you wish to report errors or questions regarding the contents 
of this document. If you are unable to locate a customer service center, contact VIPA as follows: 

VIPA GmbH, Ohmstraße 4, 91074 Herzogenaurach, Germany 

Telefax:+49 9132 744 1204 
EMail: documentation@vipa.de 

 

Technical support 

Contact your local VIPA Customer Service Organization representative if you encounter problems with the product or have questions 
regarding the product. If you are unable to locate a customer service center, contact VIPA as follows: 

VIPA GmbH, Ohmstraße 4, 91074 Herzogenaurach, Germany 

Telephone: +49 9132 744 1150/1180 (Hotline)  
EMail: support@vipa.de 

 



Manual VIPA System 500S SPEED7 Contents 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  i 

Contents 
 

 
 
About this manual .................................................................................... 1 
Safety information.................................................................................... 2 
Chapter 1 Basics .............................................................................. 1-1 

Safety Information for Users................................................................. 1-2 
Principles of Net-ID, Subnet-ID, Host-ID .............................................. 1-3 
Operating structure of a CPU............................................................... 1-6 
CPU Applications ................................................................................. 1-7 
Operands of the CPU........................................................................... 1-7 
CPU 517S/NET .................................................................................... 1-9 

Chapter 2 Hardware description ..................................................... 2-1 
Properties............................................................................................. 2-2 
Structure .............................................................................................. 2-3 
Components......................................................................................... 2-4 
Technical Data ................................................................................... 2-10 

Chapter 3 Deployment CPU 517S/NET............................................ 3-1 
Overview .............................................................................................. 3-2 
Assembly.............................................................................................. 3-3 
Installation of the driver ........................................................................ 3-4 
Guidelines for IP address assignment .................................................. 3-5 
Connect power supply.......................................................................... 3-8 
Initialization of the CPU component.................................................... 3-10 
Internal access to PG/OP channel ..................................................... 3-14 
External access to PG/OP channel via routing ................................... 3-15 
Access to the integrated web page .................................................... 3-18 
Project engineering ............................................................................ 3-20 
CPU parameterization ........................................................................ 3-24 
Project transfer................................................................................... 3-35 
Operating modes................................................................................ 3-40 
Overall reset....................................................................................... 3-43 
Firmware update ................................................................................ 3-45 
Factory reset ...................................................................................... 3-48 
Memory expansion with MCC............................................................. 3-49 
Extended know-how protection........................................................... 3-50 
MMC-Cmd - Auto commands ............................................................. 3-52 
VIPA specific diagnostic entries ......................................................... 3-54 
Using test functions for control and monitoring of variables................ 3-58 

Chapter 4 Deployment CPU with Profibus ..................................... 4-1 
Overview .............................................................................................. 4-2 
Project engineering CPU with integrated Profibus master .................... 4-3 
Deployment as Profibus DP slave ........................................................ 4-5 
Project transfer..................................................................................... 4-7 
Profibus installation guidelines ............................................................. 4-8 
Commissioning and Start-up behavior................................................ 4-11 

 



Contents Manual VIPA System 500S SPEED7 

ii  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

Chapter 5 Deployment PtP communication ................................... 5-1 
Fast introduction................................................................................... 5-2 
Principle of the data transfer ................................................................ 5-3 
Deployment of RS485 interface for PtP................................................ 5-4 
Parameterization .................................................................................. 5-6 
Communication .................................................................................... 5-9 
Protocols and procedures .................................................................. 5-15 
Modbus - Function codes ................................................................... 5-19 
Modbus - Example communication..................................................... 5-23 

Chapter 6 Deployment Ethernet communication........................... 6-1 
Basics - Industrial Ethernet in automation ............................................ 6-2 
Basics - ISO/OSI reference model ....................................................... 6-3 
Basics - Terms ..................................................................................... 6-6 
Basics - Protocols ................................................................................ 6-7 
Basics - IP address and subnet.......................................................... 6-11 
Basics - MAC address and TSAP....................................................... 6-13 
Fast introduction................................................................................. 6-14 
Hardware configuration ...................................................................... 6-18 
Configure connections........................................................................ 6-20 
Communication connections in the user program............................... 6-30 
NCM diagnostic - Help for error diagnostic......................................... 6-37 
Coupling to other systems.................................................................. 6-40 

Chapter 7 Deployment PLC-Tool..................................................... 7-1 
General ................................................................................................ 7-2 
Setup and run of program .................................................................... 7-3 
PLC-Tool Operation ............................................................................. 7-4 
Deployment PLC-Tool .......................................................................... 7-7 

Chapter 8 WinPLC7 .......................................................................... 8-1 
System presentation............................................................................. 8-2 
Installation............................................................................................ 8-3 
Example project engineering ................................................................ 8-4 

Appendix ................................................................................................A-1 
Index ....................................................................................................A-1 

 
 
 



Manual VIPA System 500S SPEED7 About this manual 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  1 

About this manual 
 

This product supplement contains all information required for the 
deployment of the Slot-PLC 517S/NET in your PC. The here described 
Slot-PLC is a SPEED7 517S/NET with integrated Profibus-DP master. The 
CPU is included in the PC as Ethernet interface and can be accessed via 
the IP address. 
 
Chapter 1: Basics 
This Basics contain hints for the usage and information about the project 
engineering of a System 500S SPEED7 from VIPA. 
Basic information about the structure of IP addresses can be found further. 
 

Chapter 2: Hardware description  
In this chapter the hardware components of the CPU 517S/NET are more 
described here. 
The chapter closes with the technical data. 
 
Chapter 3: Deployment CPU 517S/NET 
Main topic of this chapter is the deployment of the CPU 517S/NET from 
VIPA. Here information necessary for installation, start-up and project 
engineering can be found. 
 
Chapter 4: Deployment with Profibus 
Content of this chapter is the deployment of the CPU 517S/NET with 
Profibus. After a short overview the project engineering and 
parameterization of a CPU 517S/NET with integrated Profibus-Part from 
VIPA is shown.  
Further you get information about usage as DP master and DP slave of the 
Profibus part.  
The chapter is ended with notes to commissioning and start-up. 
 
Chapter 5: Deployment PtP Communication 
In this chapter the deployment of the RS485 slot for serial PtP 
communication is described.  
Here you’ll find all information about the protocols and project engineering 
of the interface, which are necessary for the serial communication using 
the RS485 interface. 
 
Chapter 6: Deployment TCP/IP 
In this chapter the communication via Ethernet is described. Please regard 
the chapter "Fast introduction" where you will find every information 
compressed required for the project engineering of the CPU 517S/NET 
with CP 543. After the fast introduction, the mentioned steps are described 
in detail. 

Overview 
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Chapter 7: Deployment PLC-Tool 
This chapter contains the description of the control software PLC-Tool from 
VIPA. PLC-Tool is a component of the OPC-Server package and is 
installed together with the OPC server at the standard installation.  
The OPC-Server package may be found at the enclosed CD SW-
ToolDemo. 
 
Chapter 8: WINPLC7 
In this chapter the programming and simulation software WinPLC7 from 
VIPA is presented. WinPLC7 is suited for every with Siemens STEP®7 
programmable PLC. 
Besides the system presentation and installation here the basics for using 
the software is explained with a sample project. 
More information concerning the usage of WinPLC7 may be found in the 
online help respectively in the online documentation of WinPLC7. 
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This manual describes the System 500S SPEED7 517S/NET from VIPA.  
It contains a description of the construction, project implementation and 
usage. 
This manual is part of the documentation package with order number  
HB145E_CPU and relevant for:  
 

Product Order number as of state: 
  CPU-HW CPU-FW DPM-FW CP-FW 
CPU 517S/NET VIPA 517-4NE02 01 V351 V326 V259 

 
The manual is targeted at users who have a background in automation 
technology. 
 

The manual consists of chapters. Every chapter provides a self-contained 
description of a specific topic. 
 

The following guides are available in the manual: 
• an overall table of contents at the beginning of the manual 
• an overview of the topics for every chapter 
• an index at the end of the manual. 
 

The manual is available in: 
• printed form, on paper 
• in electronic form as PDF-file (Adobe Acrobat Reader) 
 

Important passages in the text are highlighted by following icons and 
headings: 
 

Danger! 
Immediate or likely danger. 
Personal injury is possible. 
 

Attention! 
Damages to property is likely if these warnings are not heeded. 
 

Note! 
Supplementary information and useful tips. 

 

Objective and 
contents 

Target audience 

Structure of the 
manual 

Guide to the 
document 

Availability 

Icons 
Headings 
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Safety information 
 

The SPEED7 CPU is constructed and produced for: 
• communication and process control 
• general control and automation applications 
• industrial applications 
• operation within the environmental conditions specified in the technical 

data 
• installation into a cubicle 
 

Danger! 
This device is not certified for applications in 
• in explosive environments (EX-zone) 
 

The manual must be available to all personnel in the 
• project design department 
• installation department 
• commissioning 
• operation 
 

The following conditions must be met before using or commissioning 
the components described in this manual: 
 
• Modification to the process control system should only be carried out 

when the system has been disconnected from power! 
 
• Installation and modifications only by properly trained personnel 
 
• The national rules and regulations of the respective country must be 

satisfied (installation, safety, EMC ...) 
 

National rules and regulations apply to the disposal of the unit! 
 
 
 

 

Applications 
conforming with 
specifications 

 

Documentation 

 

Disposal 
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Chapter 1  Basics 
 

This Basics contain hints for the usage and information about the project 
engineering of a System 500S SPEED7 from VIPA.  
Basic information about the structure of IP addresses can be found further.  
 

 

Topic     Page 
Chapter 1 Basics .............................................................................. 1-1 

Safety Information for Users................................................................. 1-2 
Principles of Net-ID, Subnet-ID, Host-ID .............................................. 1-3 
Operating structure of a CPU............................................................... 1-6 
CPU Applications ................................................................................. 1-7 
Operands of the CPU........................................................................... 1-7 
CPU 517S/NET .................................................................................... 1-9 

 

 
 

Overview 

Content 
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Safety Information for Users 
 

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages 
that can occur during electrostatic discharges. 
The following symbol is attached to modules that can be destroyed by 
electrostatic discharges. 
 

 
 
The Symbol is located on the module, the module rack or on packing 
material and it indicates the presence of electrostatic sensitive equipment. 
It is possible that electrostatic sensitive equipment is destroyed by energies 
and voltages that are far less than the human threshold of perception. 
These voltages can occur where persons do not discharge themselves 
before handling electrostatic sensitive modules and they can damage 
components thereby, causing the module to become inoperable or 
unusable. 
Modules that have been damaged by electrostatic discharges can fail after 
a temperature change, mechanical shock or changes in the electrical load. 
Only the consequent implementation of protection devices and meticulous 
attention to the applicable rules and regulations for handling the respective 
equipment can prevent failures of electrostatic sensitive modules. 
 

Modules must be shipped in the original packing material. 
 

When you are conducting measurements on electrostatic sensitive 
modules you should take the following precautions: 
• Floating instruments must be discharged before use. 
• Instruments must be grounded. 
Modifying electrostatic sensitive modules you should only use soldering 
irons with grounded tips. 
 

Attention! 
Personnel and instruments should be grounded when working on 
electrostatic sensitive modules. 

 

Handling of 
electrostatic 
sensitive modules 

Shipping of 
electrostatic 
sensitive modules 

Measurements and 
alterations on 
electrostatic 
sensitive modules 
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Principles of Net-ID, Subnet-ID, Host-ID 
 

The CPU 51xS PC plug-in card consists of a CPU and an Ethernet portion 
that communicate via a TCP-based point-to-point connection. To enable 
this, CPU and Ethernet portion each have an alterable IP address that may 
only differ in the Host-ID.  
 

Ethernet

IP-Adr: .Host-ID
Subnet

PCI slot

Ethernet communication

PCI communication

PC

CPU 51xS
CPU

IP-Adr: .Host-ID
Subnet

CPU

Eth

Siemens SIMATIC
Manager

Windows driver

 
 
 
If you want to install several CPU 51xS in one PC, every CPU 51xS plug-in 
card needs an own Net-ID. 
The following text describes the approach for the assignment of IP 
addresses together with Net-ID and Host-ID.  
 

Why Principles? 
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Every IP address is a combination of a Net-ID and a Host-ID.  
The Network-ID identifies a network res. a network controller that 
administrates the network. 
The Host-ID marks the network connections of a participant (host) to this 
network.  
 

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by 
using an bit for bit AND assignment with the Subnet-Mask.  
The area of the original Host-ID that is overwritten by 1 of the Subnet-Mask 
becomes the Subnet-ID, the rest is the new Host-ID. 
 
Subnet-Mask binary all "1" binary all "0" 
IPv4 address Net-ID  Host-ID 
Subnet-Mask and  IPv4 address Net-ID Subnet-ID new Host-ID 

 
A TCP-based communication via point-to-point, hub or switch connection is 
only possible between stations with identical Network-ID and Subnet-ID! 
Different area must be connected with a router. 
The Subnet-Mask allows you to sort the resources after your needs. This 
means e.g. that every department gets an own subnet and thus does not 
interfere another department. 
 

Note! 
When using the CPU 51xS in your PC, the Net-ID of the CPU 51xS must 
not be assigned to another device. Otherwise you have to reassign the 
addresses. 

Net-ID 
Host-ID 

Subnet-Mask 
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For IPv4 addresses there are five address formats (class A to class E) that 
are all of a length of 4byte = 32bit.  
 
Class A 0 Network-ID 

(1+7 bit) 
Host-ID (24 bit) 

Class B 10 Network-ID (2+14 bit) Host-ID (16 bit) 
Class C 110 Network-ID (3+21 bit) Host-ID (8 bit)
Class D 1110 Multicast group 
Class E 11110 Reserved 

 
The classes A, B and C are used for individual addresses, class D for 
multicast addresses and class E is reserved for special purposes. 
The address formats of the classes A, B, C are only differing in the length 
of Network-ID and Host-ID. 
 
 
To build up private IP-Networks within the internet, RFC1597/1918 
reserves the following address areas: 
 
Network 
class 

Start IP End IP Standard Subnet Mask 

A 10.0.0.0 10.255.255.255 255.0.0.0 
B 172.16.0.0 172.31.255.255 255.255.0.0 
C 192.168.0.0 192.168.255.255 255.255.255.0 
(The Host-ID is underlined.) 

 
These addresses can be used as net-ID by several organizations without 
causing conflicts, for these IP addresses are neither assigned in the 
internet nor are routed in the internet. 
 

Some Host-IDs are reserved for special purposes. 
 
Host-ID = 0  Identifier of this network, reserved! 
Host-ID = maximum (binary complete 1) Broadcast address of this network 
 
 
Note! 
Never choose an IP address with Host-ID=0 or Host-ID=maximum! 
(e.g. for class B with Subnet Mask = 255.255.0.0, the "172.16.0.0" is 
reserved and the "172.16.255.255" is occupied as local broadcast address 
for this network.) 
 

 

Address classes 

Private IP 
networks 

Reserved 
Host-Ids 
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Operating structure of a CPU 
 

The CPU contains a standard processor with internal program memory. In 
connection with the integrated SPEED7 Technology receive you efficient 
equipment for process automation. 
 
A CPU supports the following modes of operation:  
 
• cyclic operation 
• timer processing 
• alarm controlled operation 
• priority based processing 
 
 
Cyclic processing represents the major part of all the processes that are 
executed in the CPU. Identical sequences of operations are repeated in a 
never-ending cycle. 
 

Where a process requires control signals at constant intervals you can 
initiate certain operations based upon a timer, e.g. not critical monitoring 
functions at one-second intervals. 
 

If a process signal requires a quick response you would allocate this signal 
to an alarm controlled procedure. An alarm can activate a procedure in 
your program. 
 

The above processes are handled by the CPU in accordance with their 
priority. Since a timer or an alarm event requires a quick reaction, the 
CPU will interrupt the cyclic processing when these high-priority events 
occur to react to the event. Cyclic processing will resume, once the 
reaction has been processed. This means that cyclic processing has the 
lowest priority. 
 

General 

Cyclic processing 

Timer processing 

Alarm controlled 
processing 

Priority based 
processing 
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CPU Applications 
 

The program that is present in every CPU is divided as follows: 
• System routine 
• User application 
 

The system routine organizes all those functions and procedures of the 
CPU that are not related to a specific control application. 
 

This consists of all the functions that are required for the processing of a 
specific control application. The operating modules provide the interfaces 
to the system routines. 
 

Operands of the CPU 
 

The following series of operands is available for programming the CPU: 
• Process image and periphery 
• Bit memory 
• Timers and counters 
• Data blocks 
 

The user application can quickly access the process image of the inputs 
and outputs PAA/PAE. You may manipulate the following types of data: 
• individual Bits 
• Bytes 
• Words 
• Double Words 
 
You may also gain direct access to peripheral modules via the bus from 
user application. The following types of data are available: 
• Bytes 
• Words 
• Blocks 

Overview 

System routine 

User application 

Overview 

Process image 
and periphery 
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The bit memory is an area of memory that is accessible by means of 
certain operations. Bit memory is intended to store frequently used working 
data. 
You may access the following types of data: 
• individual Bits 
• Bytes 
• Words 
• Double words 
 

In your program you may load cells of the timer with a value between 10ms 
and 9990s. As soon as the user application executes a start-operation, the 
value of this timer is decremented by the interval that you have specified 
until it reaches zero. 
You may load counter cells with an initial value (max. 999) and increment 
or decrement these when required. 
 

A data block contains constants or variables in the form of bytes, words or 
double words. You may always access the current data block by means of 
operands.  
You may access the following types of data: 
• individual Bits 
• Bytes 
• Words 
• Double words 
 

 

Bit Memory  

Timers and 
counters 

Data Blocks 
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CPU 517S/NET 
 

The CPU 517S/NET is a fully adequate PLC-CPU in form of a PCI-slot 
card for PC-based applications. The operating systems Windows® 98, ME, 
NT4, 2000 and XP are supported.  
The range of performance is adequate to a SPEED7 CPU  from the 
System 300S from VIPA. The programming takes place via standard 
programming tools like e.g. WinPLC7 from VIPA or STEP 7 from Siemens. 
For the link up to the process level there is as well a MPI as a Profibus DP 
master interface. The integrated CP 543 communicate via a twisted pair 
interface. 
Further on, the VIPA OPC-Server is included in the delivery. 
After the hardware installation, the card is linked up to the PC as COM 
interface. The CPU component of the CPU 517S slot card can only be 
operated with an external or internal DC 24V power supply. The external 
supply enables the operation of the card outside of a PC res. independent 
from the PC operation. Please consider for operation that the slot card is 
connected to ground via its metal cover.  
 

The CPU has an integrated work memory. During program run the total 
memory is divided into 50% for program code and 50% for data. 
There is the possibility to extend the total memory to its maximum by 
means of a MCC memory extension card. 
 

The CPU has an Ethernet interface for PG/OP communication. Only in 
installed condition you have access via the PG/OP channel to your CPU. 
Here you may program, remote control or show the integrated web page.  
There are maximum 4 channels. 
 

The CPU has an integrated Profibus DP master. Via the DP master with a 
data range of 1kByte for in- and output up to 124 DP slaves may be 
addressed. The project engineering takes place in WinPLC7 from VIPA or 
in the hardware configurator from Siemens. Please regard there may be a 
delimitation of the maximum number of configurable DP slaves by the use 
of the Siemens SIMATIC manager. 
The Profibus part may also be used as "intelligent" DP slave. More may be 
found at "Deployment CPU with Profibus". 
During operation the data range of the DP master is monitored at an 
adjustable address area of the CPU. The address area may be by 
hardware configuration. 
 

The integrated CP 543 offers you a communication processor. This serves 
32 PG/OP channels and 16 by Siemens NetPro respectively 64 by user 
program configurable productive connections. 

Overview 

Memory 
management 

Integrated 
Ethernet-PG/OP-
channel 

Integrated 
Profibus DP 
master 

Integrated  
CP 543 
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The Slot PLC includes a MPI interface. On delivery the default MPI address 
is 2. This address my be changed at any time via your CPU project 
engineering tool. 
 

• External power supply of the CPU (autarkic operation) 
• ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)    
• Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G) 
 

• Operating temperature: 0 ... +60°C 
• Storage temperature: -25 ... +70°C 
• Relative humidity: 5 ... 95% without condensation 
• Fanless operation 
 

The SPEED7 CPUs from VIPA are instruction compatible to the 
programming language STEP®7 from Siemens and may be programmed 
via WinPLC7 from VIPA or via the Siemens SIMATIC Manager. 
Here the instruction set of the S7-400 from Siemens is used. 
 
Note! 
Please do always use the CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0) 
from Siemens of the hardware catalog to project a CPU 517S/DPM from 
VIPA. 
For the project engineering, a thorough knowledge of the Siemens 
SIMATIC Manager and the hardware configurator from Siemens is 
required! 
 

The CPU component of the 517S slot card can only be operated with an 
external or internal DC 24V power supply. Simultaneous infeed should 
absolutely be avoided! 
Please consider for operation that the slot card is connected to ground via 
its metal cover. 
When connecting please consider that the internal power supply hardware 
conditionally does not have an EMV filter for protection against 
disturbances. 
 

For operating the CPU via the PC the program "PLC-Tool" is included in 
the consignment. For monitoring and operating of the CPU, your PC shows 
an user interface that is modeled on the schematic view on a CPU front.  
Via the PLC-Tool you may request the LED state and monitor res. change 
the operating mode of the CPU. 
 

 

MPI interface 

Operating security 

Environment 
conditions 

Compatibility 
 

     

Power supply 

Operating options 
via PLC-Tool 
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Chapter 2  Hardware description  
 

In this chapter the hardware components of the CPU 517S/NET are more 
described here. 
The chapter closes with the technical data. 
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Properties 
 

• Integrated SPEED7 technology 
• Instruction compatible to STEP®7 from Siemens  
• Project engineering via the SIMATIC Manager from Siemens 
• Integrated DC 24V power supply  
• MPI with max. 32 PG/OP connections with up to 12Mbit/s 
• Status-LEDs for operating state and diagnosis 
• Battery buffer for RAM and clock 
• Integrated Profibus DP master 
• Integrated CP 543 Communication processor 
• Integrated work memory 2Mbyte expandable up to 8Mbyte  

(50% program - 50% data) 
• Storage media slot for project engineering and firmware update 
• 2048 Timer, 2048 Counter, 16384 Memory-Byte 
 

 
 
 

Type Order number Description 
517S/NET VIPA 517-4NE02 2Mbyte work memory expandable up to 8Mbyte  

(50% code - 50% data), external power supply, 
MPI, MMC slot, real time clock, 
Interface: Profibus DP master, 12Mbit/s, up to 124 slaves,  
PCI-Ethernet interface for PG/OP communication, incl.  
SW110A2LA OPC-Server (SW110A2LA please order separate).
Incl. Drivers and SW860R OPC-Server (on the ToolDemo-CD) 
2. slot: Ethernet CP 543, S7 communication, RFC1006, H1, 
TCP/IP, UDP, up to 64 connections 

 

CPU 517S/NET 
517-4NE02  

Ordering data 
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Structure 
 

 
 
 

 

12

7

8

9

10

6
11

 

 
 

[1] Clamp for internal DC 24V power supply 
[2] LEDs for commissioning (here covered by Ethernet part) 
[3] Lithium accu for clock and user memory (here covered by Ethernet part) 
[4] Storage media slot (here MMC is plugged) 
[5] PCI bus pins 
[6] RUN/STOP LEDs 
[7] Operating mode switch 
[8] Profibus DP master jack 
[9] Plug for external DC 24V power supply 

[10] MPI jack 
[11] LEDs CP 543 communication 
[12] Twisted pair interface for CP 543 communication 

 

CPU 517S/NET 
517-4NE02 
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Components 
 

On the plug-in module you can see a LED bar for status monitoring of the 
CPU and the Profibus DP master. Especially at the commissioning and the 
external usage of the module, the state of your CPU and your Profibus-DP 
master is shown. 
At deployment inside a PC, you may issue the state of the LEDs on your 
PC via the delivered software PLC-Tool. 
The usage and the according colors of the LEDs are to see in the following 
tables: 
 
Master operation 
RUN 
green 

ERR 
red 

DE 
green

IF 
red 

Meaning 

○ ○ ○ ○ 
Master has no project, this means the DP 
interface is not used. 

● ○ ☼ ○ 
Master is in "clear" state (safety state). The 
inputs of the slaves may be read. The outputs 
are disabled. 

● ○ ● ○ 
Master is in "operate" state (CPU RUN), this 
means data exchange between master and 
slaves. The outputs may be accessed. 

● ● ☼ ○ 

● ● ● ○ 
At least 1 slave is missing. 

○ ○ ○ ● Initialization error at faulty parameterization. 

○ ● ○ ● Waiting state for start command from CPU 
(state at start-up).  

 
Slave operation 
RUN 
green 

ERR 
red 

DE 
green

IF 
red 

Meaning 

○ ○ ○ ○ Slave has no project respectively. 

☼ ○ ○ ○ Slave is without master. 

☼ ○ ☼ ○ Alternate flashing at configuration faults. 

● ○ ● ○ Slave exchanges data between master. 
   

on: ● off: ○ flashing: ☼ 
 

LED bar 
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Label Color Description 

Ethernet 
COLL green Collision: on: total duplex operation active 

off: half duplex operation active 
blinking: Collision detected 

SPEED green Speed: on: 100Mbit 
off: 10Mbit 

LINK green Link on: physical connection detected 
off: no physical connection 

CPU 
MMC yellow blinks at MMC access 
FRCE yellow blinks as soon as variable are forced (fixed) 

SF red blinks at system errors (hardware defect) 
PWR green CPU section is provided internal with 5V 

 

Above the operating mode lever there are 2 LEDs, showing the operating 
state of the CPU: 

Label Color Description 
ST yellow CPU is in STOP 
RN green CPU is in RUN 

 

The following table shows how the diagnostic LEDs of the integrated CP 
543 are used along with the respective colors. 
 

Name. Color Description 
PW green Indicates internal power supply of CP 543 
RN green The CP RUNs with a loaded project. The communica-

tion by configured connections is enabled. 
ST yellow ON at STOP and connections are blocked. 
SF red ON at error 
L/A green Link/Activity  

ON: Physically connected 
OFF: Physically not connected 
Blinking: Ethernet activity 

 

S green Speed:  
ON: 100Mbit 
OFF: 10Mbit. 

 

... continue 
LEDs 

LEDs at 
connection panel 

LEDs 
CP 543 
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On the PC plug-in module the following jacks are led out: 
 
 
Via the 9pin RS485 interface you link up the integrated Profibus DP master 
to Profibus. The RS485 interface in PtP operation supports the serial 
process connection to different source or destination systems. 
The RS485 jack has the following pin occupancy: 
 
 

 9-pin jack 
Pin Assignment 
1 shield 
2 M24V 
3 RxD/TxD-P (Line B) 
4 RTS 
5 M5V 
6 P5V 
7 P24V 
8 RxD/TxD-N (Line A) 

5

4

3

2

1

9

8

7

6

 9 n.c. 
 

Note! 
Please make sure to activate the terminating resistors at the bus ends! 
 

MPI serves the connection to the process level. Here you may transfer 
programs and data between the MPI participants. On delivery the MPI 
address is 2. 
For a serial transfer from your PC you normally need a MPI transducer. 
The MPI jack has the following pin assignment: 
 

 9-pin jack 
Pin Assignment 
1 reserved (must not be connected) 
2 M24V 
3 RxD/TxD-P (Line B) 
4 RTS 
5 M5V 
6 P5V 
7 P24V  
8 RxD/TxD-N (Line A) 

5

4

3

2

1

9

8

7

6

 9 n.c. 
 

Jacks and plugs 

Profibus DP 
master interface 
PBDP/PtP 

     

MPI interface 
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The CPU 517S/NET has a communication processor CP 543 integrated. 
This serves 16 configurable connections via NetPro, 64 configurable 
connections via user program and 32 PG/OP connections.  
The project engineering happens using NetPro from Siemens as  
CP343-1EX11. 
Via the RJ45 jack you may connect the CP to Twisted-Pair-Ethernet. 
The slot has the following pin assignment: 
 

RJ45 jack 8-pin RJ45 jack: 
Pin Signal 
1 Transmit + 
2 Transmit - 
3 Receive + 
4 - 
5 - 
6 Receive - 
7 - 

1
2
3
4
5
6
7
8

 

8 - 
 

As external storage medium for applications and firmware you may use a 
MMC storage module (Multimedia card) or a configured MMC as MCC 
memory extension card. The MCC can additionally be used as an external 
storage medium. 
Both VIPA storage media are pre-formatted with the PC format FAT16 and 
can be accessed via a card reader.  
 

Every CPU 51xS has an integrated work memory. During program run the 
total memory is divided into 50% for program code and 50% for data. 
There is the possibility to extend the total memory to its maximum by 
means of a Memory Configuration Card called MCC. 
 

Attention! 
At deployment of a MMC, please regard, that it has to be preformatted with 
the FAT16 file system. The VIPA memory cards are always delivered 
preformatted. 
 

With the operating mode switch you may switch the CPU between STOP 
and RUN. The operating mode START-UP is driven automatically from the 
CPU between STOP and RUN. 
Placing the switch to Memory Reset (MRES), you request an overall reset  
with following load from MMC (project or firmware update).  
 

 

CP 543  

Storage media  
slot 

Memory 
management 

 

Operating mode 
switch 

RN

ST

MR 
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After the CPU 51xS slot card is installed in the PC and the communication 
between PC and Ethernet component is established the DC 24V power 
supply may be attached. 
The CPU component of the CPU 51xS slot card can only be operated with 
an external or internal DC 24V power supply. The external supply enables 
the operation of the card outside of a PC res. independent from the PC 
operation. Please consider for operation that the slot card is connected to 
ground via its metal cover.  
 
Note! 
The CPU 51xS is to supply either externally or internally with DC 24V. 
Simultaneous infeed should absolutely be avoided! 
 

For external power supply there is a plug on slot panel with the following 
pin assignment: 

DC 24V

GND

 
 
For the internal power DC 24V supply there is a clamp on the top of the slot 
card. 
Please consider when connecting a DC 24V power supply that the internal 
power supply hardware conditionally does not have an EMC filter for 
protection against disturbances (like e.g. EN 61000-4-4 [Burst], EN 61000-
4-5 [Surge] or EN 61000-4-6 [conducted disturbance variable, inducted by 
HF fields]).  
Here please use an accordingly filtered supply voltage here. 
 
The clamp has the following pin assignment: 
 

+-
DC 24VGND

 
 

Power supply 

     

External  
power supply 

Internal  
power supply 
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The CPU 51xS contains an internal accumulator/battery for protecting the 
RAM at a power break-down. Additionally the battery buffers the internal 
clock. 
The battery is directly reloaded via the integrated voltage supply by means 
of a special loading electronic and guarantees a buffer of minimum 30 
days. 
The battery has to be error free, so that the CPU may automatically restart. 
A start with a defective battery is possible, if it is manually switched to RUN 
or if a MMC is plugged, which contains a valid s7prog.wld project with an 
OB81 for battery fault. 
If there is an error concerning the integrated battery, the CPU should be 
checked. Here please contact VIPA! 
 

Battery buffer for 
clock and RAM 
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Technical Data  
 
 

Order number VIPA 517-2NE02 
Type CPU 517S/NET 
Technical Data power supply  
Power supply (rated value) DC 24V 
Power supply (permitted range) DC 20.4...28.8V 
Reverse polarity protection yes 
Current consumption (no-load operation) 360mA 
Current consumption (rated value) 1.2A 
Inrush current 5A 
Load and working memory  
Load memory, integrated 8MB 
Load memory, maximum 8MB 
Work memory, integrated 2MB 
Work memory, maximum 8MB 
Memory divided in 50% program / 50% data yes 
Memory Card Slot MMC-Card with max. 1GB 
Hardware configuration  
Number of DP master integrated 1 
CP 543 integrated 1 
Status information, interrupts, diagnostics  
Status display yes 
Interrupts no 
Process interrupt no 
Diagnostic interrupt no 
Command processing times  
Bit instructions, min. 0.01µs 
Word instructions, min. 0.01µs 
Double integer arithmetic, min. 0.01µs 
Floating-point arithmetic, min. 0.06µs 
Timer/Counter and retentive characteristic  
Number of S7 counters 2048 
Number of S7 timers 2048 
Data range and retentive characteristic  
Number of flags 16384Byte 
Number of data blocks 8190 
Max. data blocks size 64KB 
Max. local data size per execution level 510Byte 
Blocks  
Number of OBs 24 
Number of FBs 8191 
Number of FCs 8191 
Maximum nesting depth per priority class 8 
Maximum nesting depth additional within an error OB 4 
Time  
Real-time clock buffered yes 
Clock buffered period (min.) 6 weeks 
Accuracy (max. deviation per day) 10s 
Number of operating hours counter 8 
Clock synchronization yes 
Synchronization via MPI MasterSlave 
Synchronization via Ethernet (NTP) Slave 
Address areas (I/O)  
Input I/O address area 8192Byte 
Output I/O address area 8192Byte 
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Order number VIPA 517-2NE02 
Input processing image maximal 8192Byte 
Output processing image maximal 8192Byte 
Digital inputs 65536 
Digital outputs 65536 
Analog inputs 4096 
Analog outputs 4096 
Communication functions  
PG/OP channel yes 
Global data communication yes 
Number of GD circuits, max. 16 
Size of GD packets, max. 54Byte 
S7 basis communication yes 
S7 basis communication, user data per job 76Byte 
S7 communication yes 
S7 communication as server yes 
S7 communication, user data per job 160Byte 
Number of connections, max. 32 
Functionality Sub-D interfaces  
Type X2 
Type of interface RS485 
Connector SubD, 9-pin, female 
Electrically isolated yes 
MPI yes 
Type X3 
Type of interface RS485 
Connector SubD, 9-pin, female 
Electrically isolated yes 
DP master yes 
DP slave yes 
Functionality Profibus master  
PG/OP channel yes 
Routing yes 
S7 basis communication yes 
S7 communication yes 
S7 communication as Server yes 
SYNC/FREEZE yes 
Activation/Deactivation of DP slaves yes 
DPV1 yes 
Transmission speed, min. 9.6kbit/s 
Transmission speed max. 12Mbit/s 
Number of DP slaves, max. 32 
Address range inputs, max. 1KB 
Address range outputs, max. 1KB 
User data inputs per slave, max. 244Byte 
User data outputs per slave, max. 244Byte 
Functionality Profibus slave  
PG/OP channel yes 
Routing yes 
S7 communication yes 
S7 communication as Server yes 
DPV1 yes 
Transmission speed min. 9.6kbit/s 
Transmission speed max. 12Mbit/s 
Transfer memory inputs, max. 244Byte 
Transfer memory outputs, max. 244Byte 
Address areas, max. 32 
User data per address area, max. 32Byte 
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Order number VIPA 517-2NE02 
Functionality PCI interfaces  
Type n/a 
Type of interface Ethernet 10/100Mbit 
Connector PCI bus 
Electrically isolated no 
PG/OP channel yes 
Functionality RJ45 interfaces  
Type X4 
Type of interface Ethernet 10/100Mbit 
Connector RJ45 
Electrically isolated yes 
PG/OP channel yes 
Ethernet communication CP  
Number of productive connections, max. 16 
Number of productive connections by Siemens NetPro, max. 16 
S7 connections USEND, URCV, BSEND, BRCV, 

GET, PUT, connection 
establishment active and passive 

User data per S7 connection, max. 32 
TCP connections SEND, RECEIVE, FETCH PASSIV, 

WRITE PASSIV, establishment 
active and passive 

User data per TCP connection, max. 64KB 
ISO connection SEND, RECEIVE, FETCH 

PASSIVE, WRITE PASSIVE, 
establishment active and passive 

User data per ISO connections, max. 8KB 
ISO on TCP connections (RFC 1006) SEND, RECEIVE, FETCH 

PASSIVE, WRITE PASSIVE, 
establishment active and passive 

User data per ISO on TCP connections, max. 32KB 
UDP connections SEND and RECEIVE 
User data per UDP connections, max. 2KB 
UDP-multicast-connections SEND and RECEIVE  

(max. 16 multicast cycles) 
UDP-broadcast-connections SEND 
Mechanical Data  
Dimensions (WxHxD) 40mm x 106mm x 174mm 
Weight 290g 
Environment conditions  
Operating temperature 0°C to 60°C 
Storage temperature -25°C to 70°C 
Certification  
UL508 certification in preparation 
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Chapter 3  Deployment CPU 517S/NET 
 

Main topic of this chapter is the deployment of the CPU 517S/NET from 
VIPA. Here information necessary for installation, start-up and project 
engineering may be found. 
 

 

Topic     Page 
Chapter 3 Deployment CPU 517S/NET............................................ 3-1 

Overview .............................................................................................. 3-2 
Assembly.............................................................................................. 3-3 
Installation of the driver ........................................................................ 3-4 
Guidelines for IP address assignment .................................................. 3-5 
Connect power supply .......................................................................... 3-8 
Initialization of the CPU component.................................................... 3-10 
Internal access to PG/OP channel...................................................... 3-14 
External access to PG/OP channel via routing ................................... 3-15 
Access to the integrated web page..................................................... 3-18 
Project engineering ............................................................................ 3-20 
CPU parameterization ........................................................................ 3-24 
Project transfer................................................................................... 3-35 
Operating modes................................................................................ 3-40 
Overall reset....................................................................................... 3-43 
Firmware update ................................................................................ 3-45 
Factory reset ...................................................................................... 3-48 
Memory expansion with MCC............................................................. 3-49 
Extended know-how protection........................................................... 3-50 
MMC-Cmd - Auto commands ............................................................. 3-52 
VIPA specific diagnostic entries.......................................................... 3-54 
Using test functions for control and monitoring of variables ................ 3-58 

 

 
 

Overview 

Content 
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Overview 
 

The CPU 51xS PC plug-in card consists of an Ethernet (LAN) and a CPU 
component. These communicate internally over an Ethernet connection. 
For this both components are each be assigned to an IP address, which 
may differ only in the Host-ID. In this way several CPU 51xS may be 
operated in your PC.  
The CPU component of the CPU 51xS slot card can only be operated with 
an external or internal DC 24V power supply. The external supply enables 
the operation of the card outside of a PC res. independent from the PC 
operation. Please consider for operation that the slot card is connected to 
ground via its metal cover.  
 
The assignment of IP address parameters for the Ethernet component is 
made by the Windows operating system by the Network environment 
The CPU component receives its IP address parameters by the Siemens 
SIMATIC manager by means of the PLC functions or a minimal project. 
The addresses are not affected by an overall reset. The IP address 
parameters of the CPU component are deleted by a factory reset. 
 

• Install the CPU 51xS PC slot card at a free 32bit PCI slot 
(PCI version 2.2, 32bit data/address bus, 3.3V current). 

• Switch PC on. 
• Install driver for the Ethernet component. This can be found at the 

"ToolDemo-CD" SW900TOLA at driver/slotplc the according CPU 51xS. 
• Set IP address and subnet mask for the Ethernet component of the slot 

card by means of Properties of the Network environment. Here the IP 
addresses may only differ in the Host-ID. 

• Supply CPU component with DC 24V. 
• Assign IP address parameters to the CPU component by means of 

Siemens SIMATIC manager. There are the following possibilities for 
assigning IP address parameters (Initialization): 
- PLC functions with Edith Ethernet Node 
  (search PLC and assign IP address) 

 - Hardware project engineering with CP (Minimal project) 
 
If the "Net" components are installed at your Siemens SIMATIC manager 
the CPU 51xS is displayed as Intel(R) 8255xER PCI Adapter at the 
PG/PC interface area. The CPU can online be accessed by the PG/OP 
channel. 
The steps are detailed described at the following pages. 
 

Functionality 
Ethernet (LAN) 
CPU component 

IP address 
parameter 
assignment 

Steps of 
installation 
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Assembly 
 

• Eliminate possibly existing static loading, before mounting the VIPA PCI 
card, by affecting a grounded metal object. 

• Switch your computer off and remove the power cable. 
• Remove the covers from your computer according to the manufacturers 

instructions. 
• Search a free 32bit PCI slot (usually white ore beige). Please regard that 

your PCI bus corresponds to the following specification: 
PCI version 2.2 , 32Bit data/address bus, 3.3V voltage. 

• Remove one of the metal covers from a slot. Also with the CPU 
517S/NET 1 PCI slot is used. Here an additional slot cover is to be 
removed at the right side. 

• Insert the slot card, bolt the slot card with the computer case and close 
the covers of your computer. 

Please consider that the metal cover of the slot card is always 
connected to ground and bolted with the computer case! 
 

[1] Screw 
[2] Metal slot cover 

 

[3] Metal slot cover, to be  
additionally removed  
for CPU 517S/NET 

 
Note! 
The installation should only be accomplished by experienced technical 
personnel! 
Slot card or PC may be damaged by an incorrect installation. 

Assembly 
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Installation of the driver 
 

A driver is necessary for the integration of the slot card into the operating 
system. The slot card driver may be found at the enclosed CD 
SW900TOLA. For start-up the power supply of the CPU component is not 
for the time being necessary. 
 

• Turn the PC on after mounting the slot card. The slot card is recognized 
as a new network hardware after run-up of the PC and the appropriate 
driver is requested. The driver can be found on the enclosed "ToolDemo 
CD" SW900TOLA. 

• Put in the CD and navigate via driver/slotplc to the directory from the 
according PLC 51xS. Here the slot card driver for each relevant 
operating system may be found. 

• Install the slot card driver.  
 

The CPU 51xS slot card is now specified to the operating system and is 
listed as an additional LAN connection with the device name "Intel(R) 8255 
PCI adapters". As long as the CPU component is not supplied with DC 24V 
the message appears "The network cable was removed". 
 

After installation of the driver IP address and Subnet mask can be assigned 
by the properties of the network environment at any time. Attention should 
be paid that the IP address of the CPU and Ethernet component differs 
exclusively in the Host-ID. 
 

Note! 
More information about assigning IP addresses may be found at 
"Guidelines for IP address assignment" at the following pages. 
Please consider the guidelines, since incorrect adjusted IP address 
parameters may have effects on the whole firm net. 

Overview 

Start-up without 
external CPU 
power supply 

Assign IP address 
parameters to the 
Ethernet component 

     



Manual VIPA System 500S SPEED7 Chapter 3   Deployment CPU 517S/NET 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  3-5 

Guidelines for IP address assignment 
 

The CPU 51xS slot card consists of a CPU and a Ethernet component that 
communicate via a TCP-based point-to-point connection. To enable this, 
CPU and Ethernet component each have an alterable IP address that may 
only differ in the Host-ID.  
For start-up and for further comprehension, a thorough knowledge of Net-
ID, Host-ID and Subnet-ID are assumed. In the following detailed 
information about this can be found. 
 

Ethernet

IP-Adr: .Host-ID
Subnet

PCI slot

Ethernet communication

PCI communication

PC

CPU 51xS
CPU

IP-Adr: .Host-ID
Subnet

CPU

Eth

Siemens SIMATIC
Manager

Windows driver

 
 

If you want to install several CPU 51xS in one PC, every CPU 51xS plug-in 
card needs an own Net-ID. 
The following text describes the approach for the assignment of IP 
addresses together with Net-ID and Host-ID.  
 

Every IP address is a combination of a Net-ID and a Host-ID.  
The Network-ID identifies a network res. a network controller that 
administrates the network. 
The Host-ID marks the network connections of a participant (host) to this 
network.  
 
Note! 
Never choose an IP address with Host-ID=0 or Host-ID=maximum! 
(e.g. for class B with Subnet Mask = 255.255.0.0, the "172.16.0.0" is 
reserved and the "172.16.255.255" is occupied as local broadcast address 
for this network.) 

Overview 

Net-ID 
Host-ID 
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The Host-ID can be further divided into a Subnet-ID and a new Host-ID by 
using an bit for bit AND assignment with the Subnet-Mask.  
The area of the original Host-ID that is overwritten by 1 of the Subnet-Mask 
becomes the Subnet-ID, the rest is the new Host-ID. 
Subnet-Mask binary all "1" binary all "0" 
IPv4 address Net-ID  Host-ID 
Subnet-Mask and IPv4 address Net-ID Subnet-ID new Host-ID 

 
A TCP-based communication via point-to-point, hub or switch connection is 
only possible between stations with identical Network-ID and Subnet-ID! 
Different area must be connected with a router. 
The Subnet-Mask allows you to sort the resources after your needs. This 
means e.g. that every department gets an own subnet and thus does not 
interfere another department. 
 

For IPv4 addresses there are five address formats (class A to class E) that 
are all of a length of 4byte = 32bit.  
Class A 0 Network-ID 

(1+7 bit) 
Host-ID (24 bit) 

Class B 10 Network-ID (2+14 bit) Host-ID (16 bit) 
Class C 110 Network-ID (3+21 bit) Host-ID (8 bit)
Class D 1110 Multicast group 
Class E 11110 Reserved 

 
The classes A, B and C are used for individual addresses, class D for 
multicast addresses and class E is reserved for special purposes. 
The address formats of the classes A, B, C are only differing in the length 
of Network-ID and Host-ID. 
 
To build up private IP-Networks within the internet, RFC1597/1918 
reserves the following address areas: 
Network 
class 

Start IP End IP Standard Subnet Mask 

A 10.0.0.0 10.255.255.255 255.0.0.0 
B 172.16.0.0 172.31.255.255 255.255.0.0 
C 192.168.0.0 192.168.255.255 255.255.255.0 

(The Host-ID is underlined.) 

 
These addresses can be used as net-ID by several organizations without 
causing conflicts, for these IP addresses are neither assigned in the 
internet nor are routed in the internet. 
 
Some Host-IDs are reserved for special purposes. 
Host-ID = 0  Identifier of this network, reserved! 
Host-ID = maximum (binary complete 1) Broadcast address of this network 

 

Subnet-Mask 

Address classes 

Private IP networks 

Reserved 
Host-Ids 
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In common, your complete network consists of a PC with (at least) one 
network card and one or more CPU 51xS plug-in cards that are also each 
listed as network card with the CPU as single participant: 
In this example for Ethernet and CPU component IP addresses from private 
class C net were selected. Using the Subnet mask 255.255.255.0 256 
different networks with 254 host addresses each are available 
 
CPU 51xS
LAN with recomm. IP/Mask
CPU with example IP/Mask 

192.168.201.2 / 255.255.255.0
192.168.201.3 / 255.255.255.0 

Host-ID (chosen from 1...254)

Net-ID Class C private area
(3rd Byte freely chosen)  

 
To enable the PC to connect the CPU 51xS plug-in cards and the 
subordinated CPUs without using a router table, you have to assign an 
individual Net-ID for every card!  
 

1. CPU 51xS
LAN with example IP/Mask
CPU with example IP/Mask 

192.168.201.2 / 255.255.255.0
192.168.201.3 / 255.255.255.0 

2. CPU 51xS
LAN with example IP/Mask
CPU with example IP/Mask 

192.168.202.2 / 255.255.255.0
192.168.202.3 / 255.255.255.0 

3. CPU 51xS
LAN with example IP/Mask
CPU with example IP/Mask 

192.168.203.2 / 255.255.255.0
192.168.203.3 / 255.255.255.0 

Network card (IP/Mask from DHCP-Server)
e.g. 192.168.1.2 / 255.255.255.0

PC

 
 

Example network 
planning for start-up 
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Connect power supply  
 

After the CPU 51xS slot card is installed in the PC and the communication 
between PC and Ethernet component is established the DC 24V power 
supply may be attached. 
The CPU component of the CPU 51xS slot card can only be operated with 
an external or internal DC 24V power supply. The external supply enables 
the operation of the card outside of a PC res. independent from the PC 
operation. Please consider for operation that the slot card is connected to 
ground via its metal cover.  
 

Note! 
The CPU 51xS is to supply either externally or internally with DC 24V. 
Simultaneous infeed should absolutely be avoided! 
 

For external power supply there is a plug on slot panel with the following 
pin assignment: 

DC 24V

GND

 
 

For the cabling of power supply of a CPU, a green plug with CageClamp 
technology is deployed.  
The connection clamp is realized as plug that may be clipped off carefully if 
it is still wired. 
Here wires with a cross-section of 0.08mm2 to 2.5mm2 may be connected. 
You can use flexible wires without end cases as well as stiff wires. 
 

1
2
3 

[1]  Test point for 2mm test tip  
[2]  Locking (orange) for screwdriver 
[3]  Round opening for wires 

1

2

3

 

 
The picture on the left side shows the cabling step by step from top view. 
• For cabling you push the locking vertical to the inside with a suiting 

screwdriver and hold the screwdriver in this position. 
• Insert the insulation striped wire into the round opening. You may use 

wires with a cross-section from 0.08mm2 to 2.5mm2. 
• By removing the screwdriver the wire is connected safely with the plug 

connector via a spring. 

 

Connect power 
supply 

     

External  
power supply 
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For the internal power DC 24V supply there is a clamp on the top of the slot 
card. 
Please consider when connecting a DC 24V power supply that the internal 
power supply hardware conditionally does not have an EMC filter for 
protection against disturbances (like e.g. EN 61000-4-4 [Burst], EN 61000-
4-5 [Surge] or EN 61000-4-6 [conducted disturbance variable, inducted by 
HF fields]).  
Here please use an accordingly filtered supply voltage here. 
 
The clamp has the following pin assignment: 
 

+-
DC 24VGND

 
 
 

Internal  
power supply 
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Initialization of the CPU component 
 

The CPU 51xS slot card consists of a CPU and an Ethernet component. 
For communication both components own an IP address, which may differ 
only in the Host-ID. For online access to the CPU component valid IP 
address parameters have to be assigned to this by means of the Siemens 
SIMATIC manager. This is called "initialization". 
The initialization of the Ethernet component  takes place by the properties 
of the network environment of your operating system, as described above. 
 

There are the following possibilities for assignment of IP address 
parameters: 
• PLC functions with Edith Ethernet Node 

(projecting tool and slot card in the same PC) 
• Hardware project engineering with CP (Minimal project) 
 
PC

Setting via:
- Minimal project CP 343-1
- PLC functions

Setting via
Windows driver
Intel(R) 8255xER

CPU 51xS

Subnet: 255.255.255.0
IP-Adr.: 192 . 168 . 201 . 3

Net-ID Host-ID

CPU (virtual CP)

Subnet: 255.255.255.0
IP-Adr.: 192 . 168 . 201 . 2

Net-ID Host-ID

Ethernet

Precondition:
Net-ID : equal
Host-ID: not equal

CPU

Eth

LAN connection

PCI

Subnet: 255.255.255.0
IP-Addr.: 192.168.201.3

SIMATIC Manager from Siemens

PG/PC interface:
Intel(R) 8255xER

PG/OP channel

PG/OP

 
 

For the hardware configuration the following software is necessary: 
• Siemens SIMATIC manager V. 5.1 and SIMATIC NET or Siemens 

SIMATIC manager V. 5.2 and SP1 
 
 
 

Overview 

Possibilities for 
Initialization 

Requirements 
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The initialization by PLC function can only be established if Siemens 
SIMATIC manager and CPU 51xS slot card are at the same PC. 
The initialization takes place after the following proceeding: 
 
• Start the Siemens SIMATIC manager. 
• Set via Options > Set PG/PC Interface the Access Path to  

"Intel(R) 8255xER". 
• Open with PLC > Edith Ethernet Node the dialog window for 

"initialization" of a station.  
• Use the [Browse] button to determine the CPU components via MAC 

address. 
 

 
 

• Choose the determined module and click to [OK].  
• Set the IP configuration by entering IP address, subnet mask and net 

transition. In addition an IP address may be received from a DHCP 
server. For this depending upon the selected option the MAC address, 
device name or the Client ID which can be entered here is to be 
conveyed to the DHCP server. The Client-ID is a character sequence 
from maximally 63 characters.  
Here the following indications may be used: Dash "-", 0-9, A-z, A-Z 

• Confirm your settings by button [Assign IP Configuration] 
 
Direct after the assignment the CPU component may be reached by the 
Siemens SIMATIC manager by means of these IP address parameters. 
 

Initialization via 
PLC functions 
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If the CPU 51xS slot card and the Siemens SIMATIC manager are not at 
the same PC, the CPU component may get its IP address parameters from 
a minimal project for CPU with CP. 
The Project may be transferred to the CPU 51xS slot card by MPI or by 
means of a MMC memory card.   
The initialization by means of a minimal project takes place after the 
following proceeding: 
 
• Start the Siemens SIMATIC manager and create a new project. 
• Add a new System 300 station via Insert > Station > SIMATIC 300-

Station. 
• Activate the station "SIMATIC 300" and open the hardware configurator 

by clicking on "Hardware". 
• Engineer a rack (SIMATIC 300 \ Rack-300 \ Profile rail). 
• For the SPEED7-CPUs are configured as CPU 318-2, choose the CPU 

318-2 with the order no. 6ES7 318-2AJ00-0AB0 V3.0 from the hardware 
catalog. You'll find this at SIMATIC 300 \ CPU 300 \ CPU 318-2. 

• Project engineering Ethernet PG/OP channel as CP 343-1 (343-1EX11). 
• Project engineering and networking Ethernet-CP 343 and DP master as 

CP 343-1 (343-1EX11) respectively CP 342-5 (342-5DA02 V5.0). 
 

 

 

Initialization via 
minimal project 
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• Type the wanted IP address and subnet mask into the dialog window 
and connect the CP with "Ethernet". 

 
 

• Save and compile your project. 
• Transfer your project via MPI or MMC into your CPU. 
 

There are 2 possibilities for the transfer of your project into the CPU: 
• Transfer via MPI 
• Transfer via storage card at deployment of a card reader 
 
• Change to the Siemens SIMATIC manager. 
• Choose Options > Set PG/PC interface 

→ A dialog window opens where you may configure the MPI interface 
you want to use. 

• Choose the "PC Adapter (MPI)" from the selection list; where 
appropriate you have to add this first. Click on [Properties]. 

• Select the wanted COM port in the register "Local Port" and set the 
transfer rate 38400bit/s. 

• Connect your PC via MPI with your CPU and transfer your project. 
 
As external storage medium a MMC (Memory Card) is employed. The 
MMC is available at VIPA preformatted with the FAT16 PC file system.  
• Create a new wld file via File > Memory Card file > New and use the 

mouse to drag the system data case  into the window of the wld file. 
• Copy the wld file with the help of a reading device to the MMC and 

rename the file to S7PROG.WLD.  
• Insert the MMC in your CPU and execute an overall reset. This causes a 

transfer of the data from the MMC into the battery-buffered RAM of the 
CPU. 

 
Note! 
More information about transfer methods may be found in the chapter 
"Project transfer". 
 

Project transfer 

Transfer via MPI 

Transfer via MMC 
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Internal access to PG/OP channel 
 

Every CPU 51xS has an integrated Ethernet-PG/OP channel. Only in 
installed condition you have access via the PG/OP channel to your CPU. 
Here you may program, remote control or show the integrated web page.  
There are maximum 4 channels. 
 

If the conditions for communication are fulfilled, the slot card may be 
accesses by the PG/PC interface as "Intel(R) 8255xER" for project transfer 
and diagnostics. 
 

• CPU 51xS slot card and Siemens SIMATIC manager are installed at the 
same PC. 

• Ethernet and CPU component are assigned each to one IP address that 
may only differ in the Host-ID.  

• Siemens SIMATIC manager starting with version V. 5.1 and SIMATIC 
NET respectively V. 5.2 and SP1 are installed for hardware configu-
ration. 

 

• Start the Siemens SIMATIC manager. 
• Set Options > PG/PC Interface... to: "Intel(R) 8255xER" 
The PG/OP channel may online be accessed, now. 
 
PC

Setting via:
- Minimal project CP 343-1
- PLC functions

Setting via
Windows driver
Intel(R) 8255xER

CPU 51xS

Subnet: 255.255.255.0
IP-Adr.: 192 . 168 . 201 . 3

Net-ID Host-ID

CPU (virtual CP)

Subnet: 255.255.255.0
IP-Adr.: 192 . 168 . 201 . 2

Net-ID Host-ID

Ethernet

Precondition:
Net-ID : equal
Host-ID: not equal

CPU

Eth

LAN connection

PCI

Subnet: 255.255.255.0
IP-Addr.: 192.168.201.3

SIMATIC Manager from Siemens

PG/PC interface:
Intel(R) 8255xER

PG/OP channel

PG/OP

 

Overview 

Access to  
PG/OP channel 

Requirements 

Approach 
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External access to PG/OP channel via routing 
 

You may access the CPU 51xS from an external PC via Ethernet. The 
following preconditions must be fulfilled:  
• The routing is activated on the PC with the CPU 51xS 
• The route is entered at the CPU 51xS via a CP343 hardware 

configuration with the following parameters: 
- Destination router: IP address of the Ethernet component IPEth of 
  the CPU 51xS 

• The route is entered at the external PC with the following parameters: 
- Destination-IP: Net-ID of the Ethernet component of the CPU 51xS 
- IP-Mask: subnet mask of the CPU 51xS (default: 255.255.255.0) 
- Gateway: IP address of the PCs IPPC with the CPU 51xS at the 
  home network 

 
 

 

Home net
Default

Gateway

CPU part

Ethernet part

PC1

TP
10/100

Net-ID1

IPEth1

IPCPU1

IPPC1

 (Net-ID1.Host-IDCPU1)

 (Net-ID1.Host-IDEth1)

CPU 51xS1

CPU part

Ethernet part
Net-ID2

IPEth2

IPCPU2 (Net-ID2.Host-IDCPU2)

 (Net-ID2.Host-IDEth2)

PC2

TP
10/100
IPPC2

Application

www

CPU51xS
Net 1

CPU 51xS2

Net 1 Net 2

Routing active

IPEth1 (Net-ID1.Host-IDEth1)Router:

Route 

IPEth1

CP343 HW conf.
Properties

Route Add

IPEth1 Net-ID1.0Dest.-IP:
IP-Mask: 255.255.255.0
Gateway: IPPC1

 
 

Attention! 
Only a trained system administrator should execute changes at the network 
neighborhood for this may cause conflicts with the company network! 
The employment with Windows 9x res. Windows XP Home is not 
recommended and not described. 

Overview 
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The following text describes the steps of configuration. More detailed 
information especially to the operating system specific routing is to find in 
the documentation of the operating system. 
Activation at Windows NT4 / 2000Server / 2003Server 
The activation of the routing happens in the "Network neighborhood 
properties" at the properties of the TCP/IP protocol. 
Activation at Windows XPProfessional / 2000Professional 
For the activation, an entry into the registry file is required like illustrated 
below: 
 

 
 
After a reboot, the routing is active. 
 

The entry of a route happens exclusively via the command console of the 
operating system by using the "route" command. The following parameters 
are required: 
 
route ADD <Destination-IP> MASK <IP-Mask> <Gateway> METRIC <Metric> 
IF <IF> 
 

with 
 

ADD:  Command for adding a route 
  
Dest.-IP:  IP address of the network (Net-ID) of the CPU 51xS 
IP-Mask: Subnet mask of the net of the CPU 51xS 
Gateway: IP address of the destination computer at the home network 

with the plugged CPU 51xS 
Metric: (optional) Price value for a destination  
IF:   (optional) Preset interface or best alternate interface  
 
route PRINT lists all entered routes 
route DELETE <Destination-IP> deletes the entry 
 
 

Activate routing 

Enter route 
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The following constellation is present and you want to access the CPU via 
PC: 
 

Home net
Default

Gateway

CPU part

Ethernet part

PC1

Net-ID1

IPEth1

IPCPU1

CPU 51xS1

PC2

Net 1
TP

10/100

172.16.128.15

192.168.201.3

192.168.201.5

IPPC1

TP
10/100

172.16.128.29IPPC2

 
 
 
• Activate the routing at PC1 like described above. 
• Start the hardware configurator from Siemens and configure a system 

with CP 343. 
• Enter the IP address 192.168.201.5 and the subnet mask 

255.255.255.0 in "Properties Ethernet interface". 
• Choose the function “Use router” at "Parameter", enter the IP address 

192.168.201.3 of the Ethernet part of the CPU 51xS as "Gateway" and 
transfer your project. 

• Start the command console at PC2 and enter the following statement:  
 

route add 192.168.201.0 mask 255.255.255.0 172.16.128.15 

 
Now you may access the CPU from PC2 via PC1. You may test the 
connection with the command ping 192.168.201.5. 

Example: 
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Access to the integrated web page 
 

The PG/OP channel provides a web page that you may access via an 
internet browser. The web page contains information about firmware 
versions, current cycle times etc. 
The current content of the web page is stored on MMC by means of the 
MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd - 
Auto commands". 
 

A PG/OP channel should be established between PC with Internet browser 
and CPU 51xS slot card. This may be tested by Ping to the IP address of 
the CPU component. 
 

The access takes place via the IP address of the CPU component. The 
web page only serves for information output. The monitored values are not 
alterable. 
 
 
 

CPU WITH ETHERNET-PG/OP   
Slot 100   
 VIPA 517-4NE02 V3.5.1.4 Px000118.pkg,  
 SERIALNUMBER 18525 

 Order no., firmware version, 
package, serial no. 

 SUPPORTDATA :  
 PRODUCT V3514, HARDWARE V0110,  
 5448D-V10 ,   
 Hx000062.100 , Bx000227 V6514, Ax000086 
 V1200, fx000007.wld V1140,  
 FlashFileSystem : V102 
 Memorysizes (Bytes):  
 LoadMem : 8388608,  
 WorkMemCode : 1048576,  
 WorkMemData : 1048576 

 Information for support: 

 OnBoardEthernet:  
 MacAddress : 0020d577485D,  
 IP-Address : 192.168.201.3, 
 SubnetMask : 255.255.255.0, 
 Gateway : 192.168.201.2 

 Ethernet PG/OP: Addresses  

 Cpu state : Stop  CPU status 
 FunctionRS485 X2/COM1: MPI 
 FunctionRS485 X3/COM2: DPM-async 

 RS485 function 

 Cycletime [microseconds] :  
 min=381 cur=503 ave=499 max=550  
 ArmLoad [percent] : cur=0, max=51  
 PowerCycleHxRetries : 19, 0, 0, 0, 0 

 CPU cycle time:  
min= minimal 
cur= current 
max= maximal 

   
continued ... 

Access to the 
web page 

Requirements 

Web page 
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... continue 
  Additional CPU components: 
Slot 201   Slot 201 (DP master): 
 VIPA 542-1DP00 V3.2.6 Px000119.pkg  Name, firmware version, package 
 SUPPORTDATA : PRODUCT V3260, 
 BB000554 V5260, AB000120 V4170,  
 ModuleType CB2C0010 
 Cycletime [microseconds] : 
 min=65535000 cur=0 ave=0 max=0 cnt=0 

 Information for support: 

   
Slot 206  Slot 206 (CP 543): 
 VIPA 543-1EX71 V2.5.9 Px000059.pkg  Name, firmware version, package 
 SUPPORTDATA : Bb000165 V2590,  
 AB000075 V1000, PRODUCT V2590,  
 Hx000019 V1000,  
 ModuleType ACDB0000 
 Address Input 1024...1039 
 Address Output 1024...1039 

 Information for support: 

   
  Standard Bus 
BaudRate Read Mode1, BaudRate Write Mode1  Information for support: 
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Project engineering 
 

The project engineering of CPU and DP master takes place in the Siemens 
SIMATIC manager. The CPU 51xS slot card may online be accessed for 
parameterization by PLC functions via Ethernet respectively MPI/Profibus. 
In addition, the project may be transferred by a MMC memory card to the 
PC slot card. 
On delivery the CPU 51xS slot card has the MPI address 2. 
 

For the hardware configuration of the CPU and the project engineering of 
the integrated Profibus DP master of the CPU, the following preconditions 
must be met: 
• Siemens SIMATIC manager starting with version V. 5.1 and SIMATIC 

NET respectively V. 5.2 and SP1 are installed for hardware configu-
ration. 

• A communication connection to the slot card is established 
• At usage of Profibus DP slaves of the Systems 100V, 200V and 300V 

from VIPA: GSD files are included in the hardware configurator. 
For the project engineering of the CPU and the Profibus DP master, a 
thorough knowledge of the SIMATIC manager and the hardware 
configurator from Siemens are assumed! 
 

The hardware configurator is part of the Siemens SIMATIC manager. It 
serves the project engineering. The modules that you may configure here 
are to find in the hardware catalog. 
For the deployment of Profibus slaves of the Systems 100V, 200V and 
300V from VIPA, the import of the modules to the hardware catalog via the 
GSD-files from VIPA is necessary. 
 

Overview 

Preconditions 

Install hardware 
configurator from 
Siemens 
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The project engineering of the CPU 51xS takes place at the Siemens 
hardware configurator and is divided into the following parts: 
• Project engineering as CPU 318-2 (318-2AJ00-0AB00 V3.0) 
• Project engineering Ethernet PG/OP channel as CP 343-1 (343-1EX11) 
• Project engineering internal CP 543 as CP 343-1 (343-1EX11). 
• Project engineering CPU 51xS as DP slaves in a virtual DP master 

CP 342-5 (342-5DA02 V5.0). 
 
To be compatible with the Siemens SIMATIC manager the following steps 
should be executed: 
 

Object properties:
Function RS485 

Standard bus

virtual DP master for CPU
(only for VIPA specific 
object properties)

(100) VIPA

VIPA_SPEEDBUS
Slot
0

Module

CPU 318-2
DP
MPI/DP

342-5DA02 V5.0

Slot
1
2

X2
X1
3

343-1EX11
(Ethernet-PG/OP)
343-1EX11
(for CP 543)

Order no.
CPU 51xS at slot 100

CPU:
Addr.: 100

 

• Start the hardware configurator from Siemens. 
• Configure the Siemens CPU 318-2 (6ES7 318-2AJ00-0AB0/V3.0). 

Configure the internal DP master of your CPU via the internal DP 
master of the CPU 318-2. Leave MPI/DP of the CPU 318-2 in MPI 
mode. The Profibus mode is not supported. 

• For the internal Ethernet PG/OP channel you have to configure a 
Siemens CP 343-1 (343-1EX11). 

• Configure the integrated CP 543 of the CPU 517/NET always as 2. CP 
after the placed Ethernet PG/OP channel as Siemens CP343-1 (343-
1EX11). 

• Configure as last module the Siemens DP master 342-5 (342-5DA02 
V5.0). Link the DP master and switch it to DP master operating mode.  

• To this master system you assign the CPU via a "VIPA_SPEEDBUS" 
slave. Here the Profibus address corresponds to the slot no. Beginning 
with 100 for the CPU. Place at slot 0 of every slave the assigned 
module and alter the parameters if needed.  

 
In the following these steps are more described. 

 
 

Note! 
More concerning the project engineering of the integrated CP 543 may be 
found at the chapter "Deployment Ethernet". 
 

Fast introduction 

     



Chapter 3   Deployment CPU 517S/NET  Manual VIPA System 500S SPEED7 

3-22  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

The CPU 51xS has to be configured analog to a CPU 318-2 from Siemens 
with Profibus DP master and a plugged Ethernet-CP CP343-1.  
• Start the hardware configurator and create a new project System 300. 
• Add a profile rail from the hardware catalog. 
• You reach the CPU with Profibus master in the hardware catalog at:  

Simatic300/CPU-300/CPU318-2DP/6ES7 318-2AJ00-0AB0 

• Insert the CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0). 
• Enter a Profibus address for the master (e.g. 2) 
• Click on DP and set the operating mode “DP Master” in the Object 

properties. Confirm the settings by [OK]. 
 

Configure representatively for the CPU component a CP 343-1.  
This may be found in the hardware catalog at: 
Simatic300/CP-300/Industrial Ethernet. 

 
• Add the CP 343-1 (343-1EX11-0XE0) at slot 4. 
• Click on the CP and enter the according IP address and subnet mask at 

Object properties. Enter the IP address parameters favored or assigned 
at initialization.  

 
Please note that the IP address may differ exclusively in the host ID from 
the IP address of the Ethernet component. 
The CPU component of the CPU 51xS slot card may be accessed by this 
address by means of the PLC functions. 
 

Approach 

Configuration of 
the CPU as  
CP 343-1 
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For the project engineering of the DP master system, you have to execute 
the following steps: 
• Right click on DP and choose "Add Master System ".  
• Create a new Profibus subnet with NEW. This subnet allows you to 

configure your Profibus slave modules. 
 

• For the project engineering of Profibus-DP slaves, choose the according 
Profibus-DP slave from the hardware catalog and move it to the subnet 
of your master. 

• Assign a valid Profibus address to the DP slave. 
• Include the modules of the DP slave system in plugged sequence and 

assign valid addresses to the modules. 
• Parameterize the modules if needed. 
The following illustration shows the project engineering. Additionally the 
picture includes a VIPA Profibus-DP slave as example: 
 

Module

CPU 318-2
DP
MPI/DP

CP 343-1

Slot
1
2

X2
X1
3
4
5
6
...

DP master system

6ES7 318-2AJ00-0AB0 V3.0

6GK7 343-1EX20-0XE0

 
 

The CPU 51xS slot card may online be accessed for parameterization by 
PLC functions via Ethernet respectively MPI/Profibus. 
In addition, the project may be transferred by a MMC memory card to the 
PC slot card. 
More information about transferring a project can be found at "Project 
transfer" below. 
During start-up the Profibus project is forwarded to the Profibus master. 

Configure DP 
master system 

Include  
DP slaves 

Transfer project 
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CPU parameterization 
 

Except of the VIPA specific CPU parameters the CPU parameterization 
takes place in the parameter dialog of the CPU 318-2DP. 
The VIPA specific CPU parameters like the RS485 interface behavior and 
the synchronization between CPU and DP master can be configured in the 
SPEED-Bus CPU parameter dialog. 
 

For the SPEED7-CPUs are configured in the hardware configurator from 
Siemens as Siemens CPU 318-2DP you may adjust the parameters for the 
SPEED7 CPUs at the hardware configuration at "Properties" of the CPU 
318-2DP.  
Via a double-click on the CPU 318-2DP the parameter window of the CPU 
can be archived. Using the registers you get access to all parameters of the 
CPU. 
 

 
 
IP address and subnet mask are entered via the properties of the 
integrated CP 343-1. 

Overview 

Parameterization 
via Siemens 
CPU 318-2DP 

Setting IP address 
and subnet mask  
of the CPU 
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The CPU does not evaluate each parameter, which may be set at the 
hardware configuration.  
The following parameters are supported by the CPU at this time: 
 
 
 
Since every CPU 51xS from VIPA is configured as CPU 318-2AJ00 from 
Siemens, here the short description CPU 318-2 stands. 
 
Order number and firmware are identical to the details in the "hardware 
catalog" window. 
 
The Name field provides the short description of the CPU. If you change 
the name the new name appears in the Siemens SIMATIC manager. 
 
Here is the possibility to specify a plant designation for the CPU. This plant 
designation identifies parts of the plant according to their function. This has 
a hierarchical structure and confirms to IEC 1346-1. 
  
In this field information about the module may be entered. 
 
 
 
If the checkbox for "Startup when expected/actual configuration differ" is 
deselected and at least one module is not located at its configured slot or if 
another type of module is inserted there instead, then the CPU switches to 
STOP mode. 
If the checkbox for "Startup when expected/actual configuration differ" is 
selected, then the CPU starts even if there are modules not located in their 
configured slots of if another type of module is inserted there instead, such 
as during an initial system start-up. 
 
This operation specifies the maximum time for the ready message of every 
configured module after PowerON. If the modules do not send a ready 
message to the CPU by the time the monitoring time has expired, the 
actual configuration becomes unequal to the preset configuration. 
 
The maximum time for the transfer of parameters to parameterizable 
modules. If not every module has been assigned parameters by the time 
this monitoring time has expired; the actual configuration becomes unequal 
to the preset configuration. 
 

Supported 
parameters 

General 

Short description 

Order No. / 
Firmware 

Name 

Plant designation 

Comment 

Startup 

Startup when 
expected/actual 
configuration differs 

Monitoring time for 
ready message by 
modules [100ms] 

Monitoring time for 
transfer of 
parameters to 
modules [100ms] 
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Activate the checkbox for cyclic updates of the OB1 process image. 
Updating increases the cycle time. 
 
 
Here the scan cycle monitoring time in milliseconds may be set. If the scan 
cycle time exceeds the scan cycle monitoring time, the CPU enters the 
STOP mode. Possible reasons for exceeding the time are: 
• Communication processes 
• a series of interrupt events 
• an error in the CPU program 
 
The minimum scan cycle time specifies the time interval, in which the CPU 
program is called. 
If the scan cycle time is less than the specified minimum scan cycle time, 
the CPU waits until the minimum scan cycle time is reached. 
 
Using this parameter you can control the duration of communication 
processes, which always extend the scan cycle time so it does not exceed 
a specified length. 
If there are no additional asynchronous events, the scan cycle time of  OB1 
is increased by following factor: 
 

100 
100 - cycle load from communication % 

  
If the cycle load from communication is set to 50%, the scan cycle time of 
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still 
being influenced by asynchronous events (e.g. process interrupts) as well. 
 
Here the size of the process image max. 2048 for the input/output periphery 
may be fixed. 
 
 
The preset reaction of the CPU may be changed to an I/O access error that 
occurs during the update of the process image by the system. 
Each CPU 51xS from VIPA is preset such that OB 85 is not called if an I/O 
access error occurs and no entry is made in the diagnostic buffer either. 
 
Activate the check box if you want to use clock memory and enter the 
number of the memory byte. 
 

Note! 
The selected memory byte cannot be used for temporary data storage. 

Cycle/Clock 
memory 
Update OB1 
process image 
cyclically 
 

Scan cycle 
monitoring time 

Minimum scan  
cycle time 

Scan cycle load 
from Communi-
cation 

Size of the process 
image input/output 
area 

OB85 call up at I/O 
access error 

Clock memory 
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Enter the number of retentive memory bytes from memory byte 0 onwards. 
 
 
Enter the number of retentive S7 timers from T0 onwards.  
 
 
Enter the number of retentive S7 counter from C0 onwards. 
 
 
Since with every VIPA CPU 51xS each data block is remanent stored, the 
settings at Areas are non-relevant and they are ignored. 
 
 
 
In these fields you may define the number of local data (temporary data) for 
the priority classes 1 to 29. 
 
 
 
 
Here the priorities may be specified according to which the hardware 
interrupt OBs are processed (hardware interrupt, time-delay interrupt, 
async. error interrupts). Interrupts for DPV1 are not supported. 
With priority "0" the corresponding OB is deactivated. Please regard that 
this is not supported by each OB. 
  
 
 
 
Here the priorities may be specified according to which the time-of-day 
interrupt is processed. 
With priority "0" the corresponding OB is deactivated. 
 
Activate the check box of the time-of-day interrupt OBs if these are to be 
automatically started on complete restart. 
 
Select how often the interrupts are to be triggered. Intervals ranging from 
every minute to yearly are available. The intervals apply to the settings 
made for start date and time. 
 
Enter date and time of the first execution of the time-of-day interrupt. 
 
This is not supported. 

Retentive Memory 

Number of Memory 
Bytes from MB0 

Number of S7 
Timers from T0 

Number of S7 
Counters from C0 

Areas 

Memory 

Local data  
(priority classes) 

Interrupts 

Priority 

Time-of-day 
interrupts 

Priority 

Active 

Execution 

Start date / time 

Process image 
partition 



Chapter 3   Deployment CPU 517S/NET  Manual VIPA System 500S SPEED7 

3-28  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

 
 
Here the priorities may be specified according to which the corresponding 
cyclic interrupt is processed. With priority "0" the corresponding interrupt is 
deactivated. 
 
Enter the time intervals in ms, in which the watchdog interrupt OBs should 
be processed. The start time for the clock is when the operating mode 
switch is moved from STOP to RUN. 
 
Enter the delay time in ms for current execution for the watch dog interrupt. 
This should be performed if several watchdog interrupts are enabled. 
Phase offset allows to distribute processing time for watchdog interrupts 
across the cycle. 
 
Is not supported. 
 
 
 
 
Activate this parameter, if the CPU should report the cause of STOP to PG 
respectively OP on transition to STOP.  
 
Here the number of diagnostics are displayed, which may be stored in the 
diagnostics buffer (circular buffer). 
 
 
You can specify whether the CPU clock should be used to synchronize 
other clocks or not. 
- as slave: The clock is synchronized by another clock. 
- as master: The clock synchronizes other clocks as master. 
- none: There is no synchronization 
 
Select the time intervals within which the synchronization is to be carried 
out. 
 
Lose or gain in the clock time may be compensated within a 24 hour period 
by means of the correction factor in ms. If the clock is 1s slow after 24 
hours, you have to specify a correction factor of "+1000" ms. 
  
 
 
 

Cyclic interrupts 

Priority 

Execution 

Phase offset 

Process image 
partition 

Diagnostics/Clock 

Report cause of 
STOP 

Number of 
messages in the 
diagnostics buffer 

Synchronization 
type 

Time interval 

Correction factor 
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Here 1 of 3 protection levels may be set to protect the CPU from 
unauthorized access. 
Protection level 1 (default setting): 
• No password adjustable, no restrictions 
Protection level 2 with password: 
• Authorized users: read and write access 
• Unauthorized user: read access only 
Protection level 3: 
• Authorized users: read and write access 
• Unauthorized user: no read and write access 
 

The properties dialog of the Profibus part is opened via a double click to the 
sub module DP. 
 
 
 
Here the short description "DP" for Profibus DP is specified. 
 
Nothing is shown here. 
 
Here "DP" is shown. If you change the name, the new name appears in the 
Siemens SIMATIC manager. 
 
The Profibus address is shown here. 
 
With this button the properties of the Profibus DP interface may be preset. 
 
You can enter the purpose of the DP master in this box. 
 
 
 
A diagnostics address for Profibus DP is to be preset here. In the case of 
an error the CPU is informed via this address. 
 
Here the operating mode of the Profibus part may be preset. More may be 
found at chapter "Deployment CPU with Profibus". 
 
Within the operating mode "DP-Slave" you may configure your slave 
system. More may be found at chapter "Deployment CPU with Profibus". 
 
These parameters are not supported. 

Protection 

Level of protection 

Parameter for DP 

General 

Short description 

Order no. 

Name 

Interface 

Properties  

Comment 

Addresses 

Diagnostics 

Operating mode 

Configuration 

Clock 
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The properties dialog of the MPI interface is opened via a double click to 
the sub module MPI/DP. 
 
 
 
Here the short description "MPI/DP" for the MPI interface is specified. 
 
Nothing is shown here. 
 
At Name "MPI/DP" for the MPI interface is shown. If you change the name, 
the new name appears in the Siemens SIMATIC manager. 
 
Please regard only the type "MPI" is supported by the VIPA CPU 51xS. 
 
Here the MPI address is shown. 
 
With this button the properties of the MPI interface may be preset. 
 
You can enter the purpose of the MPI interface in this box. 
 
 
 
A diagnostics address for the MPI interface is to be preset here. In the case 
of an error the CPU is informed via this address. 
 
These parameters are not supported. 
 
 
 

Parameter for 
MPI/DP 

General 

Short description 

Order no. 

Name 

Type 

Interface 

Properties  

Comment 

Addresses 

Diagnostics 

Operating mode, 
Configuration, Clock 



Manual VIPA System 500S SPEED7 Chapter 3   Deployment CPU 517S/NET 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  3-31 

Here the following parameters may be accessed: 
• Function RS485 (Synchronization DP master and CPU) 
• Token Watch 
• Number remanence flag 
• Priority OB 28, OB 29, OB 33, OB 34 
• Execution OB 33, OB 34 
• Phase offset OB 33, OB 34 
 
Via a hardware configuration you may configure the behavior of the 
synchronization between CPU and DP master using the parameter 
"Function RS485" of the object properties. Via a double-click on the 
inserted CPU 51xS at SPEED-Bus the parameter window of the SPEED7 
CPU can be achieved. 
 
 
 

Object properties:
Function RS485 

Standard bus

virtual DP master for CPU
(only for VIPA specific 
object properties)

(100) VIPA

VIPA_SPEEDBUS
Slot
0

Module

CPU 318-2
DP
MPI/DP

342-5DA02 V5.0

Slot
1
2

X2
X1
3

343-1EX11
(Ethernet-PG/OP)
343-1EX11
(for CP 543)

Order no.
CPU 51xS at slot 100

CPU:
Addr.: 100

 

Configure your SPEED7 system as shown above. After configuration 
the CPU 51xS must be located at slot 0 of the VIPA SPEED-Bus slave 
with address 100. 
The object properties are opened via a double-click on the SPEED-Bus 
slave CPU 51xS.  
With the parameter Function RS485 the following adjustment 
possibilities are given. 

 
 
 
 
 

VIPA specific 
parameter via 
SPEED7 CPU 

Approach 
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Per default the RS485 interface is used for the Profibus DP master.  
Using this parameter the RS485 interface may be switched to PtP 
communication (point to point) respectively the synchronization between 
DP master system and CPU may be set: 
 
Deactivated Deactivates the RS485 interface 
PtP With this operating mode the Profibus DP master 

is deactivated and the RS485 interface acts as an 
interface for serial point-to-point communication. 
Here data may be exchanged between two 
stations by means of protocols. 
More about this may be found at chapter 
"Deployment PtP communication" in this manual. 

Profibus-DP async 
 

Profibus DP master operation asynchronous to 
CPU cycle  
The RS485 interface is preset at default to 
Profibus-DP async. Here CPU cycle and cycles of 
every VIPA Profibus DP master run inde-
pendently. 

Profibus-DP syncIn The CPU is waiting for DP master input data. 
Profibus-DP syncOut 
 

The DP master system is waiting for CPU output 
data. 

Profibus-DP syncInOut 
 

CPU and DP master system are waiting on each 
other and form thereby a cycle. 

Default: Profibus-DP async 
 

Normally the cycle of CPU and DP master run independently. The cycle 
time of the CPU is the time needed for one OB1 cycle and for reading 
respectively writing the inputs respectively outputs. The cycle time of a DP 
Master depends among others on the number of connected slaves and the 
baud rate, thus every plugged DP master has its own cycle time.   
Due to the asynchronism of CPU and DP master the whole system gets 
relatively high response times. 
The synchronization behavior between every SPEED-Bus Profibus DP 
master and the SPEED7 CPU can be configured by means of a hardware 
configuration as shown above.  
The different modes for the synchronization are in the following described.  

Function RS485 

Synchronization 
between master 
system and CPU 
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In Profibus-DP SyncInOut mode CPU and DP master system are waiting 
on each other and form thereby a cycle. Here the whole cycle is the sum of 
the longest DP master cycle and CPU cycle. 
By this synchronization mode you receive global consistent in-/ output data, 
since within the total cycle the same input and output data are handled 
successively by CPU and DP master system. 
If necessary the time of the Watchdog of the bus parameters should be 
increased at this mode. 

RUN

...SPEED7 CPU:

SPEED-Bus
DP master system: Cycle

Cycle ...

... ...Cycle

whole cycle  
 
In this operating mode the cycle time of the SPEED-Bus DP master system 
depends on the CPU cycle time. After CPU start-up the DP master gets 
synchronized. 
As soon as their cycle is passed they wait for the next synchronization 
impulse with output data of the CPU. So the response time of your system 
can be improved because output data were directly transmitted to the DP 
master system. If necessary the time of the Watchdog of the bus para-
meters should be increased at this mode. 

RUN

... ... ... ...

SPEED7 CPU:

SPEED-Bus
DP master system:

Cycle

RUN

SPEED7 CPU:

SPEED-Bus
DP master system: ... ... ...Cycle

Cycle CPU > DPM
"1-tier CPU cycle"

Cycle CPU < DPM
"n-tier CPU cycle"

Cycle

 
 
In the operating mode Profibus-DP SyncIn the CPU cycle is synchronized 
to the cycle of the SPEED-Bus Profibus DP master system. 
Here the CPU cycle depends on the speed bus DP master with the longest 
cycle time. If the CPU gets into RUN it is synchronized with all speed bus 
DP master. As soon as the CPU cycle is passed it waits for the next 
synchronization impulse with input data of the DP master system.  
If necessary the Scan Cycle Monitoring Time of the CPU should be in-
creased. 

RUN

...

...SPEED7 CPU:

SPEED-Bus
DP master system: Cycle

Cycle

RUN

SPEED7 CPU:

SPEED-Bus
DP master system:

... ...

... ...Cycle

Cycle

Cycle CPU > DPM
"n-tier longest DP master cycle"

Cycle CPU < DPM
"1-tier longest DP master cycle"

 
 

Profibus-DP 
SyncInOut 

Profibus-DP 
SyncOut 

Profibus-DP  
SyncIn 
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This is a VIPA internal parameter. Nothing should be changed here. 
Default: On 
 

Here the number of flag bytes may be set. With 0 the value Retentive 
memory > Number of memory bytes starting with MB0 set at the 
parameters of the Siemens CPU 318-2 is used. Otherwise the adjusted 
value (1 ... 16384) is used. 
Default: 0 
 

The CPU offers additional cyclic interrupts, which interrupt the cyclic 
processing in certain distances. Point of start of the time interval is the 
change of operating mode from STOP to RUN. 
To avoid that the cyclic interrupts of different cyclic interrupt OBs receive a 
start request at the same time and so a time out may occur, there is the 
possibility to set a phase offset respectively a time of execution. 
The phase offset (0 ... 60000ms) serves for distribution processing times for 
cyclic interrupts across the cycle.  
The time intervals, in which the cyclic interrupt OB should be processed 
may be entered with execution (1 ... 60000ms). 
Default: Phase offset: 0 
              Execution: OB33: 500ms 
                              OB34: 200ms 
 

The priority fixes the order of interrupts of the corresponding interrupt OB. 
Here the following priorities are supported: 
0 (Interrupt-OB is deactivated), 2,3,4,9,12,16,17,24  
Default: 24 
 

Token Watch 

Number 
remanence flag 

Phase offset and 
execution of OB33 
and OB34 

Priority of OB28, 
OB29, OB33 and 
OB34 
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Project transfer 
 

The following options are available to transfer a project into the CPU 51x 
slot card: 
• internal via PCI slot (Ethernet connection) 
• external via PC network card (routing necessary) 
• external via RS485 
• external via Profibus (not for first project) 
• external via MMC storage card  

  
For this transfer method CPU 51xS slot card and Siemens SIMATIC 
manager are installed at the same PC. 
As soon as the Ethernet and CPU component have been assigned to valid 
IP address parameters the CPU 51xS may internal be accessed with the IP 
address of its CPU component. Adjust here as PG/PC interface "Intel(R) 
8255xER". 
For the communication functions of the CPU component a hardware 
configuration in which beside the CPU 318-2DP a CP 343-1 is configured. 
Set the desired IP address parameters here. Please note that the IP 
address may differ exclusively in the host ID from the IP address of the 
Ethernet component. 
Within the PLC function the IP address parameters of the CP 343-1 may be 
used as target parameters. 
If the target station indicated by the IP address parameters is not found 
during transmission, the original IP parameters for the CPU component 
may be entered in a hint dialog. 
With confirmation of your input your project will be transferred to the original 
IP address. After the restart of the CPU the new IP parameters of the 
project are active. 

Overview 

Internal project 
transfer via PCI slot 
by an Ethernet 
connection 
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For this transfer method it is presupposed that CPU 51xS slot card and a 
network card are in the target  PC and the network card is connected with 
the projecting PC by Ethernet. 
So that the CPU 51xS slot card may be accessed by the projecting PC via 
the network card a "routing" is necessary. For this details may be found at 
"External access to PG/OP channel via routing" above. 
Proceed now as described at internal project transfer. Configure a CPU 
318-2DP and a CP 343-1. Set the desired IP address parameters here. 
Choose at parameters "use router" and enter as "Gateway" the IP address 
of  the Ethernet component of the CPU 51xS slot card. 
Within the PLC function the IP address parameters of the CP 343 may be 
used as target parameters. 
If the target station indicated by the IP address parameters is not found 
during transmission, the original IP parameters for the CPU component 
may be entered in a hint dialog. 
With confirmation of your input your project will be transferred to the original 
IP address. After the restart of the CPU the new IP parameters of the 
project are active. 
 

External project 
transfer via PC 
network card 
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For transfer via RS485 there are the following 2 interfaces: 
• MPI interface supports maximally 32 PG/OP channels 
• PB-DP/PtP interface supports maximally 31 PG/OP channels 

(exclusive at Profibus DP master operation)  
 
The MPI programming cables are available at VIPA in different variants. 
The deployment of the cables is identical. The cables provide a bus 
enabled RS485 plug for the CPU and a RS232 res. USB plug for the PC. 
Due to the RS485 connection you may plug the MPI programming cables 
directly to an already plugged plug on the RS485 jack. Every bus 
participant identifies itself at the bus with an unique address, in the course 
of the address 0 is reserved for programming devices. 
 
The structure of a MPI net is in the principal identical with the structure of a 
1.5Mbit/s Profibus net. This means the same rules are valid and you use 
the same components for the build-up. The single participants are 
connected with each other via bus interface plugs and Profibus cables. Per 
default the MPI net runs with 187.5kbit/s. VIPA CPUs are delivered with 
MPI address 2. 
 
A cable has to be terminated with its surge impedance. For this you switch 
on the terminating resistor at the first and the last participant of a network or 
a segment. 
Please make sure that the participants with the activated terminating 
resistors are always provided with voltage during start-up and operation. 
 
 
 

MPI-Programmierkabel

STEP7
von Siemens

MPI-NetzAbschluss Abschluss

 
 

Transfer via RS485 

MPI programming 
cable 

Net structure 

Terminating resistor 
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• Connect your PC to the MPI jack of your CPU via a MPI programming 
cable.  

• Load your project in the SIMATIC manager from Siemens. 
• Choose in the menu Options > Set PG/PC interface 
• Select in the according list the "PC Adapter (MPI)"; if appropriate you 

have to add it first, then click on [Properties]. 
• Set in the register MPI the transfer parameters of your MPI net and type 

a valid address. 
• Switch to the register Local connection 
• Set the COM port of the PC and the transfer rate 38400bit/s for the MPI 

programming cable from VIPA.  
• Via PLC > Load to module you may transfer your project via MPI to the 

CPU and save it on a MMC via PLC > Copy RAM to ROM if one is 
plugged. 

 
• Connect your PC to the DP-PB/PtP jack of your CPU via a MPI 

programming cable.  
• Load your project in the Siemens SIMATIC manager. 
• Choose in the menu Options > Set PG/PC interface 
• Select in the according list the "PC Adapter (Profibus)"; if appropriate 

you have to add it first, then click on [Properties]. 
• Set in the register Profibus the transfer parameters of your Profibus net 

and type a valid Profibus address. The Profibus address must be 
assigned to the DP master by a project before. 

• Switch to the register Local connection 
• Set the COM port of the PCs and the transfer rate 38400bit/s for the MPI 

programming cable from VIPA.  
• Via PLC > Load to module you may transfer your project via Profibus to 

the CPU and save it on a MMC via PLC > Copy RAM to ROM if one is 
plugged. 

 

Note! 
An according project with an activated Profibus must have been loaded to 
the CPU before (not suited for first start-up), otherwise the CPU may not be 
reached after a overall reset. 
 

Approach transfer 
via MPI interface 

Approach transfer 
via Profibus 
interface 
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The MMC (Memory Card) serves as external transfer and storage medium 
for programs and firmware. It has the PC compatible FAT16 file system. 
There may be stored several projects and sub-directories on a MMC 
storage module. Please regard that your current project respectively the file 
with the reserved file name is stored in the root directory. 
With an overall reset, PowerON or CPU-STOP the MMC is automatically 
read. By presetting a reserved file name the functionality of the CPU may 
be influenced. 
 
File name Description 
S7PROG.WLD Project file - is read after overall reset respectively may 

be written by CPU by an order. 
AUTOLOAD.WLD Project file - is read after PowerON. 
PROTECT.WLD Protected project file 

(see "Extended know-how protection"). 
VIPA_CMD.MMC Command file - file is once executed during CPU-STOP 

by plugging a MMC or after PowerON 
(see "MMC-Cmd - Auto command"). 

*.pkg  Firmware file - is recognized after PowerON and may 
be installed by means of an update request 
(see "Firmware update"). 

 
The transfer of the application program from the MMC into the CPU takes 
place depending on the file name after overall reset or PowerON. The 
blinking of the LED "MCC" of the CPU marks the active transfer.  
A transfer from CPU to MMC only happens if the size of the user memory 
exceeds the size of the user program. Else a memory expansion via MCC 
is necessary. 
 
When the MMC has been installed, the write command stores the content 
of the battery buffered RAM as S7PROG.WLD at the MMC. The write 
command is controlled by means of the Siemens hardware configurator via 
PLC > Copy RAM to ROM. During the write process the "MMC"-LED of the 
CPU is blinking. When the LED expires the write process is finished. 
 
After a write process on the MMC, an according ID event is written into the 
diagnostic buffer of the CPU. To monitor the diagnosis entries, you select 
PLC > Module Information in the Siemens SIMATIC manager. Via the 
register "Diagnostic Buffer" you reach the diagnosis window.  
When writing on the MMC, the following events may occur: 

Event-ID Meaning 
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE200 MMC writing finished successful 

 

Transfer via 
MMC 

Reserved file 
names 

Transfer  
MMC →→→→ CPU 

Transfer  
CPU →→→→ MMC 

Transfer control 
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Operating modes 
 

The CPU has 4 operating modes: 
• operating mode STOP 
• operating mode START-UP 
• operating mode RUN 
• operating mode FLAG 
Certain conditions in the operating modes START-UP and RUN require a 
specific reaction from the system program. In this case the application 
interface is often provided by a call to an organization block that was 
included specifically for this event. 
 

• Processing of the application program has stopped. 
• If the program was being processed before, the values of counters, 

timers, flags and the contents of the process image are retained during 
the transition to the STOP mode. 

• Outputs are inhibited, i.e. all digital outputs are disabled. 
• RN-LED  off 
• ST-LED  on 
 

• During the transition from STOP to RUN a call is issued to the start-up 
organization block OB 100. The length of this OB is not limited. The 
processing time for this OB is not monitored. The start-up OB may issue 
calls to other blocks. 

• All digital outputs are disabled during the start-up, i.e. outputs are 
inhibited. 

• RN-LED blinks 
• ST-LED off 
When the CPU has completed the start-up OB, it assumes the operating 
mode RUN. 
 

• The application program in OB 1 is processed in a cycle. At the control 
of alarms other program sections can be included in the cycle. 

• All timers and counters, being started by the program, are active and the 
process image is updated with every cycle. 

• The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs 
are enabled. 

• RN-LED on 
• ST-LED off  

Overview 

Operating mode 
STOP 

Operating mode 
START-UP 

Operating mode 
RUN 
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The CPU 51xS provides the opportunity to define up to 4 break points 
(flags) for program diagnosis purposes. The flags are set and deleted via 
your programming neighborhood. As soon as a break point is reached, you 
may execute your application line by line and may activate in- and outputs.  
 

For the usage of break points, the following preconditions must be fulfilled: 
• The single step test mode is only available for STL, if needed, change 

the view via View > STL to STL. 
• The block has to be opened online and must not be protected. 
• The opened block must not have been altered in the editor. 
 

• Activate the break point bar via View > Break point bar. 
• Put the cursor to the statement line where a break point is to be set. 
• Set the break point with Test > Set break point. The statement line is 

marked with a ring. 
• To activate the break point, choose Test > Break point active. The ring 

changes to a circle. 
• Switch the CPU to RUN. When the user application reaches the break 

point, the CPU switches into the state FLAG, the break point is marked 
with an arrow and the register contents are shown. 

• Now you may execute your application code step by step via Test > 
Next command or execute the application until the next break point with 
Test > Continue. 

• Test > Delete (all) break points deletes (all) break points. 
 

• LED RN blinks and LED ST is on. 
• The code execution has been stopped. All run levels are not executed. 
• All timer are frozen. 
• The real-time clock is still active. 
• The outputs are shut down, but may be released for test purposes. 
• Passive CP communication is possible. 
 

Note! 
The usage of break points is possible at any time. A switch to the operating 
mode “Test operation” is not required.  
If you set more than 3 break points, the single step operation is not longer 
available.  
 
 

Operating mode 
FLAG 

Preconditions 

Approach with  
break points 

Behavior in 
operating mode 
FLAG 
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The CPUs include security mechanisms like a Watchdog (100ms) and a 
parameterizable cycle time surveillance (parameterizable min. 1ms) that 
stop res. execute a RESET at the CPU in case of an error and set it into a 
defined STOP state. 
The VIPA CPUs are developed function secure and have the following 
system properties: 
 

Event concerns Effect 
RUN → STOP general BASP (Befehls-Ausgabe-Sperre,  i.e. command 

output lock) is set. 
 central digital outputs The outputs are set to 0V. 
 central analog outputs The voltage supply for the output channels is 

switched off. 
 decentral outputs The outputs are set to 0V. 
 decentral inputs The inputs are read constantly from the slave and 

the recent values are put at disposal. 
STOP → RUN 
res. Power on 

general First the PII is deleted, then OB 100 is called. After 
the execution of the OB, the BASP is reset and the 
cycle starts with:   
Delete PIQ → Read PII → OB1. 

 central analog outputs The behavior of the outputs at restart can be 
preset.  

 decentral inputs The inputs are read constantly from the slave and 
the recent values are put at disposal. 

RUN general The program execution happens cyclically and can 
therefore be foreseen:  
Read PII → OB1 → Write PIQ. 

 
PII: = Process image inputs 
PIQ: = Process image outputs 
 

 

Function 
security 
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Overall reset 
 

During the overall reset the entire user memory (RAM) and the retentive 
memory area is erased.  
Data located on the storage medium (MMC, MCC) is not affected. 
You should always issue an overall reset to your CPU before loading an 
application program into your CPU, to ensure that all blocks have been 
cleared from it. 
 

Condition 
The operating mode of the CPU is STOP. Place the operating mode switch 
on the CPU in position "STOP" → The ST-LED is on. 
 
Overall reset 
• Place the operating mode switch in the position MR and hold it in this 

position for app. 3 seconds. → The ST-LED changes from blinking to 
permanently on. 

• Place the operating mode switch in the position STOP and switch it to 
MR and quickly back to STOP within a period of less than 3 seconds.  
→ The ST-LED blinks (overall reset procedure). 

• The overall reset has been completed when the ST-LED is on 
permanently. → The ST-LED is on. 

 
The following figure illustrates the above procedure: 
 

3 Sec.

3 Sec.

RN

ST

MR

RN

ST

MR

RN

ST

MR

RN

ST

MR

1 2 3 4

RN ST RN ST RN STRN ST

 
 

Overview 

Overall reset by 
means of the 
operating mode 
switch 
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At deployment of the operating software PLC-Tool you may initialize the 
Overall reset via the button [M-RES]. 
The button is available as soon as your CPU is in STOP. 
 

 
 
Conditions 
Your CPU has to be in STOP.  
Via the menu command PLC > Operating Mode you switch your CPU in 
STOP. 
 
Overall reset 
Via the menu command PLC > Clear/Reset you request the overall reset. 
In the dialog window you may switch your CPU to STOP if you didn't that 
yet and start the overall reset. 
During the overall reset  procedure the ST-LED is blinking. 
When the ST-LED changes to permanently on, the overall reset has been 
finished. 
 

After the overall reset the CPU attempts to reload the parameters and the 
program from the memory card. → The MMC-LED at the board blinks. 
When the reload has been completed, the LED extinguishes. The operating 
mode of the CPU will be STOP or RUN, depending on the position of the 
operating mode switch. 
 
 

Overall reset via 
PLC-Tool 

Overall reset via 
SIMATIC manager 
from Siemens 

Automatic reload 
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Firmware update 
 

The CPU offer you the opportunity to execute a firmware update for the 
CPU via MMC. 
For this an accordingly prepared MMC must be in the CPU during the start-
up. 
So a firmware files can be recognized and assigned with start-up, a pkg file 
name is reserved for each updateable component an hardware release, 
which begins with "px" and differs in a number with six digits. 
As soon as with start-up a pkg file is on the MMC and the firmware is more 
current than in the components, all the pkg file assigned components within 
the CPU and at the SPEED-Bus get the new firmware. 
 

The latest firmware versions may be found in the service area at 
www.vipa.de. 
 
For example the following files are necessary for the firmware update of the 
CPU 517-4NE02 and its components (Profibus, CP 543) with hardware 
release 1: 
• 517-4NE02, Hardware release 1:  Px000118.zip 
• Profibus DP master (integrated):  Px000119.zip 
• Ethernet CP 543 (integrated):  Px000059.zip 
 

Attention! 
When installing a new firmware you have to be extremely careful. Under 
certain circumstances you may destroy the CPU, for example if the voltage 
supply is interrupted during transfer or if the firmware file is defective. 
In this case, please call the VIPA-Hotline! 
Please regard that the version of the update firmware has to be different 
from the existing firmware otherwise no update is executed. 
 
 

Overview 

Latest Firmware at 
www.vipa.de 
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Every SPEED7-CPU has got an integrated web page that monitors 
information about firmware version of the SPEED7 components. The 
Ethernet-PG/OP channel provides the access to this web page.  
More detailed information can be found at "Access to integrated web page". 
 

• Go to www.vipa.de. 
• Navigate to "Firmware". 
• Click at "System 500S". 
• Choose the according modules and download the firmware Px......zip to 

your PC. 
• Extract the zip-file and copy the extracted file to your MMC. 
• Following this approach, transfer all wanted firmware files to your MMC. 
 
 

Attention! 
With a firmware update an overall reset is automatically executed. If your 
program is only available in the load memory of the CPU it is deleted! Save 
your program before executing a firmware update! After the firmware 
update you should execute a "Set back to factory settings" (see following 
page).  

Display firmware 
version of the 
SPEED7 system  
via Web page 

Load firmware and 
transfer it to 
storage media 
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MMC, FRCE, SF, PWR

RN, ST

1. Get the RUN-STOP lever of your CPU in position STOP. Turn off the 
voltage supply. In installed condition depending upon operating 
system now you get a message that the connected partner is no 
longer present. This message can be ignored. Plug the MMC with the 
firmware files into the CPU. Please take care of the correct plug-in 
direction of the MMC. Turn on the voltage supply. 

2. After a short boot-up time, the alternate blinking of the LEDs SF and 
FRCE shows that at least a more current firmware file was found on 
the MMC. 

3. You start the transfer of the firmware as soon as you tip the 
RUN/STOP lever downwards to MRES within 10s.  

4. During the update process, the LEDs SF and FRCE are alternately 
blinking and MMC LED is on. This may last several minutes. 

5. The update is successful finished when the LEDs PWR, STOP, SF, 
FRCE and MCC are on. If they are blinking fast, an error occurred.  

6. Turn Power OFF and ON. Now it is checked by the CPU, whether 
further current firmware versions are available at the MMC. If so, 
again the LEDs SF and FRCE flash after a short start-up period. 
Continue with point 3.  
If the LEDs do not flash, the firmware update is ready. 
Now a factory reset should be executed (see next page). After that 
the CPU is ready for duty. 
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Transfer firmware 
from MMC to CPU 



Chapter 3   Deployment CPU 517S/NET  Manual VIPA System 500S SPEED7 

3-48  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

Factory reset 
 

With the following proceeding the internal RAM of the CPU is completely 
deleted and the CPU is reset to delivery state.  
Please note that here also the MPI address is reset to the default address 2 
and the IP address of the Ethernet PG/OP channel is reset to 0.0.0.0! 
A factory reset may also be executed by the MMC-Cmd FACTORY_ 
RESET. More information may be found at "MMC-Cmd - Auto commands". 
 
1. Switch the CPU to STOP. 
2. Push the operating switch down to position MR for 30s. Here the ST-

LED flashes. After a few seconds the ST-LED changes to static light. 
Now the ST-LED changes between static light and flashing. Starting 
here count the static light states. 

3. After the 6. static light release the operating mode switch and tip it 
shortly downwards to MR. 

4. For the confirmation of the resetting procedure the green run LED gets 
ON within 0.5s. If not the factory reset has failed and only an overall 
reset was executed. In this case you can repeat the procedure. An 
factory reset can only be executed if the stop LED has static light for 
exactly 6 times. 

5. The end of factory reset is showing by static light of the LEDs STOP, 
SF, FRCE and MMC. Switch the power supply off and on. 

 
The proceeding is shown in the following Illustration: 
 

30 Sec.

RN

ST

MR

Tip

CPU in 
STOP

Request factory reset Start factory reset Factory reset
executed

1 3

6x

RN

ST

MR

RN

ST

MR

Tip

1 Sec. 0,5 Sec.

2 4

Error: Only
overall reset
executed

RN ST RN ST RN ST RN ST RN ST RN ST

0,5 Sec.

RN ST

 
 
 
Note! 
After the firmware update you always should execute a Factory reset. 

Proceeding 
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Memory expansion with MCC 
 

You have the option to expand the work memory of your CPU.  
For this, a MCC (Memory Configuration Card) is available at VIPA. The 
MCC is a specially prepared MMC (Multimedia Card). By plugging the MCC 
into the MCC slot and then an overall reset the according memory 
expansion is released. There may only one memory expansion be activated 
at the time.  
On the MCC there is the file memory.key. This file may not be altered or 
deleted. You may use the MCC also as "normal" MMC for storing your 
project.  
 

To extend the memory, plug the MCC into the card slot at the CPU labeled 
with "MCC" and execute an overall reset.  
 

MCC Overall reset 

Tip
3Sec.

RN ST RN ST RN ST

 
→ Memory is extended for the MCC memory configuration  
(diagnostic entry 0xE400). 
If the memory expansion on the MCC exceeds the maximum 
extendable memory range of the CPU, the maximum possible memory 
of the CPU is automatically used.  
You may determine the recent memory extension via the Siemens 
SIMATIC manager at Module  Information - "Memory". 

 

Attention! 
Please regard that the MCC must remain plugged when you’ve executed 
the memory expansion at the CPU. Otherwise the CPU switches to STOP 
after 72h. The MCC can not be exchanged with a MCC of the same 
memory configuration. 
 

When the MCC memory configuration has been set you may find the 
diagnosis entry 0xE400 in the diagnostic buffer of the CPU. 
After pulling the MCC the entry 0xE401 appears in the diagnostic buffer, 
the SF-LED is on and after 72h the CPU switches to STOP. A reboot is 
only possible after plugging-in the MCC again or after an overall reset. 
After re-plugging the MCC, the SF-LED extinguishes and 0xE400 is 
entered into the diagnostic buffer. You may reset the memory configuration 
of your CPU to the initial status at any time by executing an overall reset 
without MCC. 

Overview 

Approach 

 

Behavior 
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Extended know-how protection 
 

Besides the "standard" know-how protection the SPEED7-CPUs from VIPA 
provide an "extended" know-how protection that serves a secure block 
protection for accesses of third persons. 
 
The standard protection from Siemens transfers also protected blocks to 
the PG but their content is not displayed. But with according manipulation 
the know-how protection is not guaranteed. 
 
The "extended" know-how protection developed by VIPA offers the 
opportunity to store blocks permanently in the CPU.  
At the "extended" protection you transfer the protected blocks into a wld file 
named protect.wld. By plugging the MMC and following overall reset, the 
blocks in the protect.wld are permanently stored in the CPU.  
You may protect OBs, FBs and FCs. 
When back-reading the protected blocks into the PG, exclusively the block 
header are loaded. The source remains in the CPU and is thus protected 
for accesses of third persons. 
 

MMCprotect.wld

Blocks

wld file

PC

Tip
3Sec.

RN ST RN ST RN ST

Overall reset

Protected blocks are located in the CPU

 
 

Overview 

Standard protection 

Extended protection 
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Create a new wld file in your project engineering tool with File > Memory 
Card file > New and rename it to "protect.wld".  
Transfer the according blocks into the file by dragging them with the mouse 
from the project to the file window of protect.wld. 
 

Transfer the file protect.wld to a MMC storage module, plug the MMC into 
the CPU and execute an overall reset with the following approach: 
 

3 Sec.

3 Sec.
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ST

MR

RN

ST

MR

RN

ST

MR

RN

ST

MR

1 2 3 4

RN ST RN ST RN STRN ST

 
 
The overall reset stores the blocks in protect.wld permanently in the CPU 
protected from accesses of third persons. 
 

Protected blocks are overwritten by a new protect.wld. 
Using a PG third persons may access protected blocks but only the block 
header is transferred to the PG. The block code that is to protect remains in 
the CPU and can not be read. 
 

Protected blocks in the RAM of the CPU may be substituted at any time by 
blocks with the same name. This change remains up to next overall reset. 
Protected blocks may permanently be overwritten only if these are deleted 
at the protect.wld before. 
By transferring an empty protect.wld from the MMC you may delete all 
protected blocks in the CPU.  
  

Due to the fact that reading of a "protected" block from the CPU monitors 
no symbol labels it is convenient to provide the "block covers" for the end 
user.  
For this, create a project out of all protected blocks. Delete all networks in 
the blocks so that these only contain the variable definitions in the 
according symbolism. 
 

protect blocks 
with protect.wld 

Transfer 
protect.wld to CPU 
with overall reset 

Protection 
behavior 

Change respectively 
delete protected 
blocks 

Usage of 
protected blocks 
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MMC-Cmd - Auto commands 
 

A command file at a MMC may be started automatically when the MMC is 
stuck and the CPU is in STOP. As soon as the MMC is stuck the command 
file is once executed at CPU STOP up to the next PowerON. 
The command file is a text file, which consists of a command sequence to 
be stored as vipa_cmd.mmc in the root directory of the MMC. 
The file has to be started by CMD_START as 1. command, followed by the 
desired commands (no other text) und must be finished by CMD_END as 
last command. 
Text after the last command CMD_END e.g. comments is permissible, 
because this is ignored. As soon as the command file is recognized and 
executed each action is stored at the MMC in the log file logfile.txt. In 
addition for each executed command a diagnostics entry may be found in 
the diagnostics buffer.    
 

In the following there is an overview of the commands. Please regard the 
command sequence is to be started with CMD_START and ended with 
CMD_END. 
 

Command Description Diagnostics entry
CMD_START In the first line CMD_START is to be located. 0xE801  
 There is a diagnostic entry if CMD_START is missing   0xE8FE 
WAIT1SECOND Waits ca. 1 second. 0xE803 
WEBPAGE The current web page of the CPU is stored at the MMC 

as "webpage.htm". 
0xE804 

LOAD_PROJECT The function "Overall reset and reload from MMC" is 
executed. The wld file located after the command is 
loaded else "s7prog.wld" is loaded. 

0xE805 

SAVE_PROJECT 
[password] 

The recent project (blocks and hardware configuration) 
is stored as "s7prog.wld" at the MMC. 
If the file just exists it is renamed to "s7prog.old". 
If your project is password protected you have to add to 
SAVE_PROJECT your password as parameter. 
Example: Password = "vipa": SAVE_PROJECT vipa 

0xE806 

FACTORY_RESET Executes "factory reset". 0xE807 
DIAGBUF The current diagnostics buffer of the CPU is stored as 

"diagbuff.txt" at the MMC. 
0xE80B 

SET_NETWORK IP parameters for Ethernet PG/OP channel may be set 
by means of this command. 
The IP parameters are to be given in the order IP 
address, subnet mask and gateway in the format  
xxx.xxx.xxx.xxx each separated by a comma. 
Enter the IP address if there is no gateway used. 

0xE80E 

CMD_END In the last line CMD_END is to be located. 0xE802 
 

Overview 

Commands 
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The structure of a command file is shown in the following. The 
corresponding diagnostics entry is put in parenthesizes. 
 
 
 

CMD_START Marks the start of the command sequence (0xE801) 
LOAD_PROJECT proj.wld Execute an overall reset and load "proj.wld" (0xE805) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WEBPAGE Store web page as "webpage.htm" (0xE804) 
DIAGBUF Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
CMD_END Marks the end of the command sequence (0xE802) 
... arbitrary  text ... Text after the command CMD_END is not evaluated. 

 
 
 
 

CMD_START Marks the start of the command sequence (0xE801) 
LOAD_PROJECT proj2.wld Execute an overall reset and load "proj2.wld" (0xE805) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WAIT1SECOND Wait ca. 1s (0xE803) 
SET_NETWORK 172.16.129.210,255.255.224.0,172.16.129.210 IP parameter 

(0xE80E) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WAIT1SECOND Wait ca. 1s (0xE803) 
WEBPAGE Store web page as "webpage.htm" (0xE804) 
DIAGBUF Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
CMD_END Marks the end of the command sequence (0xE802) 
... arbitrary  text ... Text after the command CMD_END is not evaluated. 

 
 

Note! 
The parameters IP address, subnet mask and gateway may be received 
from the system administrator.  
Enter the IP address if there is no gateway used. 
 
 

Examples 

Example 1 

Example 2 
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VIPA specific diagnostic entries 
 

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC 
manager. Besides of the standard entries in the diagnostic buffer, the VIPA 
CPUs support some additional specific entries in form of event-IDs. 
The current content of the diagnostics buffer is stored on MMC by means of 
the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd - 
Auto commands". 
 
 
Note! 
Every register of the module information is supported by the VIPA CPUs. 
More information may be found at the online help of the Siemens SIMATIC 
manager. 
 

To monitor the diagnostic entries you choose the option PLC > Module 
Information in the Siemens SIMATIC manager. Via the register "Diagnostic 
Buffer" you reach the diagnostic window: 
 
 

 
 
The diagnosis is independent from the operating mode of the CPU. You 
may store a max. of 100 diagnostic entries in the CPU. 
The following page shows an overview of the VIPA specific Event-IDs. 

Entries in the 
diagnostic buffer 

     

Monitoring the 
diagnostic entries 
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Event-ID Description 
0xE003 Error at access to I/O devices  

Zinfo1: I/O address 
Zinfo2: Slot 

0xE004 Multiple parameterization of a I/O address  
Zinfo1: I/O address 
Zinfo2: Slot 

0xE005 Internal error - Please contact the VIPA-Hotline! 
0xE006 Internal error - Please contact the VIPA-Hotline! 
0xE007 Configured in-/output bytes do not fit into I/O area  
0xE008 Internal error - Please contact the VIPA-Hotline! 
0xE009 Error at access to standard back plane bus 
0xE010 Not defined module group at backplane bus recognized 

Zinfo2: Slot 
Zinfo3: Type ID 

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration 
0xE012 Error at parameterization 
0xE013 Error at shift register access to standard bus digital modules 
0xE014 Error at Check_Sys 
0xE015 Error at access to the master 

Zinfo2: Slot of the master (32=page frame master) 
0xE016 Maximum block size at master transfer exceeded  

Zinfo1: I/O address  
Zinfo2: Slot 

0xE017 Error at access to integrated slave 
0xE018 Error at mapping of the master I/O devices 
0xE019 Error at standard back plane bus system recognition 
0xE01A Error at recognition of the operating mode (8 / 9bit) 
0xE01B Error - maximum number of plug-in modules exceeded 
0xE030 Error of the standard bus 

  
0xE0B0 SPEED7 is not stoppable (probably undefined BCD value at timer) 
0xE0C0 Not enough space in work memory for storing code block (block size exceeded) 
0xE0CC Communication error MPI / Serial 
0xE0CD Error at DPV1 job management 
0xE0CE Error: Timeout at sending of the i-slave diagnostics 

  
0xE100 MMC access error 
0xE101 MMC error file system 
0xE102 MMC error FAT 
0xE104 MMC error at saving 
0xE200 MMC writing finished (Copy Ram2Rom) 

continued ... 

Overview of the 
Event-IDs 
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... continue 
Event-ID Description 
0xE210 MMC reading finished (reload after overall reset) 
0xE21F MMC reading: error at reload (after overall reset), read error, out of memory 

  
0xE400 Memory expansion MCC has been plugged  
0xE401 Memory expansion MCC has been removed 

  
0xE801 MMC-Cmd: CMD_START recognized and successfully executed 
0xE802 MMC-Cmd: CMD_END recognized and successfully executed 
0xE803 MMC-Cmd: WAIT1SECOND recognized and successfully executed 
0xE804 MMC-Cmd: WEBPAGE recognized and successfully executed 
0xE805 MMC-Cmd: LOAD_PROJECT recognized and successfully executed 
0xE806 MMC-Cmd: SAVE_ PROJECT recognized and successfully executed 
0xE807 MMC-Cmd: FACTORY_RESET recognized and successfully executed 
0xE80B MMC-Cmd: DIAGBUF recognized and successfully executed 
0xE80E MMC-Cmd: SET_NETWORK recognized and successfully executed 
0xE8FB MMC-Cmd: Error: Initialization of the Ethernet PG/OP channel by means of  

 SET_NETWORK is faulty. 
0xE8FC MMC-Cmd: Error: Not every IP-Parameter is set at SET_NETWORK. 
0xE8FE MMC-Cmd: Error: CMD_START was not found 
0xE8FF MMC-Cmd: Error: Reading the CMD file is faulty (MMC error) 

  
0xE901 Check sum error 

  
0xEA00 Internal error - Please contact the VIPA-Hotline! 
0xEA01 Internal error - Please contact the VIPA-Hotline! 
0xEA02 SBUS: Internal error (internal plugged sub module not recognized) 

Zinfo1: Internal slot 
0xEA04 SBUS: Multiple parameterization of a I/O address 

Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA05 Internal error - Please contact the VIPA-Hotline! 
0xEA07 Internal error - Please contact the VIPA-Hotline! 
0xEA08 SBUS: Parameterized input data width unequal to plugged input data width 

Zinfo1: Parameterized input data width 
Zinfo2: Slot 
Zinfo3: Input data width of the plugged module 

0xEA09 SBUS: Parameterized output data width unequal to plugged output data width 
Zinfo1: Parameterized output data width 
Zinfo2: Slot 
Zinfo3: Output data width of the plugged module 

continued ... 
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... continue 
Event-ID Description 
0xEA10 SBUS: Input address outside input area 

Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA11 SBUS: Output address outside output area 
Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA12 SBUS: Error at writing record set 
Zinfo1: Slot 
Zinfo2: Record set number 
Zinfo3: Record set length 

0xEA14 SBUS: Multiple parameterization of a I/O address (Diagnostic address) 
Zinfo1: I/O address 
Zinfo2: Slot 
Zinfo3: Data width 

0xEA15 Internal error - Please contact the VIPA-Hotline! 
0xEA18 SBUS: Error at mapping of the master I/O devices 

Zinfo2: Master slot 
0xEA19 Internal error - Please contact the VIPA-Hotline! 
0xEA20 Error - RS485 interface is not set to Profibus DP master but there is a Profibus DP 

master configured.  
0xEA21 Error - Project engineering RS485 interface X2/X3: 

Profibus DP master is configured but missing 
Zinfo2: Interface x 

0xEA22 Error - RS485 interface X2 - value is out of range 
Zinfo: Configured value X2 

0xEA23 Error - RS485 interface X3 - value is out of range 
Zinfo: Configured value X3 

0xEA24 Error - Project engineering RS485 interface X2/X3: 
Interface/Protocol is missing, the default settings are used. 
Zinfo2: Configured value X2 
Zinfo2: Configured value X3 

  
0xEA30 Internal error - Please contact the VIPA-Hotline! 
0xEA40 Internal error - Please contact the VIPA-Hotline! 
0xEA41 Internal error - Please contact the VIPA-Hotline! 

  
0xEA98 Timeout at waiting for reboot of a SBUS module (Server)  
0xEA99 Error at file reading via SBUS 

  
0xEE00 Internal error - Please contact the VIPA-Hotline! 
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Using test functions for control and monitoring of variables 
 

For troubleshooting purposes and to display the status of certain variables 
you can access certain test functions via the menu item Debug of the 
Siemens SIMATIC manager. 
The status of the operands and the VKE can be displayed by means of the 
test function Debug > Monitor. 
You can modify and/or display the status of variables by means of the test 
function PLC > Monitor/Modify Variables. 
 

This test function displays the current status and the VKE of the different 
operands while the program is being executed.   
It is also possible to enter corrections to the program. 
 

Note! 
When using the test function “Monitor” the PLC must be in RUN mode! 
 

The processing of the states may be interrupted by means of jump 
commands or by timer and process-related alarms. At the breakpoint the 
CPU stops collecting data for the status display and instead of the required 
data it only provides the PG with data containing the value 0. 
For this reason, jumps or time and process alarms can result in the value 
displayed during program execution remaining at 0 for the items below: 
 
• the result of the logical operation VKE 
• Status / AKKU 1 
• AKKU 2 
• Condition byte 
• absolute memory address SAZ. In this case SAZ is followed by a "?". 
 
The interruption of the processing of statuses does not change the 
execution of the program. It only shows that the data displayed is no longer. 

Overview 

Debug > Monitor 
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This test function returns the condition of a selected operand (inputs, 
outputs, flags, data word, counters or timers) at the end of program-
execution.   
This information is obtained from the process image of the selected 
operands. During the "processing check" or in operating mode STOP the 
periphery is read directly from the inputs. Otherwise only the process image 
of the selected operands is displayed. 
 
Control of outputs 
It is possible to check the wiring and proper operation of output-modules.   
You can set outputs to any desired status with or without a control program. 
The process image is not modified but outputs are no longer inhibited. 
 
Control of variables 
The following variables may be modified: 
I, Q, M, T, C and D. 
The process image of binary and digital operands is modified independently 
of the operating mode of the CPU 51xS.    
When the operating mode is RUN the program is executed with the 
modified process variable. When the program continues they may, 
however, be modified again without notification. 
Process variables are controlled asynchronously to the execution sequence 
of the program. 
 
 
 
 

PLC > 
Monitor/Modify 
Variables 
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Chapter 4  Deployment CPU with Profibus 
 

Content of this chapter is the deployment of the CPU 517S/NET with 
Profibus. After a short overview the project engineering and 
parameterization of a CPU 517S/NET with integrated Profibus-Part from 
VIPA is shown. 
Further you get information about usage as DP master and DP slave of the 
Profibus part.  
The chapter is ended with notes to commissioning and start-up. 
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Chapter 4 Deployment CPU with Profibus ..................................... 4-1 
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Overview 
 

Profibus is an international standard applicable to an open and serial field 
bus for building, manufacturing and process automation that can be used 
to create a low (sensor-/actuator level) or medium (process level) 
performance network of programmable logic controllers.  
Profibus comprises an assortment of compatible versions. The following 
details refer to Profibus DP. 
Profibus DP is a special protocol intended mainly for automation tasks in a 
manufacturing environment. DP is very fast, offers Plug'n'Play facilities and 
provides a cost-effective alternative to parallel cabling between PLC and 
remote I/O. Profibus-DP was designed for high-speed data communication 
on the sensor-actuator level. The data transfer referred to as "Data 
Exchange" is cyclical. During one bus cycle, the master reads input values 
from the slaves and writes output information to the slave. 
 
The Profibus DP master is to configure via the hardware configurator from 
Siemens. Therefore you have to choose the Siemens-CPU 318-2AJ00 in 
the hardware configurator from Siemens. 
The transmission of your project engineering into the CPU takes place by 
means of MPI. This is internally passing on your project data to the 
Profibus master part. 
During the start-up the DP master automatically includes his data areas 
into the address range of the CPU. A project engineering in the CPU is not 
required. 
As external storage medium the Profibus DP master uses the MMC 
(Multi Media Card) together with the CPU. 
 
Via the Profibus DP master up to 124 Profibus DP slaves may be coupled 
to the CPU. The DP master communicates with the DP slaves and links up 
its data areas with the address area of the CPU. There may be created 
maximal 1024Byte Input and 1024Byte Output data. 
At every POWER ON res. overall reset the CPU fetches the I/O mapping 
data from the master. 
At DP slave failure, the ER-LED is on and the OB 86 is requested. If this is 
not available, the CPU switches to STOP and BASP is set. 
As soon as the BASP signal comes from the CPU, the DP master is setting 
the outputs of the connected periphery to zero. The DP master remains in 
the operating mode RUN independent from the CPU.  
 
For the deployment in an super-ordinated master system you first have to 
project your slave system as CPU 318-2DP (6ES7 318-2AJ00-0AB0/V3.0) 
in Slave operation with configured in-/output areas. Afterwards you 
configure your master system. Assign your slave system to your master 
system by dragging the "CPU 31x" from the hardware catalog at 
Configured stations onto the master system, choose your slave system and 
connect it. 
 

Profibus DP 

CPU with 
DP master 

Deployment of the 
DP Master with 
CPU 

DP slave operation 
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Project engineering CPU with integrated Profibus master 
 

For the project engineering of the Profibus DP master you have to use the 
hardware manager from Siemens. Your Profibus projects are transferred 
via MPI to the CPU by means of the "PLC" functions. The CPU passes the 
data on to the Profibus DP master. 
 

For the project engineering of the Profibus DP master in the  
CPU 51xS/DPM the following preconditions have to be fulfilled:  
• Siemens SIMATIC Manager has to be installed. 
• With Profibus DP slaves of the Systems 100V, 200V and 300V from 

VIPA: GSD Files are included into the hardware configurator. 
• There is a transfer possibility between configuration tool and CPU 51xS. 
 

Note! 
For the project engineering of the CPU and the Profibus DP master a 
thorough knowledge of the Siemens SIMATIC manager is required! 
 

The hardware configurator is a part of the Siemens SIMATIC Manager. It 
serves the project engineering. The modules that may be configured here, 
are listed in the hardware catalog. 
For the deployment of the Profibus DP slaves of the Systems 100V, 200V 
and 300V from VIPA you have to include the modules into the hardware 
catalog by means of the GSD file from VIPA. 
 

• Create a new project System 300. 
• Add a profile rail from the hardware catalog. 
• In the hardware catalog the CPU with Profibus master is listed as:  

Simatic300/CPU-300/CPU318-2DP/6ES7 318-2AJ00-0AB0 

• Insert the CPU 318-2DP (6ES7 318-2AJ00-0AB0). 
• Type the Profibus address of your master (e.g. 2). 
• Click on DP, choose the operating mode "DP master" under object 

properties and confirm your entry with OK. 
• Click on "DP" with the right mouse button and choose "add master 

system".  
• Create a new Profibus subnet via NEW. 
 

 
 

Overview 

Preconditions 

     

Install Siemens 
Hardware 
configurator 

Configure  
DP master 



Chapter 4   Deployment CPU with Profibus Manual VIPA System 500S SPEED7  

4-4  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

 
 

Now the project engineering of your Profibus DP master is finished. Please 
link up now your DP slaves with periphery to your DP master. 
• For the project engineering of Profibus DP slaves you search the 

concerning Profibus DP slave in the hardware catalog and drag&drop it 
in the subnet of your master. 

• Assign a valid Profibus address to the DP slave. 
• Link up the modules of your DP slave system in the plugged sequence 

and add the addresses that should be used by the modules. 
• If needed, parameterize the modules. 
 

You may deploy your Profibus part from the SPEED7-CPU as DP slave. 
The approach is described on the following page. 
 
 

Slave operation 
possible 
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Deployment as Profibus DP slave 
 

The deployment of the Profibus section as "intelligent" DP slave happens 
exclusively at master systems that may be configured in the Siemens 
SIMATIC manager. The following steps are required: 
• Start the Siemens SIMATIC manager and configure a CPU 318-2DP 

with the operating mode DP slave. 
• Connect to Profibus and configure the in-/output area for the slave 

section. 
• Save and compile your project. 
• Configure another station as CPU 318-2DP with operating mode DP 

master. 
• Connect to Profibus and configure the in-/output area for the master 

section 
• Save and compile your project. 
In the following these steps are more detailed. 
 

• Start the Siemens SIMATIC manager with a new project. 
• Insert a SIMATIC 300 station and name it as "...DP slave" 
• Open the hardware configurator and insert a profile rail from the 

hardware catalog. 
• Place the following Siemens CPU at slot 2:  

CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0) 
• Connect the CPU to Profibus, set a Profibus address >1 (preferably 3) 

and switch the Profibus section via operating mode to "slave operation". 
• Via Configuration you define the in-/output address area of the slave 

CPU that shall be assigned to the DP slave. 
• Save and compile your project 
 

Module

CPU 318-2
DP
MPI/DP

Standard bus
Slot

1
2

X2
X1
3

Object properties
Operating mode: DP slave
Connect: Profibus
Profibus address: > 1

Configuration:
Input area 
Output area

Slave section

 
 
 
 

Fast introduction 

Project 
engineering of the 
slave section 
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• Insert another SIMATIC 300 station and name it as "...DP master". 
• Open the hardware configurator and insert a profile rail from the 

hardware catalog. 
• Place the following Siemens CPU at slot 2:  

CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0) 
• Add your modules according to the real hardware assembly.  
• Connect the CPU to Profibus, set a Profibus address >1 (preferably 2) 

and switch the Profibus section via operating mode to "master 
operation". 

• Connect your slave system to the master system by dragging the "CPU 
31x" from the hardware catalog at configured stations onto the master 
system and select your slave system. 

• Open the Configuration at Object properties of your slave system. 
• Via double click to the according configuration line you assign the 

according input address area on the master CPU to the slave output 
data and the output address area to the slave input data. 

• Save and compile your project. 
 

Module

CPU 318-2
DP
MPI/DP

Standard bus
Slot

1
2

X2
X1
3

Object properties
Operating mode: DP master
Connect: Profibus
Profibus address: > 1

Master section

DP master system

S7-300
Hardware catalog: CPU 31x from 
configured stations

Object properties
Configuration:
Input area slave CPU =  Output area master-CPU
Output area slave CPU =  Input area master-CPU

1
2

3

 
     

Note! 
Data consistency can only be guaranteed for one unit! The choice "Data 
consistency by length" is not supported. 
 
 

Project 
engineering of the 
master section 
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Project transfer 
 

The following options are available to transfer a project into the CPU 51x 
slot card:  
• internal via PCI slot (Ethernet connection) 
• external via PC network card (routing necessary) 
• external via MPI 
• external via Profibus (not for first project) 
• external via MMC storage card 
 

  
 
More about the transfer methods may be found at chapter "Deployment 
CPU 51xS" at "Project transfer". 
 

 

Overview 
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Profibus installation guidelines 
 

• A Profibus DP network may only be built up in linear structure. 
• Profibus DP consists of minimum one segment with at least one master 

and one slave. 
• A master has always been deployed together with a CPU. 
• Profibus supports max. 124 participants. 
• Per segment a max. of 32 participants is permitted. 
• The max. segment length depends on the transfer rate:  

9.6 ... 187.5kbit/s → 1000m 
500kbit/s  → 400m 
1.5Mbit/s  → 200m 
3 ... 12Mbit/s  → 100m 

• Max. 10 segments may be built up. The segments are connected via 
repeaters. Every repeater counts for one participant. 

• All participants are communicating with the same transfer rate. The 
slaves adjust themselves automatically on the transfer rate. 

• The bus has to be terminated at both ends. 
• Master and slaves are free combinable. 
 

As transfer medium Profibus uses an isolated twisted-pair cable based 
upon the RS485 interface.  
The RS485 interface is working with voltage differences. Though it is less 
irritable from influences than a voltage or a current interface. You are able 
to configure the network as well linear as in a tree structure.  
Your VIPA CPU includes a 9pin slot "PBDP" where you connect the 
Profibus coupler into the Profibus network as a slave. 
Max. 32 participants per segment are permitted. The segments are 
connected via repeaters. The maximum segment length depends on the 
transfer rate. 
Profibus DP uses a transfer rate between 9.6kbit/s and 12Mbit/s, the slaves 
are following automatically. All participants are communicating with the 
same transfer rate.  
The bus structure under RS485 allows an easy connection res. 
disconnection of stations as well as starting the system step by step. Later 
expansions don’t have any influence on stations that are already 
integrated. The system realizes automatically if one partner had a fail down 
or is new in the network. 

Profibus in 
general 

Transfer medium 
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The following picture illustrates the terminating resistors of the respective 
start and end station. 
 

RxD/TxD-P(B)

Shield

Master Slave

3

8

3

8

Shield

P5V P5V

M5V M5V

330 330

330 330

220 220

Shield

3

8RxD/TxD-N(A)

5

6

RxD/TxD-P(B)

RxD/TxD-N(A)

Slave

RxD/TxD-P(B)

RxD/TxD-N(A)

5

3

8

6

 
 

Note! 
The Profibus line has to be terminated with its ripple resistor. Please make 
sure to terminate the last participants on the bus at both ends by activating 
the terminating resistor. 
 

 
 

 

In systems with more than two stations all partners are wired in parallel. 
For that purpose, the bus cable must be feed-through uninterrupted. 
Via the order number VIPA 972-0DP10 you may order the bus connector 
"EasyConn". This is a bus connector with switchable terminating resistor 
and integrated bus diagnostic. 

C

A

B

90°

A

B

0°

B

A

45°

 
 

 0° 45° 90° 
A 64 61 66 
B 34 53 40 
C 15.8 15.8 15.8 

     all in mm 
 
 

Bus connection 

     

EasyConn 
bus connector 
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Note! 
To connect this EasyConn plug, please use the standard Profibus cable 
type A  (EN50170). Starting with release 5 you also can use highly flexible 
bus cable: Lapp Kabel order no.: 2170222, 2170822, 2170322. 
With the order no. 905-6AA00 VIPA offers the "EasyStrip" de-isolating tool 
that makes the connection of the EasyConn much easier.  
 

11 6

       
Dimensions in mm  
 
 
The "EasyConn" bus connector is provided with a switch that is used to 
activate a terminating resistor. 
 

 

Attention! 
The terminating resistor is only effective, if the connector 
is installed at a slave and the slave is connected to a 
power supply. 
 
Note! 
A complete description of installation and deployment of 
the terminating resistors is delivered with the connector. 

 

 

• Loosen the screw. 
• Lift contact-cover. 
• Insert both wires into the ducts 

provided (watch for the correct  
line color as below!) 

• Please take care not to cause a  
short circuit between screen and  
data lines! 

• Close the contact cover. 
• Tighten screw  

(max. tightening torque 4Nm). 
 
The green line must be connected to A, the red line to B! 
 
 

     

Termination with 
"EasyConn" 

Assembly 

Please note: 
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Commissioning and Start-up behavior 
 

In delivery the CPU is overall reset. The Profibus part is deactivated and its 
LEDs are off after Power ON. 
 

The DP master can be served with bus parameters by means of a 
hardware configuration. A soon as these are transferred the DP master 
goes online with his bus parameter. This is shown by the RUN LED. Now 
the DP master can be contacted via Profibus by means of his Profibus 
address. In this state the CPU can be accessed via Profibus to get 
configuration and DP slave project. 
 

If the master has received valid configuration data, he switches to Data 
Exchange with the DP Slaves. This is indicated by the DE-LED. 
 

After Power ON respectively a receipt  of a new hardware configuration the 
configuration data and bus parameter were transferred to the DP master. 
The DP master does not have any operation switch. His state is controlled 
by the RUN/STOP state of the CPU. 
Dependent on the CPU state the following behavior is shown by the DP 
master: 
 
• The global control command "Operate" is sent to the slaves by the 

master. Here the DE-LED is ON. 
• Every connected DP slave is cyclically attended with an output telegram 

containing recent output data. 
• The input data of the DP slaves were cyclically transferred to the input 

area of the CPU. 
 
• The global control command "Clear" is sent to the slaves by the master. 

Here the DE-LED is blinking. 
• DP slaves with fail safe mode were provided with output telegram length 

"0". 
• DP slaves without fail safe mode were provided with the whole output 

telegram but with output data = 0. 
• The input data of the DP slaves were further cyclically transferred to the 

input area of the CPU. 
 
 

Start-up on 
delivery 

Online with bus 
parameter without 
slave project 

Slave 
configuration 

CPU state controls 
DP master 

Master behavior at 
CPU RUN 

Master behavior at 
CPU RUN 
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Chapter 5  Deployment PtP communication 
 

Content of this chapter is the deployment of the RS485 slot for serial PtP 
communication.  
Here you’ll find all information about the protocols and project engineering 
of the interface, which are necessary for the serial communication using 
the RS485 interface. 
 

 

Topic     Page 
Chapter 5 Deployment PtP communication ................................... 5-1 

Fast introduction................................................................................... 5-2 
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Communication .................................................................................... 5-9 
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Fast introduction 
 

Via a hardware configuration you may de-activate the Profibus part 
integrated to the CPU 51xS and thus release the RS485 interface for PtP 
(point-to-point) communication. 
The RS485 interface supports in PtP operation the serial process 
connection to different source res. destination systems.  
 

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus 
are supported. 
 

The parameterization of the serial interface happens during runtime using 
the SFC 216 (SER_CFG). For this you have to store the parameters in a 
DB for all protocols except ASCII.  
 

The SFCs are controlling the communication. Send takes place via  
SFC 217 (SER_SND) and receive via SFC 218 (SER_RCV).  
The repeated call of the SFC 217 SER_SND delivers a return value for 
3964R, USS and Modbus via RetVal that contains, among other things, 
recent information about the acknowledgement of the partner station. 
The protocols USS and Modbus allow to evaluate the receipt telegram by 
calling the SFC 218 SER_RCV after SER_SND. 
The SFCs are included in the consignment of the CPU. 
 

The following SFCs are used for the serial communication: 
 

SFC Description 
SFC 216 SER_CFG RS485 parameterize 
SFC 217 SER_SND RS485 send  
SFC 218 SER_RCV RS485 receive 

 
 

General 

Protocols 

Parameterization 

Communication 

Overview SFCs  
for serial 
communication 
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Principle of the data transfer 
 

The data transfer is handled during runtime by using SFCs. The principle of 
data transfer is the same for all protocols and is shortly illustrated in the 
following. 
 

Data, which are written into the according data channel by the PLC, is 
stored in a FIFO send buffer (first in first out) with a size of 2x1024byte 
and then put out via the interface. 
When the interface receives data, this is stored in a FIFO receive buffer 
with a size of 2x1024byte and can there be read by the PLC. 
If the data is transferred via a protocol, the adoption of the data to the 
according protocol happens automatically. 
In opposite to ASCII and STX/ETX, the protocols 3964R, USS and Modbus 
require the acknowledgement of the partner. 
An additional call of the SFC 217 SER_SND causes a return value in 
RetVal that includes among others recent information about the 
acknowledgement of the partner. 
Further on for USS and Modbus after a SER_SND the acknowledgement 
telegram must be evaluated by call of the SFC 218 SER_RCV. 
 

Protocol FIFO Buffer

1024Byte

1024Byte

1024Byte

1024Byte

IN

OUT

RS485

InterfaceProgram

SER_RCV
SFC 218

CFG

RECEIVE

SEND
SER_SND
SFC 217

SER_CFG
SFC 216

RS485 PtP communication

 
 
 

Overview 

Principle 
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Deployment of RS485 interface for PtP 
 

Per default, the RS485 interface X3 of the CPU is used for the Profibus DP 
master. Via hardware configuration the RS485 interfaces may be switched 
to point-to-point communication via the Parameter Function RS485 X3 of 
the Properties. 
 
The hardware configuration happens as described at "Project engineering" 
by means of a virtual Profibus master system with the following approach: 
 

Object properties:
Function RS485 

Standard bus

virtual DP master for CPU
(only for VIPA specific 
object properties)

(100) VIPA

VIPA_SPEEDBUS
Slot
0

Module

CPU 318-2
DP
MPI/DP

342-5DA02 V5.0

Slot
1
2

X2
X1
3

343-1EX11
(Ethernet-PG/OP)
343-1EX11
(for CP 543)

Order no.
CPU 51xS at slot 100

CPU:
Addr.: 100

 

• Start the Siemens hardware configurator. 
• Configure the Siemens CPU 318-2AJ00  

(6ES7 318-2AJ00-0AB0/V3.0).  
• Configure a Siemens CP 343-1 (343-1EX11) for the internal 

Ethernet PG/OP channel. 
• Configure the integrated CP 543 of the CPU 517/NET always as  

2. CP after the placed Ethernet PG/OP channel as  
CP343-1 (343-1EX11). 

• Configure always as last module a Siemens DP master CP 342-5 
(342-5DA02 V5.0). Connect and parameterize it at operation mode 
"DP-Master". 

• Connect the slave system "VIPA_SPEEDbus".  
• For the slave system set the Profibus address 100. 
• Configure at slot 0 the VIPA CPU 51xS of the hardware catalog 

from VIPA_SPEEDbus. 
• By double clicking the placed CPU 51xS the properties dialog of 

the CPU may be opened.  
• Switch the Parameter Function RS485 X3 to "PtP". 
 
As soon as the project is transferred together with the PLC user 
program to the CPU, the parameters will be taken after start-up. 
 

 
 
 

Switch to PtP 
operation 

Hardware 
configuration 
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• Logical states represented by voltage differences between the two cores 
of a twisted pair cable 

• Serial bus connection in two-wire technology using half duplex mode 
• Data communications up to a max. distance of 500m 
• Data communication rate up to 115.2kbit/s 
 

9pin SubD jack 
Pin Assignment 
1 n.c. 
2 M24V 
3 RxD/TxD-P (Line B) 
4 RTS 
5 M5V 
6 P5V 
7 P24V 
8 RxD/TxD-N (Line A) 

 

5

4

3

2

1

9

8

7

6

 
9 n.c. 

 
 

RxD/TxD-P (B)

RxD/TxD-N (A)

Shield

CPU - RS485 Periphery

3

8

Periphery

Periphery

RxD/TxD-P (B)

RxD/TxD-N (A)

RxD/TxD-P (B)

RxD/TxD-N (A)

RxD/TxD-P (B)

RxD/TxD-N (A)

 

 
 

Properties RS485 

Connection 
RS485 

Connection 
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Parameterization 
 

The parameterization happens during runtime deploying the SFC 216 
(SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS 
and Modbus in a DB. 
 

Name Declaration Type Comment 
Protocol IN BYTE 1=ASCII, 2=STX/ETX, 3=3964R 
Parameter IN ANY Pointer to protocol-parameters 
Baudrate IN BYTE Number of the baudrate 
CharLen IN BYTE 0=5Bit, 1=6Bit, 2=7Bit, 3=8Bit 
Parity IN BYTE 0=None, 1=Odd, 2=Even 
StopBits IN BYTE 1=1Bit, 2=1.5Bit, 3=2Bit 
FlowControl IN BYTE 1 (fix) 
RetVal OUT WORD Return value (0 = OK) 

 

All time settings for timeouts must be set as hexadecimal value. Find the 
hex value by multiply the wanted time in seconds with the baud rate. 
 
Example: Wanted time 8ms at a baud rate of 19200Baud 
   Calculation: 19200bit/s x 0.008s ≈ 154Bit → (9Ah)  
   Hex value is 9Ah. 
 

Here you fix the protocol to be used. You may choose between: 
1: ASCII 
2: STX/ETX 
3: 3964R 
4: USS Master 
5: Modbus RTU Master 
6: Modbus ASCII Master 
 

SFC 216 
(SER_CFG) 

Parameter 
description 

Protocol 
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At ASCII protocol, this parameter is ignored. 
At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the 
communication parameters and has the following structure for the 
according protocols: 
 
Data block at STX/ETX 
DBB0: STX1 BYTE (1. Start-ID in hexadecimal)   
DBB1: STX2 BYTE (2. Start-ID in hexadecimal)   
DBB2: ETX1 BYTE (1. End-ID in hexadecimal)   
DBB3: ETX2 BYTE (2. End-ID in hexadecimal) 
DBW4: TIMEOUT    WORD (max. delay time between 2 telegrams)  
 

Note! 
The start res. end sign should always be a value <20, otherwise the sign is 
ignored! 
With not used IDs please always enter FFh! 
 
Data block at 3964R 
DBB0: Prio BYTE (The priority of both partners must be 
    different)   
DBB1: ConnAttmptNr BYTE (Number of connection trials)   
DBB2: SendAttmptNr BYTE (Number of telegram retries)   
DBW4: CharTimeout WORD (Character delay time) 
DBW6: ConfTimeout WORD (Acknowledgement delay time)  
 
Data block at USS 
DBW0: Timeout WORD (Delay time in)  
 
Data block at Modbus-Master 
DBW0: Timeout WORD (Respond delay time)  
 

Velocity of data transfer in bit/s (Baud).  
04h: 1200Baud 05h: 1800Baud 06h: 2400Baud 07h: 4800Baud 
08h: 7200Baud 09h: 9600Baud 0Ah: 14400Baud 0Bh: 19200Baud
0Ch: 38400Baud 0Dh: 57600Baud 0Eh: 115200Baud  
 

Number of data bits where a character is mapped to. 
0: 5Bit 1: 6Bit 2: 7Bit 3: 8Bit 
 

Parameter (as DB) 

     

Baudrate 

CharLen 
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The parity is -depending on the value- even or odd. For parity control, the 
information bits are extended with the parity bit that amends via its value 
("0" or "1") the value of all bits to a defined status. If no parity is set, the 
parity bit is set to "1", but not evaluated. 
0: NONE 1: ODD 2: EVEN 
 

The stop bits are set at the end of each transferred character and mark the 
end of a character.  
1: 1Bit 2: 1.5Bit 3: 2Bit 
 

The parameter FlowControl is ignored. When sending RST=1, when 
receiving RST=0. 
 

Return values send by the block: 
 

Error code Description 
0000h no error 
809Ah interface not found 
8x24h Error at SFC-Parameter x, with x: 

1: Error at "Protocol" 
2: Error at "Parameter" 
3: Error at "Baudrate"  
4: Error at "CharLength"  
5: Error at "Parity"  
6: Error at "StopBits"  
7: Error at "FlowControl" (Parameter missing) 

809xh Error in SFC parameter value x, where x: 
1: Error at "Protocol" 
3: Error at "Baudrate"  
4: Error at "CharLength"  
5: Error at "Parity"  
6: Error at "StopBits"  
7: Error at "FlowControl"  

8092h Access error in parameter DB (DB too short) 
828xh Error in parameter x of DB parameter, where x: 

1: Error 1. parameter 
2: Error 2. parameter 
... 

 

Parity 

StopBits 

FlowControl 

RetVal SFC 216 
(Error message 
SER_CFG) 
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Communication 
 

The communication happens via the send and receive blocks SFC 217 
(SER_SND) and SFC 218 (SER_RCV).  
The SFCs are included in the consignment of the CPU. 
 

This block sends data via the serial interface. 
The repeated call of the SFC 217 SER_SND delivers a return value for 
3964R, USS and Modbus via RetVal that contains, among other things, 
recent information about the acknowledgement of the partner station. 
The protocols USS and Modbus require to evaluate the receipt telegram by 
calling the SFC 218 SER_RCV after SER_SND. 
 

 
Name Declaration Type Comment 
DataPtr IN ANY Pointer to Data Buffer for sending data 
DataLen OUT WORD Length of data sent 
RetVal OUT WORD Return value (0 = OK) 

 

Here you define a range of the type Pointer for the send buffer where the 
data that has to be sent is stored. You have to set type, start and length. 
Example: Data is stored in DB5 starting at 0.0 with a length of  
   124Byte. 
   DataPtr:=P#DB5.DBX0.0 BYTE 124  
 

Word where the number of the sent Bytes is stored. 
At ASCII if data were sent by means of SFC 217 faster to the serial 
interface than the interface sends, the length of data to send could differ 
from the DataLen due to a buffer overflow. This should be considered by 
the user program. 
With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr 
is stored or 0. 
 

Overview 

SFC 217 
(SER_SND)  

Parameter 

DataPtr  

DataLen  
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Return values of the block: 
 

Error code Description 
0000h Send data - ready 
1000h Nothing sent (data length 0) 
20xxh Protocol executed error free with xx bit pattern for 

diagnosis 
7001h Data is stored in internal buffer - active (busy) 
7002h Transfer - active 
80xxh Protocol executed with errors with xx bit pattern for 

diagnosis (no acknowledgement by partner) 
90xxh Protocol not executed with xx bit pattern for diagnosis (no 

acknowledgement by partner) 
8x24h Error in SFC parameter x, where x: 

1: Error in "DataPtr" 
2: Error in "DataLen"  

8122h Error in parameter "DataPtr" (e.g. DB too short) 
807Fh Internal error 
809Ah Interface not found or interface is used for Profibus 
809Bh Interface not configured 

 
 
ASCII 

Value Description 
9000h Buffer overflow (no data send) 
9002h Data too short (0Byte) 

 
STX/ETX 

Value Description 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024Byte) 
9002h Data too short (0Byte) 
9004h Character not allowed 

 
3964R 

Value Description 
2000h Send ready without error 
80FFh NAK received - error in communication 
80FEh Data transfer without acknowledgement of partner or error 

at acknowledgement 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024Byte) 
9002h Data too short (0Byte) 

 
 

RetVal SFC 217 
(Error message 
SER_SND) 

Protocol specific 
RetVal values 
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USS 
Error code Description 

2000h Send ready without error 
8080h Receive buffer overflow (no space for receipt) 
8090h Acknowledgement delay time exceeded 
80F0h Wrong checksum in respond 
80FEh Wrong start sign in respond 
80FFh Wrong slave address in respond 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024Byte) 
9002h Data too short (<2Byte) 

 
Modbus RTU/ASCII Master 

Error code Description 
2000h Send ready (positive slave respond) 
2001h Send ready (negative slave respond) 
8080h Receive buffer overflow (no space for receipt) 
8090h Acknowledgement delay time exceeded 
80F0h Wrong checksum in respond 
80FDh Length of respond too long 
80FEh Wrong function code in respond 
80FFh Wrong slave address in respond 
9000h Buffer overflow (no data send) 
9001h Data too long (>1024Byte) 
9002h Data too short (<2Byte) 

 
 

... Continue  
RetVal SFC 217 
SER_SND 
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The following text shortly illustrates the structure of programming a send 
command for the different protocols. 
 
 

3964R       USS / Modbus 
 

SFC 217
SER_SND

Busy ?

RetVal 8xxxh / 
90xxh ?

RetVal 2001h ?

RetVal 2000h ?

N

N

N

Error evaluation

End

J

J

J

Data evaluation

End

N

J

SFC 217
SER_SND

Busy ?

RetVal 8xxxh / 
90xxh ?

RetVal 2001h ?

RetVal 2000h ?

N

N

N

SFC 218
SER_RCV

Error evaluation

End

J

J

J

SFC 218 
SER_RCV

Data evaluation

End

N

J

 
 
ASCII / STX/ETX 
 

SFC 217
SER_SND

RetVal 900xh

Error evaluation

End

J

N

 
 

Principles of 
programming 
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This block receives data via the serial interface.  
Using the SFC 218 SER_RCV after SER_SND with the protocols USS and 
Modbus the acknowledgement telegram can be read. 
 

 
Name Declaration Type Comment 
DataPtr IN ANY Pointer to Data Buffer for received data 
DataLen OUT WORD Length of received data 
Error OUT WORD Error Number 
RetVal OUT WORD Return value (0 = OK) 

 
Here you set a range of the type Pointer for the receive buffer where the 
reception data is stored. You have to set type, start and length. 
Example: Data is stored in DB5 starting at 0.0 with a length of 124Byte. 
  DataPtr:=P#DB5.DBX0.0 BYTE 124  
 
Word where the number of received Bytes is stored. 
At STX/ETX and 3964R, the length of the received user data or 0 is 
entered. 
At ASCII, the number of read characters is entered. This value may be 
different from the read telegram length.  
 
This word gets an entry in case of an error. The following error messages 
may be created depending on the protocol: 
ASCII  
Bit Error Description 
0 overrun Overflow, a sign couldn’t be read fast enough from the 

interface 
1 framing error Error that shows that a defined bit frame is not 

coincident, exceeds the allowed length or contains an 
additional Bit sequence (Stopbit error) 

2 parity Parity error 
3 overflow Buffer is full 

 
STX/ETX  
Bit Error Description 
0 overflow The received telegram exceeds the size of the receive 

buffer. 
1 char A sign outside the range 20h...7Fh has been received.
3 overflow Buffer is full 

 
3964R / Modbus RTU/ASCII Master 

SFC 218 
(SER_RCV)  

Parameter 

DataPtr  

DataLen  

Error 

Bit Error Description 
0 overflow The received telegram exceeds the size of the receive 

buffer. 
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Return values of the block: 
 

Error code Description 
0000h no error 
1000h Receive buffer too small (data loss) 
8x24h Error at SFC-Parameter x, with x: 

1: Error at "DataPtr" 
2: Error at "DataLen"  
3:  Error at "Error" 

8122h Error in parameter "DataPtr" (e.g. DB too short) 
809Ah Serial interface not found res. interface is used by Profibus 
809Bh Serial interface not configured 

 

The following picture shows the basic structure for programming a receive 
command. This structure can be used for all protocols. 
 

SFC 218
SER_RCV

RetVal 0000h ?

RetVal 8xxxh ?

N Data evaluation

End

J

Error evaluation

End

N

J

 
 
 
 

RetVal SFC 218 
(Error message 
SER_RCV) 

Principles of 
programming 
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Protocols and procedures  
 

The CPU supports the following protocols and procedures: 
• ASCII communication 
• STX/ETX 
• 3964R 
• USS 
• Modbus 
 

ASCII data communication is one of the simple forms of data exchange.  
Incoming characters are transferred 1 to 1. 
At ASCII, with every cycle the read-SFC is used to store the data that is in 
the buffer at request time in a parameterized receive data block. If a 
telegram is spread over various cycles, the data is overwritten. There is no 
reception acknowledgement. The communication procedure has to be 
controlled by the concerning user application.  
 

STX/ETX is a simple protocol with start and end ID, where STX stands for 
Start of Text and ETX for End of Text.   
The STX/ETX procedure is suitable for the transfer of ASCII characters. It 
does not use block checks (BCC). Any data transferred from the periphery 
must be preceded by a start followed by the data characters and the end 
character.  
Depending of the byte width the following ASCII characters can be 
transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh. 
The effective data, which includes all the characters between Start and End 
are transferred to the PLC when the End has been received. 
When data is send from the PLC to a peripheral device, any user data is 
handed to the SFC 217 (SER_SND) and is transferred with added Start- 
and End-ID to the communication partner. 
Message structure: 
 

STX2 Z1 Z2 Zn ETX1 ETX2

ZVZ

STX1

 
 
You may define up to 2 Start- and End-IDs.  
You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start- 
res. End-ID all Hex values from 01h to 1Fh are permissible. Characters 
above 1Fh are ignored. In the user data, characters below 20h are not 
allowed and may cause errors. The number of Start- and End-IDs may be 
different (1 Start, 2 End res. 2 Start, 1 End or other combinations). If no 
End-ID is defined, all read characters are transferred to the PLC after a 
parameterizable character delay time (Timeout). 

Overview 

ASCII 

STX/ETX 
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The 3964R procedure controls the data transfer of a point-to-point link 
between the CPU and a communication partner. The procedure adds 
control characters to the message data during data transfer. These control 
characters may be used by the communication partner to verify the 
complete and error free receipt. 
The procedure employs the following control characters: 
 
• STX Start of Text 
• DLE  Data Link Escape 
• ETX End of Text 
• BCC  Block Check Character  
• NAK  Negative Acknowledge  
 
 

STX

DLE
Message-data

DLE

ETX

BCC

Monitor delayed acknowledgment
DLE

 Monitor delayed acknowledgment

Active partner Passive partner

 
 
You may transfer a maximum of 255Byte per message. 
 

Note! 
When a DLE is transferred as part of the information it is repeated to 
distinguish between data characters and DLE control characters that are 
used to establish and to terminate the connection (DLE duplication). The 
DLE duplication is reversed in the receiving station. 
The 3964R procedure requires that a lower priority is assigned to the 
communication partner. When communication partners issue simultaneous 
send commands, the station with the lower priority will delay its send 
command. 

3964R 

Procedure 
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The USS protocol (Universelle serielle Schnittstelle = universal serial 
interface) is a serial transfer protocol defined by Siemens for the drive and 
system components. This allows to build-up a serial bus connection 
between a superordinated master and several slave systems. 
The USS protocol enables a time cyclic telegram traffic by presetting a fix 
telegram length. 
 
The following features characterize the USS protocol: 

• Multi point connection 
• Master-Slave access procedure 
• Single-Master-System 
• Max. 32 participants 
• Simple and secure telegram frame 

 
You may connect 1 master and max. 31 slaves at the bus where the single 
slaves are addressed by the master via an address sign in the telegram. 
The communication happens exclusively in half-duplex operation. 
After a send command, the acknowledgement telegram must be read by a 
call of the SFC 218 SER_RCV. 
 
The telegrams for send and receive have the following structure: 
 
Master-Slave telegram 
STX LGE ADR PKE IND PWE STW HSW BCC
02h   H L H L H L H L H L  
  
Slave-Master telegram 
STX LGE ADR PKE IND PWE ZSW HIW BCC
02h   H L H L H L H L H L  
  
where STX:  Start sign   STW: Control word 
 LGE: Telegram length  ZSW: State word 
 ADR: Address   HSW: Main set value 
 PKE: Parameter ID   HIW: Main effective value 
 IND: Index    BCC: Block Check Character 
 PWE: Parameter value 
 

Broadcast with set  
bit 5 in ADR-Byte 

01234567

Broadcast

1

 
 

A request can be directed to a certain slave ore be send to all slaves as 
broadcast message. For the identification of a broadcast message you 
have to set bit 5 to 1 in the ADR-Byte. Here the slave addr. (bit 0 ... 4) is 
ignored. In opposite to a "normal" send command, the broadcast does not 
require a telegram evaluation via SFC 218 SER_RCV. Only write 
commands may be sent as broadcast. 
 
 
 

USS 
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The Modbus protocol is a communication protocol that fixes a hierarchic 
structure with one master and several slaves. 
Physically, Modbus works with a serial half-duplex connection. 
There are no bus conflicts occurring, because the master can only 
communicate with one slave at a time. After a request from the master, this 
waits for a preset delay time for an answer of the slave. During the delay 
time, communication with other slaves is not possible. 
After a send command, the acknowledgement telegram must be read by a 
call of the SFC 218 SER_RCV. 
 
The request telegrams send by the master and the respond telegrams of a 
slave have the following structure: 
 
Start 
sign 

Slave 
address 

Function 
Code 

Data Flow 
control 

End 
sign 

 

A request can be directed to a special slave or at all slaves as broadcast 
message. To mark a broadcast message, the slave address 0 is used. 
In opposite to a "normal" send command, the broadcast does not require a 
telegram evaluation via SFC 218 SER_RCV. 
Only write commands may be sent as broadcast. 
 
Modbus offers 2 different transfer modes: 
• ASCII mode: Every Byte is transferred in the 2 sign ASCII code. The 

data are marked with a start and an end sign. This causes a transparent 
but slow transfer. 

• RTU mode: Every Byte is transferred as one character. This enables a 
higher data pass through as the ASCII mode. Instead of start and end 
sign, a time control is used. 

 
The mode selection happens during runtime by using the SFC 216 SER_CFG. 
 
The following Modbus Protocols are supported by the RS485 interface: 
• Modbus RTU Master 
• Modbus ASCII Master 
 
 
 

Modbus 

Broadcast with 
slave address = 0 

ASCII, RTU mode 

Supported Modbus 
protocols  
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Modbus - Function codes 
 

Modbus has some naming conventions:  
 

Word =
Register

IN: "Input Register"
OUT: "Holding Register"

Bit =
Coil

IN: "Input Status"
OUT: "Coil Status"

 
 
• Modbus differentiates between bit and word access;  

Bits = "Coils" and Words = "Register". 
• Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-

Status". 
• Word inputs are referred to as "Input-Register" and Word outputs as 

"Holding-Register".  
 

Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x 
and 4x.  
0x and 1x gives you access to digital Bit areas and 3x and 4x to analog 
word areas.  
For the CPs from VIPA is not differentiating digital and analog data, the 
following assignment is valid: 
 
0x: Bit area for master output data  
  Access via function code 01h, 05h, 0Fh 
1x: Bit area for master input data 
  Access via function code 02h 
3x: Word area for master input data 
  Access via function code 04h 
4x: Word area for master output data 
  Access via function code 03h, 06h, 10h 
 

3x0001 3x0002 3x0003

1x0001
1x0002
1x0003

IN

1x0022

4x0001 4x0002 4x0003

0x0001
0x0002
0x0003

OUT

0x0022

 
 
A description of the function codes follows below.  

Naming 
convention 

Range definitions 
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With the following Modbus function codes a Modbus master can access a 
Modbus slave. The description always takes place from the point of view of 
the master: 
 

Code Command Description 
01h Read n Bits  Read n Bits of master output area 0x 
02h Read n Bits  Read n Bits of master input area 1x 
03h Read n Words Read n Words of master output area 4x 
04h Read n Words Read n Words master input area 3x 
05h Write 1 Bit Write 1 Bit to master output area 0x 
06h Write 1 Word Write 1 Word to master output area 4x 
0Fh Write n Bits Write n Bits to master output area 0x 
10h Write n Words Write n Words to master output area 4x 

 

The description always takes place from the point of view of the master. 
Here data, which were sent from master to slave, up to their target are 
designated as "output" data (OUT) and contrary slave data received by the 
master were designated as "input" data (IN). 
 

System 500S - Master
CPU PtP

System 200V - Slave
PtP

read (01h:bit, 03h:word)

CPU

SEND FC0

RECEIVE FC1

OUT

read (02h:bit, 04h:word)

write (05h,0F:bit, 06h10h:word) OUT OUT

Periphery

ININ

OUT

IN

IN

0x(bit)
4x(word)

1x(bit)
3x(wort)

 
 

If the slave announces an error, the function code is send back with an 
"ORed" 80h. Without an error, the function code is sent back.  
 

Slave answer:    Function code OR 80h  → Error 
      Function code  → OK 
 

For the Byte sequence in a Word is always valid:      1 Word 
      High   Low 
      Byte   Byte 
   

The shown check sums CRC at RTU and LRC at ASCII mode are 
automatically added to every telegram. They are not shown in the data 
block. 

Overview 

Point of View of 
"Input" and  
"Output" data 

Respond of the 
slave 

Byte sequence  
in a Word 

Check sum CRC, 
RTU, LRC 
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Code 01h: Read n Bits of master output area 0x 
Code 02h: Read n Bits of master input area 1x 
 

Command telegram 
Slave address Function code Address 

1. Bit 
Number of 
Bits 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 
Slave address Function code Number of 

read Bytes 
Data  
1. Byte 

Data 
2. Byte 

 
... 

Check sum
CRC/LRC 

1Byte 1Byte 1Byte 1Byte 1Byte  1Word 
   max. 250Byte  

 

03h: Read n Words of master output area 4x  
04h: Read n Words master input area 3x 
 

Command telegram 
Slave address Function code Address  

1. Bit 
Number of 
Words 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 
Slave address Function code Number of 

read Bytes 
Data 
1. Word 

Data 
2. Word 

 
... 

Check sum
CRC/LRC 

1Byte 1Byte 1Byte 1Word 1Word  1Word 
   max. 125Words  

 

Code 05h: Write 1 Bit to master output area 0x 
A status change is via "Status Bit" with following values: 
 

"Status Bit" = 0000h → Bit = 0 
"Status Bit" = FF00h → Bit = 1 

 
Command telegram 
Slave address Function code Address  

Bit 
Status 
Bit 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 
Slave address Function code Address 

Bit 
Status 
Bit 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 

Read n Bits 
01h, 02h 

Read n Words 
03h, 04h 

Write 1 Bit  
05h 
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Code 06h: Write 1 Word to master output area 4x 
  
Command telegram 
Slave address Function code Address  

word 
Value 
word 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
Respond telegram 
Slave address Function code Address 

word 
Value 
word 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 

Code 0Fh: Write n Bits to master output area 0x  
Please regard that the number of Bits has additionally to be set in Byte.  
 

Command telegram 
Slave address Function 

code 
Address  
1. Bit 

Number of 
Bits 

Number of 
Bytes 

Data 
1. Byte 

Data 
2. Byte 

 
... 

Check sum
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Byte 1Byte 1Byte 1Byte 1Word 
     max. 250Byte  

 
Respond telegram 
Slave address Function code Address 

1. Bit 
Number of 
Bits 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 

Code 10h: Write n Words to master output area 4x 
 

Command telegram 
Slave address Function 

code 
Address  
1. Word 

Number of 
words 

Number of 
Bytes 

Data 
1. Word 

Data 
2. Word 

 
... 

Check sum
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Byte 1Word 1Word 1Word 1Word 
     max. 125 Words  

 
Respond telegram 
Slave address Function code Address 

1. Word 
Number of 
Words 

Check sum 
CRC/LRC 

1Byte 1Byte 1Word 1Word 1Word 

 
 

Write 1 Word  
06h 

Write n Bits 0Fh 

Write n Words 10h 
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Modbus - Example communication 
 

The example establishes a communication between a master and a slave 
via Modbus. The following combination options are shown: 
 
Modbus master (M) Modbus slave (S) 
CPU 51xS CPU 21xSER-1 
 

The following components are required for this example: 
• CPU 51xS as Modbus RTU master 
• CPU 21xSER-1 as Modbus RTU slave 
• Siemens SIMATIC Manager and possibilities for the project transfer 
• Modbus cable connection 
 

• Assemble a Modbus system consisting of a CPU 51xS as Modbus 
master and a CPU 21xSER-1 as Modbus slave and Modbus cable. 

• Execute the project engineering of the master!  
For this you create a PLC user application with the following structure: 
OB 100: Call SFC 216 (configuration as Modbus RTU master) with 

timeout setting and error evaluation. 
OB 1: Call SFC 217 (SER_SND) where the data is send with error 

evaluation. Here you have to build up the telegram according 
to the Modbus rules. 
Call SFC 218 (SER_RECV) where the data is received with 
error evaluation. 

• Execute the project engineering of the slave!  
The PLC user application at the slave has the following structure: 
OB 100: Call SFC 216 (configuration as Modbus RTU slave) with 

timeout setting and Modbus address in the DB and error 
evaluation. 

OB 1: Call SFC 217 (SER_SND) for data transport from the slave 
CPU to the output buffer. 
Call SFC 218 (SER_RECV) for the data transport from the 
input buffer to the CPU. Allow an according error evaluation 
for both directions.  

 
The following page shows the structure for the according PLC programs for 
master and slave. 

Outline 

Components 

Approach 
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      Master              Slave 
 

      

CPU 51xS
CPU Master

CPU 21xSER-1
Slave CPU

SER_SND

SER_RCV

SER_RCV

RetVal

SER_RCV

SER_SND

code/data

RetVal

SER_SND code

data

RetVal

 
 

SFC 217
SER_SND

(mit Slave-Nr., Code, 
Bereich)

RetVal 8xxxh / 
90xxh ?

RetVal 2001h ?

RetVal 2000h ?

N

N

Error evaluationJ

J

SFC 218 
SER_RCV

N

J

RetVal 0000h ?

RetVal 8xxxh ?

N

Data evaluation

J

Error evaluation

N

J

Start

SER_SND
RetVal 2001h ?

J

N

Error evaluationJ

SFC 216
SER_CFG

(DB: Timeout)

RetVal 8xxxh ?

OB100:

OB1:
N

SFC 217
SER_SND

RetVal  9001h ? Error evaluationJ

SFC 218 
SER_RCV

N

RetVal 0000h ?

RetVal 8xxxh ?

N

Data evaluation

Error evaluation

N

J

Start

Error evaluationJ

SFC 216
SER_CFG

(DB: Timeout, slave address)

RetVal 8xxxh ?

N

RetVal 0000h ?

N

J

J

N

RetVal 700xh? J
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Chapter 6  Deployment Ethernet communication 
 

In this chapter the communication via Ethernet is described. Please regard 
the chapter "Fast introduction" where you will find every information 
compressed required for the project engineering of the CPU 517S/NET with 
CP 543. After the fast introduction, the mentioned steps are described in 
detail. 
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Basics - Industrial Ethernet in automation 
 

The flow of information in a company presents a vast spectrum of 
requirements that must be met by the communication systems. Depending 
on the area of business the bus system or LAN must support a different 
number of users, different volumes of data must be transferred and the 
intervals between transfers may vary, etc. 
It is for this reason that different bus systems are employed depending on 
the respective task. These may be subdivided into different classes. The 
following model depicts the relationship between the different bus systems 
and the hierarchical structures of a company: 
 

Operational layer

Management layer

System layer

Prozess layer

Sensor / actuator
layer

Field bus

Sensor / actuator
Bus

H1

Industrial
EthernetPlant

computer
PPS CAD

Plant-oriented
control computer

manufacturing, stock,
production data

PPS CAD

Machine and control
computer

Peripheral systems. machines, CNC, NC,
controllers (PLC), measuring systems

Peripheral components
sensor, actuator, regulator, multiplexer, operating consoles

 
 

Industrial Ethernet is an electrical net based on shielded twisted pair 
cabling or optical net based on optical fiber. 
Industrial Ethernet is defined by the international standard IEEE 802.3. The 
net access of Industrial Ethernet corresponds to IEEE 802.3 -  CSMA/CD 
(Carrier Sense Multiple Access/Collision Detection) scheme: every station 
"listens” on the bus cable and receives communication messages that are 
addressed to it.  
Stations will only initiate a transmission when the line is unoccupied. In the 
event that two participants should start transmitting simultaneously, they 
will detect this and stop transmitting to restart after a random delay time 
has expired. 
Using switches there is the possibility for communication without collisions.  

Overview 

Industrial Ethernet 



Manual VIPA System 500S SPEED7 Chapter 6   Deployment Ethernet communication 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  6-3 

Basics - ISO/OSI reference model 
 

The ISO/OSI reference model is based on a proposal that was developed 
by the International Standards Organization (ISO). This represents the first 
step towards an international standard for the different protocols. It is 
referred to as the ISO-OSI layer model. OSI is the abbreviation for Open 
System Interconnection, the communication between open systems. The 
ISO/OSI reference model does not represent a network architecture as it 
does not define the services and protocols used by the different layers. The 
model simply specifies the tasks that the different layers must perform. 
All current communication systems are based on the ISO/OSI reference 
model, which is defined by the ISO 7498 standard. The reference model 
structures communication systems into 7 layers that cover different 
communication tasks. In this manner the complexity of the communication 
between different systems is divided amongst different layers to simplify the 
task. 
The following layers have been defined: 
 

Layer Function 
Layer 7 Application Layer 
Layer 6 Presentation Layer 
Layer 5 Session Layer 
Layer 4 Transport Layer 
Layer 3 Network Layer 
Layer 2 Data Link Layer 
Layer 1 Physical Layer 

 

Depending on the complexity and the requirements of the communication 
mechanisms a communication system may use a subset of these layers.  

Overview 
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Layer 1 Bit communication layer (physical layer) 
The bit communication layer (physical layer) is concerned with the transfer 
of data bits via the communication channel. This layer is therefore 
responsible for the mechanical, electrical and the procedural interfaces and 
the physical communication medium located below the bit communication 
layer: 
• Which voltage represents a logical 0 or a 1? 
• The minimum time the voltage is present to be recognized as a bit. 
• The pin assignment of the respective interface. 
 

Layer 2  Security layer (data link layer) 
This layer performs error-checking functions for bit strings transferred 
between two communicating partners. This includes the recognition and 
correction or flagging of communication errors and flow control functions.  
The security layer (data link layer) converts raw communication data into a 
sequence of frames. This is where frame limits are inserted on the 
transmitting side and where the receiving side detects them. These limits 
consist of special bit patterns that are inserted at the beginning and at the 
end of every frame. The security layer often also incorporates flow control 
and error detection functions.  
The data security layer is divided into two sub-levels, the LLC and the MAC 
level. 
The MAC (Media Access Control) is the lower level and controls how 
senders are sharing a single transmit channel. 
The LLC (Logical Link Control) is the upper level that establishes the 
connection for transferring the data frames from one device into the other. 
 
Layer 3 Network layer 
The network layer is an agency layer. 
Business of this layer is to control the exchange of binary data between 
stations that are not directly connected. It is responsible for the logical 
connections of layer 2 communications. Layer 3 supports the identification 
of the single network addresses and the establishing and disconnecting of 
logical communication channels.  
Additionally, layer 3 manages the prior transfer of data and the error 
processing of data packets. IP (Internet Protocol) is based on Layer 3. 
 
Layer 4 Transport layer 
Layer 4 connects the network structures with the structures of the higher 
levels by dividing the messages of higher layers into segments and passes 
them on to the network layer. Hereby, the transport layer converts the 
transport addresses into network addresses. 
Common transport protocols are: TCP, SPX, NWLink and NetBEUI. 
 

Layers 
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Layer 5 Session layer  
The session layer is also called the communication control layer. It relieves 
the communication between service deliverer and the requestor by 
establishing and holding the connection if the transport system has a short 
time fail out. 
At this layer, logical users may communicate via several connections at the 
same time. If the transport system fails, a new connection is established if 
needed.  
Additionally this layer provides methods for control and synchronization 
tasks.  
 
Layer 6 Presentation layer  
This layer manages the presentation of the messages, when different 
network systems are using different representations of data.  
Layer 6 converts the data into a format that is acceptable for both 
communication partners. 
Here compression/decompression and encrypting/decrypting tasks are 
processed. 
This layer is also called interpreter. A typical use of this layer is the terminal 
emulation.  
 
Layer 7 Application layer  
The application layer is the link between the user application and the 
network. The tasks of the application layer include the network services like 
file, print, message, data base and application services as well as the 
according rules.  
This layer is composed from a series of protocols that are permanently 
expanded following the increasing needs of the user. 
 

Layers 
continued... 



Chapter 6   Deployment Ethernet communication Manual VIPA System 500S SPEED7 

6-6  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

Basics - Terms 
 

A network res. LAN (Local Area Network) provides a link between different 
stations that enables them to communicate with each other. 
Network stations consist of PCs, IPCs, TCP/IP adapters, etc. 
Network stations are separated by a minimum distance and connected by 
means of a network cable. The combination of network stations and the 
network cable represent a complete segment. 
All the segments of a network form the Ethernet (physics of a network). 
 

In the early days of networking the Triaxial- (yellow cable) or thin Ethernet 
cable (Cheapernet) was used as communication medium. This has been 
superseded by the twisted-pair network cable due to its immunity to 
interference. The CPU has a twisted-pair connector. 
The twisted-pair cable consists of 8 cores that are twisted together in pairs. 
Due to these twists this system is provides an increased level of immunity 
to electrical interference. For linking please use twisted pair cable which at 
least corresponds to the category 5. 
Where the coaxial Ethernet networks are based on a bus topology the 
twisted-pair network is based on a point-to-point scheme. 
The network that may be established by means of this cable has a star 
topology. Every station is connected to the star coupler (hub/switch) by 
means of a separate cable. The hub/switch provides the interface to the 
Ethernet. 
 

The hub is the central element that is required to implement a twisted-pair 
Ethernet network.   
It is the job of the hub to regenerate and to amplify the signals in both 
directions. At the same time it must have the facility to detect and process 
segment wide collisions and to relay this information. The hub is not 
accessible by means of a separate network address since it is not visible to 
the stations on the network. 
A hub has provisions to interface to Ethernet or to another hub res. switch. 
 

A switch also is a central element for realizing Ethernet on Twisted Pair. 
Several stations res. hubs are connected via a switch. Afterwards they are 
able to communicate with each other via the switch without interfering the 
network. An intelligent hardware analyzes the incoming telegrams of every 
port of the switch and passes them collision free on to the destination 
stations of the switch. A switch optimizes the bandwidth in every connected 
segment of a network. Switches enable exclusive connections between the 
segments of a network changing at request. 
 

Network (LAN) 

Twisted Pair 

Hub (repeater) 

Switch 
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Basics - Protocols 
 

Protocols define a set of instructions or standards that enable computer to 
establish communication connections and exchange information as error 
free as possible. A commonly established protocol for the standardization 
of the complete computer communication is the so called ISO/OSI layer 
model, a model based upon seven layers with rules for the usage of 
hardware and software (see ISO/OSI reference model above). 
 
The CPU from VIPA uses the following protocols:  
• Siemens S7 connections 
• TCP/IP 
• UDP 
• RFC1006 (ISO on TCP) 
• ISO transport (once H1) 
The protocols are described in the following: 
 

With the Siemens S7 connection large data sets may be transferred 
between PLC systems based on Siemens STEP®7. Here the stations are 
connected via Ethernet. 
Besides the communication connection a CPU may be controlled by an 
other CPU by means of the remote functions with the appropriate function 
block to set these e.g. to STOP. 
Precondition for the Siemens S7 communication is a configured connection 
table, which contains the defined connections for communication. 
Here WinPLC7 from VIPA or NetPro from Siemens may be used. 
 

• A communication connection is specified by a connection ID for each 
connection partner. 

• The acknowledgement of the data transfer is established from the 
partner station at level 7 of the ISO/OSI reference model. 

• At the PLC side FB/SFB VIPA handling blocks are necessary for data 
transfer for the Siemens S7 connections.  

 

Note! 
More about the usage of the FB/SFB VIPA handling blocks concerning the 
S7 connections may be found in the manual "Operation list" of the CPU. 
 
 
 

Overview 

Siemens S7 
connections 

Properties 
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TCP/IP protocols are available on all major systems. At the bottom end this 
applies to simple PCs, through to the typical mini-computer up to 
mainframes.  
For the wide spread of Internet accesses and connections, TCP/IP is often 
used to assemble heterogeneous system pools. 
TCP/IP, standing for Transmission Control Protocol and Internet Protocol, 
collects a various range of protocols and functions. 
TCP and IP are only two of the protocols required for the assembly of a 
complete architecture. The application layer provides programs like "FTP" 
and "Telnet" for the PC.  
The application layer of the Ethernet CP is defined with the user application 
using the standard handling blocks.  
These user applications use the transport layer with the protocols TCP and 
UDP for the data transfer which themselves communicate via the IP 
protocol with the Internet layer.  
 
The Internet protocol covers the network layer (Layer 3) of the ISO/OSI 
layer model.  
The purpose of IP is to send data packages from on PC to another passing 
several other PCs. These data packages are referred to as datagrams. The 
IP doesn't neither guarantee the correct sequence of the datagrams nor the 
delivery at the receiver.  
For the unambiguous identification between sender and receiver 32Bit 
addresses (IP addresses) are used that are normally written as four octets 
(exactly 8bit), e.g. 172.16.192.11. 
These Internet addresses are defined and assigned worldwide from the 
DDN network (Defense Department Network), thus every user may 
communicate with all other TCP/IP users.  
One part of the address specifies the network; the rest serves the 
identification of the participants inside the network. The boarder between 
the network and the host part is variable and depends on the size of the 
network.  
To save IP addresses, so called NAT router are used that have one official 
IP address and cover the network. Then the network can use any IP 
address.  
 
The TCP (Transmission Control Protocol) bases directly on the IP and thus 
covers the transport layer (layer 4) of the ISO/OSI layer model. TCP is a 
connection orientated end-to-end protocol and serves the logic connection 
between two partners. 
TCP guarantees the correct sequence and reliability of the data transfer. 
Therefore you need a relatively large protocol overhead that slows down 
the transfer speed.  
Every datagram gets a header of at least 20Byte. This header also contains 
a sequence number identifying the series. This has the consequence that 
the single datagrams may reach the destination on different ways through 
the network. 
Using TCP connections, the telegram length is not transmitted. This means 
that the recipient has to know how many bytes belong to a message. To 
transfer data with variable length you may begin the user data with the 
length information and evaluate this at the counter station.  
 

TCP/IP 

IP 

TCP 
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• Besides of the IP address ports are used for the addressing. A port 
address should be within the range of 2000...65535. Partner and local 
ports may only be identical at one connection.   

• Not depending on the used protocol, the PLC needs the VIPA handling 
blocks AG_SEND (FC 5) and AG_RECV (FC 6) for data transfer. 

 

The UDP (User Datagram Protocol) is a connection free transport protocol. 
It has been defined in the RFC768 (Request for Comment). Compared to 
TCP, it has much fewer characteristics. 
The addressing happens via port numbers.  
UDP is a fast unsafe protocol for it doesn't neither care about missing data 
packages nor about their sequence.  
 

The TCP transport service works stream orientated. This means that data 
packages assembled by the user not necessarily have to receive the 
partner in the same packaging. Depending on the data amount, packages 
may though come in the correct sequence but differently packed. This 
causes that the recipient may not recognize the package borders anymore. 
For example you may send 2x 10Byte packages but the counter station 
receives them as 20Byte package. But for most of the applications the 
correct packaging is important.  
Due to this you need another protocol above TCP. This purpose is defined 
in the protocol RFC1006. The protocol definition describes the function of 
an ISO transport interface (ISO 8072) basing upon the transport interface 
TCP (RFC793).  
The basic protocol of RFC1006 is nearly identical to TP0 (Transport 
Protocol, Class 0) in ISO 8073.  
For RFC1006 is run as protocol for TCP, the decoding takes place in the 
data section of the TCP package. 
 

• The receipt of data is confirmed by a TCP layer. 
• Instead of ports TSAPs are used for the addressing besides of the IP 

address. The TSAP length may be 1 ... 16 characters. The entry may 
happen in ASCII or Hex format. Remote and local TSAPs may only be 
identical at 1 connection.   

• Not depending on the used protocol, the PLC needs the VIPA handling 
blocks AG_SEND (FC 5) and AG_RECV (FC 6) for data transfer. 

• Contrary to TCP different telegram lengths can be received using 
RFC1006. 

 
 

Properties 
TCP/IP 

UDP 

ISO-on-TCP 
RFC1006 

Properties 
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The ISO transport service (ISO 8073 class 4) corresponds to the transport 
layer (Layer 4) of the ISO/OSI reference model. With ISO transport 
connections there is the possibility for program and event controlled 
communication via Industrial Ethernet. Here data blocks may be exchanged 
bi-directional.  
The ISO transport connection offers services for a safety transfer of data by 
means of configured connections. Large data blocks may be transferred by 
means of blocking. 
The transmission reliability is very high by the automatic repetition, by 
additional block test mechanisms and by the receipt acknowledgement at 
the receiver side. ISO transport connections are exclusively transferred via 
Industrial Ethernet and they are optimized for the deployment in a closed 
manufacturing area. 
 

• ISO transport connections are only suited for Industrial Ethernet 
• The receipt of data is acknowledged by the partner station. Here 

different telegram lengths may be processed. 
• The addressing happens by MAC address (Ethernet address) and 

TSAPs (Transport Service Access Point). 
• The data transfer is made by the services SEND/RECEIVE and 

FETCH/WRITE. 
• Independent on the used protocol, the PLC needs the VIPA handling 

blocks AG_SEND (FC 5) and AG_RECV (FC 6) for data transfer. 
 
 
 
 

ISO transport 
(once H1) 

Properties 
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Basics - IP address and subnet 
 

Industrial Ethernet exclusively supports IPv4. At IPv4 the IP address is a 
32Bit address that must be unique within the network and consists of 4 
numbers that are separated by a dot.  
Every IP address is a combination of a Net-ID and a Host-ID and its 
structure is as follows:  xxx.xxx.xxx.xxx 
Range: 000.000.000.000 to 255.255.255.255  
The network administrator also defines IP addresses.  
 

The Network-ID identifies a network res. a network controller that 
administrates the network. 
The Host-ID marks the network connections of a participant (host) to this 
network.  
 

The Host-ID can be further divided into a Subnet-ID and a new Host-ID by 
using a bit for bit AND assignment with the Subnet mask.  
The area of the original Host-ID that is overwritten by 1 of the Subnet mask 
becomes the Subnet-ID, the rest is the new Host-ID. 

 
Subnet mask binary all "1" binary all "0" 
IPv4 address Net-ID  Host-ID 
Subnet mask and  IPv4 address Net-ID Subnet-ID new Host-ID 

 
A TCP-based communication via point-to-point, hub or switch connection is 
only possible between stations with identical Network-ID and Subnet-ID! 
Different area must be connected with a router. 
The subnet mask allows you to sort the resources following your needs. 
This means e.g. that every department gets an own subnet and thus does 
not interfere another department. 
 

At the first start-up of the CPU, the Ethernet PG/OP channel and the CP 
343 part of the CPU do not have an IP address. The assignment takes 
place using the following possibilities: 
• Using Siemens SIMATIC manager switch PG/PC interface to "TCP/IP... 

RFC1006". Via "Assign Ethernet address" search the appropriate CP 
and assign IP parameters. After that the CP is directly assigned to the 
new IP parameters without any restart of the CPU.  

• You may assign an IP address and a subnet mask to your CP with the 
help of a "minimum project" and transfer this via MMC or MPI into the 
CPU. After a reboot of the CPU and after switching the PG/PC interface 
to "TCP/IP... RFC1006" you may now configure your CPU online via the 
favored CP. 

 

IP address 
structure 

Net-ID 
Host-ID 

Subnet mask 

Subnet 

Address at first 
start-up  
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For IPv4 addresses there are five address formats (class A to class E) that 
are all of a length of 4byte = 32bit.  
 
Class A 0 Network-ID 

(1+7bit) 
Host-ID (24bit) 

Class B 10 Network-ID (2+14bit) Host-ID (16bit) 
Class C 110 Network-ID (3+21bit) Host-ID (8bit) 
Class D 1110 Multicast group 
Class E 11110 Reserved 

 
The classes A, B and C are used for individual addresses, class D for 
multicast addresses and class E is reserved for special purposes. 
The address formats of the 3 classes A, B, C are only differing in the length 
of Network-ID and Host-ID. 
 
To build up private IP-Networks within the Internet, RFC1597/1918 
reserves the following address areas: 

 
Network 
class 

Start IP End IP Standard subnet mask 

A 10.0.0.0 10.255.255.255 255.0.0.0 
B 172.16.0.0 172.31.255.255 255.255.0.0 
C 192.168.0.0 192.168.255.255 255.255.255.0 
(The Host-ID is underlined.) 

 
These addresses can be used as net-ID by several organizations without 
causing conflicts, for these IP addresses are neither assigned in the 
Internet nor are routed in the Internet. 
 

Some Host-IDs are reserved for special purposes. 
 
Host-ID = "0"  Identifier of this network, reserved! 
Host-ID = maximum (binary complete "1") Broadcast address of this network 
 

Note! 
Never choose an IP address with Host-ID=0 or Host-ID=maximum! 
(e.g. for class B with subnet mask = 255.255.0.0, the "172.16.0.0" is 
reserved and the "172.16.255.255" is occupied as local broadcast address 
for this network.) 
 
 

Address classes 

Private IP networks 

Reserved 
Host-Ids 
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Basics - MAC address and TSAP 
 

There is a unique MAC address (Media Access Control) necessary for 
each CP. Usually a module is labeled with its MAC address by the 
manufacturer. This address should be used for project engineering of the 
CP. The MAC address has a length of 6bytes. 
On delivery the first three bytes specify the manufacturer. These bytes are 
assigned by the IEEE committee. The last three bytes may be assigned by 
the manufacturer. 
In a network several stations with the same MAC address may not exist. 
The MAC address may be changed at any time. You will get a valid MAC 
address from your network administrator. 
 

The MAC address, with which all bits are set to 1, is: 
FF-FF-FF-FF-FF-FF  
This address is used as Broadcast address and addresses all participants 
in the net.  
 
At the first-start-up the CP 343 of the CPU has an unique MAC address. 
This may be found on a label beneath the front flap. 
 

Note! 
Please regard for the configuration of the network in the Siemens SIMATIC 
manager that it is necessary to activate the ISO protocol and to preset a 
valid MAC address within the properties dialog of the Ethernet interface of 
the CP! 
 

TSAP means Transport Service Access Point. ISO transport connections 
support TSAP length of 1...16byte. TSAPs may be entered in ASCII format 
or hexadecimal. 
 

An ISO transport connection is specified by a local and a remote 
connection endpoint. 

Station A    Station B 
remote TSAP → ISO transport- → local TSAP 
local TSAP ← connection ← remote TSAP 

MAC address A    MAC address B 
 
The TSAPs of an ISO transport connection must match as follows: 
Remote TSAP (in CP) = local TSAP (in destination station) 
Local TSAP (in CP) = remote TSAP (in destination station) 

MAC address 

Broadcast address 

Address at first 
start-up  

     

TSAP 

Address 
parameters 
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Fast introduction 
 

At the first start-up respectively at an over all reset the Ethernet PG/OP 
channel and CP 543 of the CPU do not have any IP address. The CPs may 
only be contacted by its MAC addresses. IP address parameters may be 
assigned to the CPs by means of the MAC addresses, which may be found 
on labels beneath the front flap with the sequence 1. address PG/OP 
channel and beneath address of the CP 543. The assignment takes place 
directly via the hardware configuration of the Siemens SIMATIC manager. 
For the project engineering of the CPU 517S/NET with CP 543 please 
follow this approach: 
• Assembly and commissioning 
• Hardware configuration (Inclusion of CP in CPU) 
• CP project engineering via NetPro (connection to Ethernet) 
• PLC programming via user application (connection to PLC) 
• Transfer of the complete project to CPU 
 
 

To be compatible to the Siemens SIMATIC Manager, the CPU 517S/NET from VIPA is to 
be configured as  

CPU 318-2 (6ES7 318-2AJ00-0AB0)! 

 
The Ethernet PG/OP channel of the CPU 517S/NET is always to be configured as 
CP343-1 (343-1EX11) from Siemens. The CP 543 of the CPU is always to be configured 
below the before configured PG/OP channel also as CP343-1 (343-1EX11). 
 

 

• Install your CPU 517S/NET at a free PCI slot. 
• Attach external voltage supply and note that your PC is connected with 

the network.  
• Switch on the voltage supply.  

→ After a short boot time, the CP is in idle mode. At the first 
commissioning res. after an overall reset of the CPU, the CP does not 
have an IP address. For control purposes you may now reach the CP via 
the MAC address. The MAC address is to be found at a small label on 
the board. 

 
 

Overview 

Note 

Assembly and 
commissioning 
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You get valid IP address parameters from your system administrator. For 
the assignment of the IP address parameters such as IP address, Subnet 
mask etc. you have the following possibilities: 
• Online using Siemens SIMATIC manager via "Assign Ethernet Address". 
• With a project with IP address and IP parameters transferred via MMC 

or MPI to the CPU. After a reboot of the CPU and after switching the 
PG/PC interface to "TCP/IP... RFC1006" you may now configure your 
CPU online via the CP. 

 
In the following the proceeding with the Siemens SIMATIC manager 
starting with version V 5.3 & SP3 is described: 
• Start the Siemens SIMATIC manager. 
• Switch to "TCP/IP... RFC1006" using Options > Set PG/PC interface. 
• The dialog for initialization of a station opens by PLC > Edit Ethernet 

Node. 
• To get the stations and their MAC address, use the [Browse] button or 

type in the MAC Address. The Mac address can be found at a label 
beneath the front flap of the CP. 

• Choose if necessary the known MAC address of the list of found 
stations. 

• Either type in the IP configuration like IP address, subnet mask and 
gateway. Or your station is automatically provided with IP parameters by 
means of a DHCP server. Depending of the chosen option the DHCP 
server is to be supplied with MAC address, equipment name or client ID. 
The client ID is a numerical order of max. 63 characters. The following 
characters are allowed: "hyphen", 0-9, a-z, A-Z 

• Confirm with [Assign ...]. 
Directly after the assignment the CP is online reachable using the set IP 
parameters. 

Assign IP Address 
parameters 

Address assign-
ment with "Assign 
Ethernet Address" 
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• Start Siemens SIMATIC manager with new project. 
• Place a new System 300 station with Insert > Station > SIMATIC 300 

station  
• Activate the station "SIMATIC 300" and open the hardware configurator 

by clicking on "Hardware". 
• Configure a rack (SIMATIC 300 \ Rack-300 \ Profile rail). 
• Configure in deputy of your CPU 517S/NET the Siemens  

CPU 318-2 with the order no. 6ES7 318-2AJ00-0AB0 V.3.0 which is to 
be found at SIMATIC 300 \ CPU 300 \ CPU 318-2 \ 318-2AJ00-0AB00. If 
needed, parameterize the CPU 318-2. 

• Configure the internal PG/OP channel directly under the really plugged 
modules as virtual CP 343-1 (343-1EX11) from Siemens. 

• Set IP address, subnet mask and gateway at CP properties. 
• Always configure as 2. CP the internal CP 343 as CP 343-1  

(343-1EX11) by setting another IP address, subnet mask and gateway. 
• Save and compile your project.  
 
This is the end of the project. After the project is transferred to CPU, the CP 
may be accessed by means of IP address and subnet mask of the project. 
 

For deployment of the ISO transport connections they must be enabled in 
the Ethernet properties of the CP at the project above. 
Here there is the possibility to assign the CP to a MAC address. With each 
start-up of the CPU the new MAC address is transferred to the CP. 
 

The link-up between the stations happens with the graphical interface 
NetPro. Start NetPro by clicking on a network in your project res. on 
connections in the CPU directory. 
 

Connections

[5]

 
 

Address 
assignment  
with project 

Deployment of  
ISO transport 
connections 

Configure 
connections with 
NetPro 
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For the project engineering of connections, connected stations are 
presumed. To link-up stations, point on the colored net mark of the 
according CP with the mouse and drag it to the network you want to assign. 
The connection is displayed graphically by a line. 
 
For the project engineering of new connections click on the according CPU 
and choose "Insert new connection” from the context menu. 

CPU
318-2

DP MPI CP
343-1

CP
343-1

Station 1

insert new connection

 
 
Via the dialog window you may set the parameters for a connection. The 
parameters ID and LADDR are required for the usage on the blocks 
AG_SEND res. AG_RECV. 
With deployment of Siemens S7 connections the parameter ID is to be 
passed to the respective FB/SFB VIPA handling blocks. 
 
Always use the 2. CP from the route 
Please take care to always choose the 2. CP from the route for 
communication. As 1. CP you will always see the Ethernet PG/OP channel 
that does not support configurable connections.  
 
Save and compile your project and close NetPro.  
To store the CP project engineering data in the system data, you have to 
activate the option "Save configuration data on the CPU" (default setting) 
under object properties area Options in the hardware configuration of the 
CP. 
 

For the execution of connection commands at the PLC, your CPU requires 
an user application. For this, exclusively the VIPA handling blocks are 
used, which you may get from VIPA as a library. 
More information about the deployment of the blocks may be found in the 
manual "Operation list" of your CPU. 
Depending upon the connection type there are function blocks for Siemens 
S7 connections and Send/Receive connections. 
 

Information about transferring a project may be found at chapter 
"Deployment CPU 517S/NET" at "Project transfer". 
 
The following pages provide a more detailed description of the steps of the 
fast introduction.  
 

Link-up stations 

Configure 
connections 

Save and compile 
connections 

PLC user 
application 

Project transfer 



Chapter 6   Deployment Ethernet communication Manual VIPA System 500S SPEED7 

6-18  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

Hardware configuration 
 

For the Hardware configuration the hardware configurator from Siemens is 
used. Here you set amongst others the IP address of the CP and configure 
the hardware components of your PLC. 
Due to the fact that neither the Ethernet-PG/OP channel nor the CP 543 
have an IP address in delivery state you may engineer the CPU exclusively 
via MPI or MMC. 
For the access to the CPU via the Ethernet-PG/OP channel res. the  
CP 543 it is required that the CPU has a hardware project engineering 
where IP address and subnet mask for Ethernet-PG/OP res. CP 543 are 
defined. 
 

For the hardware configuration the following software is required: 
- Siemens SIMATIC Manager V. 5.2 or higher  
-  SIMATIC NET 
 

Note! 
For the project engineering a thorough knowledge of the SIMATIC Manager 
and the hardware configurator from Siemens are required and assumed! 
 

 

To be compatible to the Siemens SIMATIC Manager, the CPU 51xS from VIPA has to 
be configured as 

CPU 318-2DP (6ES7 318-2AJ00-0AB0)! 

 
The internal Ethernet-PG/OP channel is always configured virtually at slot 4 as CP343-1 
(343-1EX11) from Siemens. The CP 543 of a CPU 51xSN/NET has always to be 
configured at slot 5 also as CP343-1 (343-1EX11). 
 

 

Overview 

Requirements 

    

Note! 
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The following text shows the approach of the project engineering in the 
hardware configurator from Siemens in an abstract sample. 
The project engineering is divided into 2 parts: 
• Project engineering of the CPU 
• Project engineering Ethernet-PG/OP channel and CP 543 
 

• Start the hardware configurator from Siemens with a new project and 
insert a profile rail from the hardware catalog. 

• Place the following Siemens CPU at slot 2:  
CPU 318-2DP (6ES7 318-2AJ00-0AB0 V3.0) 

 

For the internal Ethernet-PG/OP channel at slot 4 and the CP 543 at slot 5 
you have to configure each a Siemens CP 343-1 (SIMATIC 300 \ CP 300 \ 
Industrial Ethernet \CP 343-1 \ 6GK7 343-1EX11 0XE0). 
  

Module

CPU 318-2
DP
MPI/DP

343-1EX11
343-1EX11

Standard bus
Slot.

1
2

X2
X1
3
4
5

CPU 517S/NET

Ethernet-PG/OP channel

C
P

 5
43

E
th

er
ne

t P
G

/O
P

CP 543  
 
Open the property window via double-click on the CP 343-1EX11 and enter 
at properties the IP address, subnet mask and gateway for the CPs and 
select the wanted subnet. 
 

 
 
Save and compile your project. 

Steps of the 
project 
engineering 

Project 
engineering  
of the CPU 

Project engineering 
Ethernet-PG/OP 
channel and CP 543 
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Configure connections 
 

The project engineering of connections i.e. the "link-up" between stations 
happens in NetPro from Siemens. NetPro is a graphical user interface for 
the link-up of stations. 
A communication connection enables the program controlled communi-
cation between two participants at the Industrial Ethernet. The communi-
cation partners may here be part of the same project or - at multi projects - 
separated within related part projects. 
Communication connections to partners outside of a project are configured 
via the object "In unknown project" or via deputy objects like "Other 
stations" or Siemens "SIMATIC S5 Station".  
By means of the handling block like FB 55 - IP_CONFIG there is the 
possibility to establish program controlled communication connections. 
More may be found in the manual "Operation list" of the CPU. 
 

The following properties are characterizing a communication connection: 
• One station always executes an active connection establishment. 
• Bi-directional data transfer (Send and receive on one connection) 
• Both participant have equal rights, i.e. every participant may initialize the 

send res. receive process event controlled. 
• Except of the UDP connection, at a communication connection the 

address of the communication partner is set via the project engineering. 
Here the connection is active established by one station. 

 
CP

send

receive

Communication
link

Ethernet partner

receive

send

send

receive

Communication
link

Ethernet partner

receive

send

.

.

.

.

.

.

.

.

.

 
 

• Siemens SIMATIC manager V.5.2 or higher and SIMATIC NET are 
installed. 

• The CP has been engineered at the hardware configuration, entered into 
the hardware configuration and linked-up to the Ethernet subnet. 

• The CP as bus participant has an IP address respectively a MAC 
address for ISO transport connections. 

 

Overview 

Properties 
communication 
connection 

Requirements 
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Note! 
Every station outside of the recent project must be configured as 
replacement objects like e.g. Siemens "SIMATIC S5" or "other station" or 
with the object  "In unknown project". 
When creating a connection you may also choose the partner type 
"unspecified" and set the required remote parameter directly in the 
connection dialog. 
 

For the project engineering of connections, a thorough knowledge with 
NetPro from Siemens is required! The following passage only describes the 
basic usage of NetPro. More detailed information about NetPro is to be 
found in the according online manual res. documentation. 
Start NetPro by clicking on a "net" in the Siemens SIMATIC manager or on 
"connections" within the CPU. 
 
The environment of NetPro has the following structure: 

1 Graphic net view 
All stations and networks are displayed in a graphic view. By clicking 
on the according component you may access and alter the 
concerning properties.  

2 Net objects 
This area displays all available net objects in a directory view. By 
dragging a wanted object to the net view you may include further net 
objects and open them in the hardware configurator. 

3 Connection table 
The connection table lists all connections in a table. This list is only 
shown when you highlighted a connectable module like e.g. a CPU. 
You may insert new connections into this table with the according 
command. 

 

 

Stationes

Subnet

+

+

Profibus-PA

Profibus-DP+

21

MPI

Ethernet

CPU
318-2

DP MPI CP
343-1

Profibus

CP
343-1
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DP MPI CP
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You receive the following graphical display for every PLC station and their 
component. By selecting the single components, the context menu offers 
you several functions: 
 

1 Station 
This includes a PLC station with rack, CPU and communication 
components. Via the context menu you may configure a station 
added from the net objects and its concerning components in 
the hardware configurator. After returning to NetPro, the new 
configured components are shown.  

2 CPU 
A click onto the CPU shows the connection table. The 
connection table shows all connections that are configured for 
the CPU. 

3 Internal communication components 
This displays the communication components that are available 
in your CPU. For the NET-CPU is configured as CPU 318-2 the 
internal components do not show the CP. 
Due to this, the CPs that are included in the NET-CPU must be 
configured as external CPs behind the really plugged modules. 
The CPs are then also shown in NetPro as external CPs (4, 5) 
in the station. 

4 Ethernet PG/OP channel 
The internal Ethernet PG/OP channel must always be 
configured as 1. CP in the hardware configuration. This CP only 
serves the PG/OP communication. You may not configure 
connections. 

CPU
318-2

DP MPI CP
343-1

CP
343-1

Station 1

1

1 2 43 5  

5 CP 343 
The internal CP 343 must always be configured as 2. CP in the 
hardware configuration after the Ethernet PG/OP channel. 

 

 

NetPro offers you the option to link-up the communicating stations. You 
may link-up the stations via the properties in the hardware configuration or 
graphically via NetPro. For this you point the mouse on the colored net 
mark of the according CP and drag and drop it to the net you want to link. 
Now the CP is linked up to the wanted net by means of a line. 

CP
343-1

CPU
318-2

DP MPI CP
343-1

Station 1

Industrial Ethernet

CPU
318-2

DP MPI CP
343-1

Station 1

Industrial Ethernet

CP
343-1

 
 

PLC stations 

Link up stations 
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For the project engineering of connections, open the connection list by 
selecting the according CPU. Choose Insert new connection in the context 
menu: 
 

CPU
318-2

DP MPI CP
343-1

CP
343-1

Station 1

insert new connection

 
 

A dialog window opens where you may choose the connection partner and 
the connection type.  
 
Each station configured in the Siemens SIMATIC manager is listed in the 
table of connection partner. These stations are unique specified by an IP 
address and a subnet mask. 
 
Here the connection partner may exist in the current project or in an 
unknown project. Connection jobs to an unknown project must be defined 
by an unique connection name, which is to be used in the projects of both 
stations. Due to this allocation the connection remains unspecified. 
 
Exclusive at UDP connections you may send to every reachable 
participant. The receipt of user data is not possible. The broadcast 
participants are specified by one port and one broadcast address at sender 
and receiver. 
Per default, broadcasts that are only serving the Ethernet communication, 
like e.g. ARP-Requests (Search MAC <> IP address), are received and 
accordingly processed. For the identification of the broadcast participants 
within the net, you have to define a valid broadcast address as partner IP 
during project engineering of a broadcast connection. Additionally to the 
broadcast address you have to set a common port for sender and receiver. 
 
By selecting All Multicast stations you define that UDP telegrams have to 
be sent res. received by all participants of a multicast group. In opposite to 
broadcast here a reception is possible. For the identification of the multicast 
participants within the net, you have to define one valid multicast group 
address and one port for sender and receiver. 
The maximum number of multicast circles, which are supported by the CP, 
is identical to the maximum number of connections. 
 

Projecting 
connections 

Connection partner 
(partner station)  

Specified 
connection partner 

Unspecified 
connection partner 

All broadcast 
stations 

All multicast 
stations 
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The following connection types are available for communication: 
• Siemens S7 connections, Send/Receive connections (TCP, ISO-on-

TCP and ISO transport) for secured data transfer of data blocks 
between two Ethernet stations 

• UDP for not secured data transfer of data blocks between two stations. 
 

Choose the connection partner and the type of connection and confirm with 
[OK]. 
If activated, a properties dialog for the according connection opens as link 
to your PLC user program. 
At the following pages the relevant parameters of the different connection 
types are shortly described. More information about this may be found in 
the online help of Siemens NetPro respectively of VIPA WinPLC7. 
 

 
 

After every connection was configured by this way, you may save and 
compile your project and exit NetPro. 
To store the CP project engineering data in the system data, you have to 
activate the option "Store project data in the CPU" (default setting) at object 
properties area Options in the hardware configuration of the CP. 
 

Connection types 

Open the 
properties dialog 

Save and compile 
connections 



Manual VIPA System 500S SPEED7 Chapter 6   Deployment Ethernet communication 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  6-25 

For data transfer with Siemens S7 connections the FB/SFB VIPA handling 
blocks are necessary; the deployment is described in the manual 
"Operation list" of your CPU. 
At Siemens S7 connections the communication connections are specified 
by a connection ID for each communication partner. 
A connection is specified by the local and partner connection end point. A 
link. At Siemens S7 connections the TSAPs must be congruent crosswise. 
The following parameters define a connection end point: 
 

Station A    Station B 
remote TSAP → Siemens → local TSAP 
local TSAP ← S7 connection ← remote TSAP 

ID A    ID B 
 
 
The following table shows the combination options with Siemens S7 
connections with deployment of the FB/SFB VIPA handling blocks. 
The handling blocks are more described in the manual "Operation list" of 
the CPU. 
 
  

Connection partner Connection establishing Connection 
specified in NetPro 

(in the current project) 
active/passive specified 

active specified 
unspecified in NetPro  
(in the current project) passive unspecified 

unspecified in NetPro  
(in the unknown project) 

active/passive specified (connection name in an 
other project) 

 
In the following every relevant parameter of a Siemens S7 connection is 
described: 
 

Here you may define how the connection is to be established. Since the 
Siemens SIMATIC manager can identify the communication options by 
means of the end points, some options are already preset and may not be 
changed. 
 
An established connection is precondition for data transfer. By activating 
the option Establish an active connection the local station establishes the 
connection. 
Please regard not every station is able to establish a connection. Here the 
job is to be made by the partner station.  
 
If activated only one-way communication blocks like PUT and GET may be 
used for communication in the user program. Here the partner station acts 
as server, which neither may send active nor receive active 
 

Siemens S7 
connection 

Possibilities of 
combination 

Local connection 
end point 

Establish an active 
connection 

One-way 



Chapter 6   Deployment Ethernet communication Manual VIPA System 500S SPEED7 

6-26  HB145E - CPU - RE_517-4NE02 - Rev. 10/23 

 
 
The ID is the link to your PLC program. The ID must be identical to the ID 
of the call interface of the FB/SFB VIPA handling block. 
 
As soon as you click at [Default], the ID is reset to system generated ID. 
 

In this part of the dialog window the connection path between the local and 
the partner station may be set. Depending on the linking of the modules the 
possible interfaces for communication are listed in a selection field.  
 
With this button a dialog window is opened, which shows address 
information about the local and partner station. The parameters may also 
be changed. 
 
With Siemens S7 connections a TSAP is automatically generated of the 
connection resource (one-way/two-way) and state of place (rack/slot 
respectively system internal ID at PC stations). 
 
The connection resource is part of the TSAP of the local station 
respectively of the partner. Not every connection resource may be used for 
every connection type. Depending on the connection partner and the 
connection type the range of values is limited respectively the connection 
resource is fix specified. 
 

With deploying of Siemens S7 connections the operating may be 
determined by deployment of the FB/SFB VIPA handling blocks in the user 
program. To use this blocks configured communication connections are 
always necessary in the active station.  
More about the usage of these blocks may be found in the manual 
"Operation list" of your CPU. 
The following blocks may be used with Siemens S7 connections: 

FB/SFB Name Description 
FB/SFB 8 USEND Uncoordinated data transmission 
FB/SFB 9 URCV Uncoordinated data reception 

FB/SFB 12 BSEND Sending data in blocks 
FB/SFB 13 BRCV Receiving data in blocks 
FB/SFB 14 GET Remote CPU read 
FB/SFB 15 PUT Remote CPU write 

FB 55 IP_CONFIG Programmed communication Connections 

Block parameters 

Local ID 

[Default] 

Connection path 

[Address details] 

TSAP 

Connection 
resource 

Operating mode 
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At the PLC side for data transfer with these connections the VIPA handling 
blocks AG_SEND (FC 5) and AG_RECV (FC 6) are to be used. 
 
The following connections are Send/Receive connections: 
• TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• ISO transport (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• UDP (SEND-RECEIVE) 
Here the following parameters define a connection end point: 
 

remote port → TCP → local port 
local port ← connection ← remote port 

IP address A    IP address B 
 

remote TSAP → ISO-on-TCP → local TSAP 
local TSAP ← connection ← remote TSAP 

IP address A    IP address B 
 

remote TSAP → ISO transport → local TSAP 
local TSAP ← connection ← remote TSAP 

MAC address A    MAC address B 
 

remote port → UDP- → local port 
local port ← connection ← remote port 

IP address A    IP address B 
 
The following table shows the combination options with the different 
operating modes: 
 

Connection partner 
 

Connection type Conn. establ. Connection Operating mode 

TCP / ISO-on-TCP / 
ISO transport active/passive 

Specified in NetPro 
(in recent project) 

UDP - 

specified SEND/RECEIVE 

active specified SEND/RECEIVE 
part specified 
(Port/TSAP) 

TCP / ISO-on-TCP / 
ISO transport passive 

unspecified 

SEND/RECEIVE 
FETCH PASSIV 
WRITE PASSIV 

Unspecified in NetPro 
(in recent project) 

UDP - specified SEND/RECEIVE 

Unspecified in NetPro  
(in unknown project)  active SEND/RECEIVE 

 
TCP / ISO-on-TCP / 

ISO transport 
passive 

SEND/RECEIVE 
FETCH PASSIV 
WRITE PASSIV 

 UDP - 

specified 
(connection 

name in an other 
project) 

SEND/RECEIVE 

All Broadcast stations UDP - specified (Port, 
Broadcast addr.) SEND 

All Multicast stations UDP - specified (Port, 
Multicast group) SEND/RECEIVE 

In the following each relevant parameters of the different connection types 
are described. 

Send/Receive 
connections 

Possibilities of 
combination 
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In this tab the general connection parameters are listed, which identify the 
local connection end point. 
 
This entry is identical to the entry of the connection table. The value may 
always be changed. Please also regard to adjust the ID parameter of the 
call interface of the FC. 
 
Note! 
If a CP is exchanged by another one, this must at least provide the same 
services and must at least have the same version level. Only this can 
guarantee the connections configured via the CP to remain consistent and 
useable. 
 
This field contains the name of the connection. The name is generated by 
the system and may be changed on every time. 
 
Here is the CP listed, which should be used for connection. With the button 
[Route] the appropriate CP may be selected for communication. 
Do not select the 1. CP of the route for communication connections. The 1. 
CP is always the Ethernet-PG/OP channel, which does not support 
configurable connections. 
 
If activated the connection to the partner is active established by the local 
station. Here the partner is to be specified in the tab "Addresses".  
At an unspecified connection the connection is passive established. 
 

Here the parameters ID and LADDR for your user program are shown. Both 
are parameters, which are to be preset if you use the FC 5 and FC 6 
(AG_SEND, AG_RECEIVE). Please always use the VIPA FCs, which you 
may receive from VIPA. 
 

The Addresses tab displays the relevant local and remote address 
information as proposed values. Depending on the kind of communication 
the address information may remain unspecified. 
 
Ports res. port addresses are defining the access point to the user 
application within the station/CPU. These must be unambiguous. A port 
address should be within the range of 2000...65535. Remote and local 
ports may only be identical with one connection.   
 
ISO-on-TCP and ISO transport support TSAP lengths (Transport Service 
Access Point) of 1...16 byte. You may enter the TSAP in ASCII or 
hexadecimal format. The calculation of the length happens automatically. 

General information 

ID 

     

Name 

Via CP 
[Route] 

Active connection 
establishment 

Block parameters 

Addresses 

Ports 

TSAP 
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Dependent on the specification of the connecting partner the operating 
mode may be set respectively displayed. 
 
SEND/RECEIVE 
The SEND/RECEIVE interface allows the program-controlled com-
munication to any partner station via a configured connection. Here the 
data transfer happens by a call from your user application. The FC5 and 
FC6 that are part of the VIPA block library are serving as interface. 
This enables your control to send messages depending on process events. 
 
FETCH/WRITE PASSIVE 
With the help of FETCH/WRITE services partner systems have the direct 
access to memory areas of the CPU. These are "passive" communication 
connections that have to be configured. The connections are "actively" 
established by the connection partner (e.g. Siemens-S5). 
 
FETCH PASSIVE (request data) 
FETCH allows a partner system to request data.  
 
WRITE PASSIVE (write data) 
This allows a partner system to write data in the data area of the CPU. 
 

Here every configured connections of this station and its partner are 
displayed. These data are information and may not be changed. 
 

Note! 
By appropriate shift respectively delete activities in the Siemens SIMATIC 
manager connections may lose the allocation to the CP. 
These connections are marked with "!" at ID of the overview. 
 
 

Options 

Mode 

Overview 
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Communication connections in the user program  
 

For the execution of connection commands at the PLC, your CPU requires 
an user application. For this, exclusively the VIPA handling blocks are to be 
used, which you may get as library from VIPA. 
More information about the deployment of the blocks may be found in the 
manual "Operation list" of the CPU. 
Depending on the connection type there are blocks for Siemens S7 
connections and Send/Receive connections. 
In the following the proceeding with both connection types is described. 
 

Larger data sets may be transferred between PLC systems based on 
Siemens STEP®7 by means of Siemens S7 connections. Here the stations 
are to be linked by Ethernet. 
Using remote functions with the appropriate function block you can control 
a CPU with another CPU and switch it e.g. to STOP. 
The communication connections are static, this means they are to be 
configured by a connection table. 
 

With the SPEED7 CPUs of VIPA there are two possibilities for the 
deployment of the communication functions: 
• Siemens S7-300 communication functions 

By integration of the function blocks FB 8 ... FB 55 from VIPA you may 
access the Siemens S7-300 communication functions.  

• Siemens S7-400 communication functions 
For the Siemens S7-400 communication functions the SFB 8 ... SFB 15 
are to be used, which were integrated to the operating system of the 
CPU. Here copy the interface description of the SFBs from the standard 
library at system function block to the directory container, generate an 
instance data block for each call and call the SFB with the associated 
instance data block. 

 

Precondition for Siemens S7 communication is a configured connection 
table in which the communication links are defined. For this e.g. WinPLC7 
from VIPA or NetPro from Siemens can be used. A communication link is 
specified by a connection ID for each communication partner. Use the local 
ID to initialize the FB/SFB in the PLC from which the connection is 
regarded and the partner ID to configure the FB/SFB in the partner PLC. 

Overview 

User program at 
Siemens S7 
connections 

Communication 
functions 

Configuring 
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The following function blocks may be used for Siemens S7 commu-
nications. More information about the deployment of the blocks may be 
found in the manual "Operation list" of the CPU. 
 

FB/SFB Label Description 
FB/SFB 8 USEND Uncoordinated data transmission 

FB/SFB 8 USEND may be used to transmit data to a remote partner 
FB/SFB of the type URCV (FB/SFB 9). You must ensure that 
parameter R_ID of both FB/SFBs is identical. The transmission is 
started by a positive edge at control input REQ and proceeds without 
coordination with the partner FB/SFB.  

FB/SFB 9 URCV Uncoordinated data reception 
FB/SFB 9 URCV can be used to receive data asynchronously from a 
remote partner FB/SFB of the type USEND (FB/SFB 8). You must 
ensure that parameter R_ID of both FB/SFBs is identical. 
The block is ready to receive then there is a logical 1 at the EN_R 
input. An active job can be cancelled with EN_R=0. 

FB/SFB 12 BSEND Sending data in blocks 
FB/SFB 12 BSEND sends data to a remote partner FB/SFB of the 
type BRCV (FB/SFB 13). The data area to be transmitted is 
segmented. Each segment is sent individually to the partner. The last 
segment is acknowledged by the partner as it is received, 
independently of the calling up of the corresponding FB/SFB/FB 
BRCV. With this type of data transfer, more data can be transported 
between the communications partners than is possible with all other 
communication FBs/SFBs for configured S7 connections, namely 
65534bytes.  

FB/SFB 13 BRCV Receiving data in blocks 
The FB/SFB 13 BRCV can receive data from a remote partner 
FB/SFB of the type BSEND (FB/SFB 12). The parameter R_ID of both 
FB/SFBs must be identical.  
After each received data segment an acknowledgement is sent to the 
partner FB/SFB and the LEN parameter is updated. 

FB/SFB 14 GET Remote CPU read 
The FB/SFB 14 GET can be used to read data from a remote CPU. 
The respective CPU must be in RUN mode or in STOP mode. 

FB/SFB 15 PUT Remote CPU write 
The FB/SFB 15 PUT can be used to write data to a remote CPU. The 
respective CPU may be in RUN mode or in STOP mode. 

FB 55 IP_CONFIG Programmed Communication Connections 
With this block you may flexible transfer data blocks with configuration 
data to the CP within the user program. 

 

Function blocks 
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The following connections are Send/Receive connections: 
• TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• ISO-on-TCP (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• ISO Transport (SEND-RECEIVE, FETCH-WRITE PASSIVE) 
• UDP (SEND-RECEIVE) 
 
For the communication between CPU and CP, the following FCs are 
available: 
AG_SEND (FC 5) 
This block transfers the user data from the data area given in SEND to the 
CP specified via ID and LADDR. As data area you may set a PA, bit 
memory or data block area. When the data area has been transferred 
without errors, "order ready without error” is returned. 
AG_RECV (FC 6) 
The block transfers the user data from the CP into a data area defined via 
RECV. As data area you may set a PA, bit memory or data block area. 
When the data area has been transferred without errors, "order ready 
without error” is returned. 
 

Note! 
Please regard that you may only use the SEND/RECV-FCs from VIPA in 
your user application for the communication with VIPA-CPs. At a change to 
VIPA-CPs in an already existing project, the present AG_SEND/ AG_LSEND 
res. AG_RECV/AG_LRECV may be replaced by AG_SEND res. AG_RECV 
from VIPA without adjustment. Due to the fact that the CP automatically 
adjusts itself to the length of the data to transfer, the L variant of SEND res. 
RECV is not required for VIPA CPs.  
 

The CP processes send and receive commands independently from the 
CPU cycle and needs for this transfer time. The interface with the FC 
blocks to the user application is here synchronized by means of 
acknowledgements/receipts. 
For status evaluation the communication blocks return parameters that may 
be evaluated directly in the user application. 
These status displays are updated at every block call. 
 

Do not use cyclic calls of the communication blocks in OB 1. This causes a 
permanent communication between CPU and CP. Program instead the 
communication blocks within a time OB where the cycle time is higher res. 
event controlled. 
 

User program at 
Send/Receive 
connections 

     

Status displays 

Deployment at 
high communi-
cation load 
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If a block is called a second time in the user application before the data of 
the last time is already completely send res. received, the FC block 
interface reacts like this: 
AG_SEND 
No command is accepted until the data transfer has been acknowledged 
from the partner via the connection. Until this you receive the message 
"Order running" before the CP is able to receive a new command for this 
connection. 
AG_RECV 
The order is acknowledged with the message "No data available yet" as 
long as the CP has not received the receive data completely. 
 

The following illustration shows a possible sequence for the FC blocks 
together with the organizations and program blocks in the CPU cycle: 
 

OB

Communication
connection

Communication
connection

Communication
connection

PIQ write

PII read

User program

AG_SEND

AG_RECV

AG_RECV

AG_SEND

AG_SEND

AG_RECV

CPU cycle

 
 
The FC blocks with concerning communication connection are summed up 
by color. Here you may also see that your user application may consist of 
any number of blocks. This allows you to send or receive data (with 
AG_SEND res. AG_RECV) event or program driven at any wanted point 
within the CPU cycle.  
You may also call the blocks for one communication connection several 
times within one cycle. 
 

FC call is faster 
than CP transfer 
time 

AG_SEND, 
AG_RECV in the 
user application 
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By means of AG_SEND the data to send are transferred to the CP. 
 
 

Parameter Declaration Type Description 
ACT Input BOOL Activation of the sender 

0: Updates DONE, ERROR and STATUS 
1: The data area defined in SEND with the length LEN  
 is send 

ID Input INT Connection number 1 ... 16 (identical with ID of NetPro) 
LADDR Input WORD Logical basic address of the CP 

(identical with LADDR of NetPro) 
SEND Input ANY Data area 
LEN Input INT Number of bytes from data area to transfer 
DONE Output BOOL Status parameter for the order 

0: Order running 
1: Order ready without error 

ERROR Output BOOL Error message 
0: Order running (at DONE = 0) 
0: Order ready without error (at DONE = 1) 
1: Order ready with error 

STATUS Output WORD Status message returned with DONE and ERROR. More 
details are to be found in the following table. 

 

By means of AG_RECV the data received from the CP are transferred to 
the CPU. 
 
 

Parameter Declaration Type Description 
ID Input INT Connection number 1 ... 16 (identical with ID of NetPro) 
LADDR Input WORD Logical basic address of the CP 

(identical with LADDR of NetPro) 
RECV Input ANY Data area for the received data 
NDR Output BOOL Status parameter for the order 

0: Order running 
1: Order ready data received without error 

ERROR Output BOOL Error message 
0: Order running (at NDR = 0) 
0: Order ready without error (at NDR = 1) 
1: Order ready with error 

STATUS Output WORD Status message returned with NDR and ERROR. More 
details are to be found in the following table. 

LEN Output INT Number of bytes that have been received 
 
 

AG_SEND (FC 5) 

Parameter 

AG_RECV (FC 6) 

Parameter 
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The following table shows all messages that can be returned by the CP 
after a SEND res. RECV command.  
A "-" means that this message is not available for the concerning SEND 
res. RECV command. 
 

DONE 
(SEND) 

NDR 
(RECV) 

ERROR STATUS Description 

1 - 0 0000h Order ready without error 
- 1 0 0000h New data received without error 
0 - 0 0000h No order present 
- 0 0 8180h No data available yet 
0 0 0 8181h Order running 
0 0 1 8183h No CP project engineering for this order 
0 - 1 8184h System error 
- 0 1 8184h System error (destination data area failure) 
0 - 1 8185h Parameter LEN exceeds source area SEND 
 0 1 8185h Destination buffer (RECV) too small 
0 0 1 8186h Parameter ID invalid (not within 1 ...16) 
0 - 1 8302h No receive resources at destination station, receive 

station is not able to process received data fast enough 
res. has no receive resources reserved. 

0 - 1 8304h The connection is not established.  
The send command shouldn’t be send again before a 
delay time of >100ms. 

- 0 1 8304h The connection is not established.  
The receive command shouldn’t be send again after a 
delay time of >100ms. 

0 - 1 8311h Destination station not available under the defined 
Ethernet address. 

0 - 1 8312h Ethernet error in the CP 
0  1 8F22h Source area invalid, e.g. when area in DB not present 

Parameter LEN < 0 
- 0 1 8F23h Source area invalid, e.g. when area in DB not present 

Parameter LEN < 0 
0 - 1 8F24h Range error at reading a parameter. 
- 0 1 8F25h Range error at writing a parameter. 
0 - 1 8F28h Orientation error at reading a parameter. 
- 0 1 8F29h Orientation error at writing a parameter. 
- 0 1 8F30h Parameter is within write protected 1. recent data block 
- 0 1 8F31h Parameter is within write protected 2. recent data block 
0 0 1 8F32h Parameter contains oversized DB number. 
0 0 1 8F33h DB number error 
0 0 1 8F3Ah Area not loaded (DB) 

continued... 

DONE, ERROR, 
STATUS 
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... continue  
DONE 

(SEND) 
NDR 

(RECV) 
ERROR STATUS Description 

0 - 1 8F42h Acknowledgement delay at reading a parameter from 
peripheral area. 

- 0 1 8F43h Acknowledgement delay at writing a parameter from 
peripheral area. 

0 - 1 8F44h Address of the parameter to read locked in access track
- 0 1 8F45h Address of the parameter to write locked in access 

track 
0 0 1 8F7Fh Internal error e.g. invalid ANY reference e.g. parameter 

LEN = 0 . 
0 0 1 8090h Module with this module start address not present or 

CPU in STOP. 
0 0 1 8091h Module start address not within double word grid. 
0 0 1 8092h ANY reference contains type setting unequal BYTE. 
- 0 1 80A0h Negative acknowledgement at reading the module 
0 0 1 80A4h reserved 
0 0 1 80B0h Module doesn’t recognize record set. 
0 0 1 80B1h The length setting (in parameter LEN) is invalid. 
0 0 1 80B2h reserved 
0 0 1 80C0h Record set not readable. 
0 0 1 80C1h The set record set is still in process. 
0 0 1 80C2h Order accumulation. 
0 0 1 80C3h The operating sources (memory) of the CPU are 

temporarily occupied. 
0 0 1 80C4h Communication error (occurs temporarily; a repetition in 

the user application is reasonable.) 
0 0 1 80D2h Module start address is wrong. 

 
 
At a reboot of the CP, the output parameters are reset as follows: 
• DONE = 0 
• NDR = 0 
• ERROR = 8180h (at AG_RECV) 

ERROR = 8181h (at AG_SEND) 
 
 

Information about transferring a project may be found at chapter 
"Deployment CPU ..." at "Project transfer". 
 
 

Status parameter at 
reboot 

Project transfer 



Manual VIPA System 500S SPEED7 Chapter 6   Deployment Ethernet communication 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  6-37 

 NCM diagnostic - Help for error diagnostic 
 

This page shall help you with the error diagnostic. The following page lists a 
number of typical problems and their probable causes: 
 
Question Solution with "no" 
CPU in Run? Control DC 24V voltage supply. 

Set RUN/STOP lever in position RUN. 
Check PLC program and transfer it again. 

AG_SEND, AG_RECV 
in user application? 

These 2 blocks are required in the user 
application for the data transfer between CP and 
CPU. Both blocks must also be called with a 
passive connection. 

Is CP able to connect? Check Ethernet cable (at a point-to-point 
connection a crossed Ethernet cable is to be 
used). 
Check IP address. 

Can data be 
transferred? 

Check Port no. for read and write. 
Check source and destination areas. 
Check if the 2. CP is selected in the route. 
Enlarge the receive res. send buffer defined via 
the ANY pointer.  

Is the complete data 
block sent at ISO-on-
TCP? 

Check the LEN parameter at AG_SEND. 
Set the receive res. send buffer defined via the 
ANY pointer to the required size. 

 

The CP supports the Siemens NCM diagnostic tool. The NCM diagnostic 
tool is part of the Siemens SIMATIC manager. This tool delivers information 
about the operating state of the communication functions of the online CPs 
dynamically.  
The following diagnostic functions are available: 
• Check operating state at Ethernet  
• Read the diagnostic buffer of the CP 
• Diagnostic of connections 
The following pages contain a short description of the NCM diagnostic. 
More details about the function range and for the deployment of the 
Siemens NCM diagnostic tool is to be found in the according online help 
res. the manual from Siemens.  
 

Check list for  
error search 

Siemens NCM  
S7 diagnostic 
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There are two options to start the diagnostic tool: 
• Via Windows-START menu > SIMATIC ... NCM S7 > Diagnostic 
• Within the project engineering res. the hardware configuration via the 

register "Diagnostic" in the "Property" dialog with [Execute]. 
 
The working surface of the diagnostic tool has the following structure: 
The navigation area at the left side contains the hierarchical listed 
diagnostic objects. Depending on CP type and configured connections 
there is an adjusted object structure in the navigation area.  
The information area at the right side always shows the result of the 
navigation function you chose in the navigation area. 
 

Navigation area Information area

 
 
A diagnostic always requires an online connection to the CP you want to 

control. For this click at  at the symbol bar. The following dialog window 
appears: 

 
 

Set the following parameters at destination station: 
Connection...: Ind. Ethernet TCP/IP 
Station addr.: Enter the IP address of the CP 
Module rack/slot:  
Enter the module rack and slot of the CP 343 that you’ve placed at the  
2. slot. 
Set your PG/PC interface to TCP/IP...RFC1006. Via [OK] you start the 
online diagnostic. 

Start NCM 
diagnostic 

Structure 

No diagnostic 
without 
connection  
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The CP has a diagnostic buffer. This has the architecture of a ring memory 
and may store up to 100 diagnostic messages. The NCM diagnostic allows 
you to monitor and evaluate the CP diagnostic messages via the diagnostic 
object Diagnostic buffer. 
Via a double click on a diagnostic message the NCM diagnostic shows 
further information. 
 

You execute a diagnostic by clicking on a diagnostic object in the 
navigation area. More functions are available via the menu and the symbol 
bar. 
 

Note! 
Please always control the preconditions for an operative communication 
using the check at the beginning of this chapter.  
 

For the aimed diagnostic deployment the following approach is convenient: 
 
• Start diagnostic. 

• Open the dialog for the online connection with , enter connection 
parameters and establish the online connection with [OK]. 

• Identify the CP and check the recent state of the CP via module status. 
• Check the connections for particularities like: 

- Connection status 
- Receive status 
- Send status 

• Control and evaluate the diagnostic buffer of the CP via diagnostic 
buffer. 

• As needed, alter project engineering res. programming and restart 
diagnostic. 

 

Read diagnostic 
buffer 

Approach for 
diagnostic 
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Coupling to other systems 
 

The operating mode FETCH/WRITE supported at TCP res. ISO-on-TCP 
can be used for accesses of partner devices to the PLC system memory. 
To be able to use this access also for example for implementation in PC 
applications you have to know the telegram structure for orders. The 
specific headers for request and acknowledgement telegrams have per 
default a length of 16Byte and are described at the following pages. 
 

The organization format is the abbreviated description of a data source or a 
data destination in a PLC environment. The available ORG formats are 
listed in the following table. 
The ERW-identifier is used for the addressing of data blocks. In this case 
the data block number is entered into this identifier. The start address and 
quantity provide the address for the memory area and they are stored in 
HIGH-/LOW- format (Motorola-formatted addresses) 
 

Description Type Range 
ORG identifier BYTE 1...x 
ERW identifier BYTE 1...255 
Start address HILOWORD 0...y 
Length HILOWORD 1...z 

 
The following table contains a list of available ORG-formats. The "length" 
must not be entered as -1 (FFFFh). 
 

ORG identifier 01h-04h 
CPU area DB MB EB AB 
ORG identifier 01h 02h 03h 04h 
Description Source/destination 

data from/into data 
Block in main 
memory. 
 

Source/destination 
data from/into flag 
memory area 

Source/destination 
data from/into process 
image of the inputs 
(PII). 

Source/destination 
data from/into process 
image of the outputs 
(PIQ). 

ERW identifier 
(DBNO) 
 
 
 
 
 

DB, from where the 
source data is 
retrieved or to where 
the destination data is 
transferred. 
 

irrelevant irrelevant irrelevant 

Start address 
significance 
 
 

DBB-No., from where 
the data is retrieved or 
where the data is 
saved. 
 
 

MB-No., from where 
the data is retrieved or 
where the data is 
saved. 
 

IB-No., from where the 
data is retrieved or 
where the data is 
saved. 
 

QB-No., from where 
the data is retrieved or 
where the data is 
saved. 
 

Length 
significance 
 
 

Length of the 
source/destination 
data block in words 
 

Length of the 
source/destination 
data block in bytes 
 

Length of the 
source/destination 
data block in bytes 
 

Length of the 
source/destination 
data block in bytes 
 

 

Overview 

ORG format 
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Note! 
Information about the valid range can be found at Chapter "Hardware 
description of the CPU". 
 

ORG identifier 05h-0Ah 

CPU area PB ZB TB 
ORG identifier 05h 06h 07h 
Description source/destination data 

from/into peripheral 
modules. Input module for 
source data, output module 
for destination data. 
 

source/destination data 
from/into counter cells. 

Source/destination data 
from/into timer cells. 

ERW identifier 
(DBNO) 
 
 
 
 

irrelevant irrelevant irrelevant 

Start address 
Significance 
 

PB-No., from where the data 
can be retrieved or where it 
is saved. 
 
 

ZB-No., from where the data 
can be retrieved or where it 
is saved. 
 

TB-No., from where the data 
can be retrieved or where it 
is saved. 
 

Length 
Significance 
 
 
 

Length of the 
source/destination data 
block in bytes. 
 
 

Length of the 
source/destination data 
block in words 
(counter cell = 1 word). 
 

Length of the 
source/destination data 
block in words 
(counter cell = 1 word). 
 

 

ORG identifier 81h-FFh 
To transfer data blocks of the number range 256 ... 32768 you may use the 
ORG identifier 81h-FFh.  
For the setting of a DB No. >255 needs a length of one word, the DBNOnew 
is assembled from the content of the ORG identifier and the DBNO. 
DBNOnew is created as word as follows: 
 
  DBNOnew  

High-Byte  Low-Byte 
1 X X X X X X X X X X X X X X X

 
 

ORG identifier (0XXXXXXX) 

 
 

DBNO (XXXXXXXX) 
 
If the highest bit of the ORG identifier is set, the Low-Byte of DBNOnew is 
defined via DBNO and the High-Byte of DBNOnew via ORG identifier, where 
the highest bit of the ORG identifier is eliminated.  
The following formula illustrates this:  
 
DBNOnew =256 x (ORG-identifier AND 7Fh) + DBNO 

     

Transfer of blocks 
with numbers 
>255 
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For every FETCH and WRITE the CP generates PLC header for request 
and acknowledgment messages. Normally the length of these headers is 
16Bytes and have the following structure: 
 
 

Request telegram 
Remote Station 

Acknowledgement telegram CP 

System ID ="S5" (Word) System ID ="S5"  (Word)
Length Header =10h (Byte) Length Header =10h (Byte) 
ID OP-Code =01h (Byte) ID OP-Code =01h (Byte) 
Length OP-Code =03h (Byte) Length OP-Code =03h (Byte) 
OP-Code =03h (Byte) OP-Code =04h (Byte) 
ORG block =03h (Byte) Ackn. block =0Fh (Byte) 
Length ORG block =08h (Byte) Length Ack. block =03h (Byte) 
ORG identifier*  (Byte) Error no.  (Byte) 
ERW identifier  (Byte) Empty block =FFh (Byte) 
Start address  (Word) Length empty block =07h (Byte) 
Length   (Word) 5 empty bytes attached 
Empty block =FFh (Byte) 
Length empty block =02h (Byte) 
Data up to 64kByte (only if error no.=0) 

 

Request telegram 
Remote Station 

Acknowledgement telegram CP 

System ID ="S5" (Word) System ID ="S5"  (Word)
Length Header =10h (Byte) Length Header =10h (Byte) 
ID OP-Code =01h (Byte) ID OP-Code =01h (Byte) 
Length OP-Code =03h (Byte) Length OP-Code =03h (Byte) 
OP-Code =05h (Byte) OP-Code =06h (Byte) 
ORG block =03h (Byte) Ackn. block =0Fh (Byte) 
Length ORG block =08h (Byte) Length Ackn. block =03h (Byte) 
ORG identifier*  (Byte) Error no.  (Byte) 
ERW identifier  (Byte) Empty block =FFh (Byte) 
Start address  (Word) Length empty block =07h (Byte) 
Length   (Word) 5 empty bytes attached 
Empty block =FFh (Byte) 
Length empty block =02h (Byte) 

Data up to 64kByte (only if error no.=0) 

*) More details to the data area is to be found at "ORG-Format" above. 
 
 

Note! 
Please regard that in opposite to Siemens-S5 systems, the block 
addressing of these CPUs takes the start address as byte number and the 
length as number of words. 
 

The following messages can be returned via error no.: 
Error no. Message 

00h No error occurred 
01h The defined area cannot be read res. written 

 
 

Structure of PLC-
Header 

WRITE 

FETCH 

     

Messages of  
error no. 
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Chapter 7  Deployment PLC-Tool 
 

This chapter contains the description of the control software PLC-Tool from 
VIPA. PLC-Tool is a component of the OPC-Server package and is 
installed together with the OPC server at the standard installation. The 
OPC-Server package can be found at the enclosed CD SW-ToolDemo. 
 

 

Topic     Page 
Chapter 7 Deployment PLC-Tool..................................................... 7-1 

General ................................................................................................ 7-2 
Setup and run of program .................................................................... 7-3 
PLC-Tool Operation ............................................................................. 7-4 
Deployment PLC-Tool .......................................................................... 7-7 

 

 
 
 
 
 

Overview 

Content 
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General 
 

 

PLC-Tool is a program for operating the CPU 51xS.  
The OPC-Server is required for communicating with the CPU. The OPC-
Server has to be installed on the PC. The PLC-Tool enables you to "talk“ to 
external CPUs which are connected via MPI to the serial interface of the 
PC. 
 

 
 
The operating surface (see figure above), which is a schematically top view 
of a CPU, serves for monitoring and operating the CPU. Here, the status of 
the LEDs on the CPU as well as the position of the mode switch are 
shown. 
 
 When starting the program, it installs itself also as a small icon (Tray-Icon) 
in the windows tool bar.  
 
The Tray-Icon also visualizes the status of the CPU. This example here 
shows the CPU in run  status. The program can be started repeatedly in 
order to simultaneously operate and monitor several CPUs. For each 
connection to a CPU, you have to assign an own MPI-address. 
Any other trademarks referred to in the text are the trademarks of the 
respective owner and we acknowledge their registration. 
 

Overview 

PLC-Tool 

Tray-Icon 
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Setup and run of program 
 

For deployment of the PLC-Tool on your PC there are the following system 
requirements:  
 
• PC with Windows operating system (Windows 2000 or higher, Windows 

XP professional or Windows NT 4.0 Service package 6) 
• at least 32MB work memory (64MB are recommended) 
• for installation about 10MB for OPC-Server and PLC-Tool 
 

The installation of the OPC-Server is required when using PLC-Tool, as the 
required drivers for the PLC-Tool will be installed on your PC by installing 
the OPC-Server. 
 

As the PLC-Tool is a component of the OPC-Server package, the PLC-
Tool will be installed together with the OPC-Server during the standard 
setup. 
The PLC-Tool can also be installed separately. Like installing the OPC-
Server, the installation of the PLC-Tool is supported by a setup-program. 
Close all Windows-programs before starting the setup-program. 
Insert the CD SW-Tool/Demo. The overview will be loaded via the auto-
start function of the CD. From now on, you will be guided through the 
installation. 
 

PLC-Tool can be opened like any other PC-application. You have three 
options: 
Start menu 
In windows start menu, please click OPC! Then click on PLC-Tool! 
Explorer 
You can start the PLC-Tool by double clicking on file: VPLCTool.exe in 
directory C:\Programs\OPC Server. 
Tool bar via Tray-Icon 
As soon as PLC-Tool has been started, tray-icon (mini symbol) is shown in 
the start tool bar. 
PLC-Tool can be opened by double clicking onto that tray-icon. 

System 
requirements 

Requirements 

Setup 

Run of program 
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PLC-Tool Operation 
 

 
 
The operating dialog will be opened after starting the program. 
 

Operating modes
CPU

Status indicator
CPU

Status indicator
Profibus master

Selection of operating
modes

Main menü

Hardware release
Firmware release

 
 

The menu of the program consists of the following entries: 
 
File   CPU Options ?(Help) 
- Minimize - New connection … - Language - Content 
- Exit - Connection diagnosis … - Create link - Help index 
 - Download WLD file - Always on top - Use help  
   - Info 

 
Here, the name of your PLC system is shown. You can enter the name into 
the dialog box CPU > New connection. 
 
The LED states of the corresponding CPU are copied into the status 
indicators. The set up of the status indicator depends on the CPU in use. 
As long as there is not a connection to the CPU, the status indicator is 
deactivated. Additionally, there is a status indication in the tool bar of your 
windows-system (tray-icon). 
 
The push buttons which are accordingly to the operating mode either 
activated or deactivated, serve for adjusting the operating mode of the 
CPU. Additionally the physical status of the operating mode switch is 
shown on the desk top in form of a switch. 

Operating Dialog 

Open operating 
dialog 

Main menu 

Name of the PLC 
system 

Status indicators 

Operating mode 
switch 
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Minimize 
By using the command „minimize“ the operating dialog will be closed.  
The program continues actively and will be stored as icon (tray-icon) on the 
tool bar. 
 
Exit 
Herewith, the program will be stopped and the tray-icon deleted from the 
tool bar. 
 
New connection 
With this command a dialog box will be opened. You can specify your 
connection to the CPU within this dialog box. 
 
Connection diagnosis 
When using this command a dialog box is opened which gives information 
regarding the effective connection. 
 
Download WLD file 
This function allows you to transfer wld files to the module. 
 
Language 
When marking this command, a submenu containing a list of available 
languages for the surface is being opened. The active language is marked 
with a hook. The language on the program surface can be changed by 
clicking on another language. 
 
Note! 
As long as your operating system does not support languages, these 
languages will be shown as deactivated. The languages do exist but it is 
not possible to choose them. 
 
Create link 
Via setting up a link you can set up a link for your CPU connection which is 
momentarily active. In the dialog box you have to mention where you 
stored it. 
 
Always on top 
This function always puts the operating dialog onto the top level of the 
monitor. Therewith, the window is always visible, even then, when you are 
working with different applications. This function is marked with a hook, if 
active. By clicking anew onto that function – it can be deactivated again. 
 

Structure of 
menu 

File 

CPU 

Options 
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Content 
This command opens an overview with topics of online-support. 
 
Help Index 
This command offers the option to have all catchwords regarding 
information for support alphabetically indicated. In that list you can go up 
and down by using the arrow-keys and stop at the word you are looking for 
to mark it. After having marked that word the appropriate text for help will 
be shown. 
 
Use help 
This function opens a window with standard-help for windows. Here, you 
can obtain information for using the help system. 
 
Info 
Via information you will obtain details about revision date of the PLC-Tool 
and copyright. 
 

? (Help) 
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Deployment PLC-Tool 
 

With CPU > New connection the dialog window "Create new adapter" is 
opened. 
To access the CPU 51xS set Connection type to "Ethernet". The following 
dialog window is opened.  

 
 
Please enter here an unique name! The name should signify the PLC 
system in which your CPU is, e.g. "mixer". 
 
Into this dialog box, you may enter an additional description, which explains 
your system more specifically. The assigned name in here will be given as 
tool-tip. If you don’t assign a description – then the name of the adapter will 
be given as "tool-tip". 
 
The initialization by PLC function can only be established if Siemens 
SIMATIC manager and CPU 51xS slot card are at the same PC. 
If the CPU 51xS slot card and PLC-Tool are at the same PC please enter 
here the IP address of the Ethernet part of the CPU 51xS. 
If you want to access the CPU 51xS from an external PC via Ethernet, so 
you have to enter the IP address of the network card of the external PC. 
Additionally you have to set the routing to the CPU 51xS slot card in the 
target PC and to enter this route in the external PC. More concerning this 
may be found at "External access to PG/OP channel via routing". 
 
Please enter here the IP address of the CPU part of the slot card 
 
Leave this parameter at 2. 
 
By clicking at [Finish] a connection to your CPU is established. 
 
Note! 
The adjustments made in the dialog box are only of temporary existence. 
As soon as you close the PLC-Tool, your entries will be deleted. For 
securing your settings you should secure your data in form of a link via 
options > create link. 

Establish 
connection to 
the CPU 

Name of adapter 

Description 

Local IP address 

PLC IP address 

Slot number 
(Rack) 
Finish 
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The following dialog box will be opened under CPU > connection diagnosis: 
 

 
 
 
This dialog box gives information about the effective connection. 
 
 
Similar to the event protocol of windows, for indicating diagnosis data three 
procedure modes are used and are shown via a proper symbol. 
 
The symbols have the following meaning: 
 
 
A procedure was successfully finished. 
 
A procedure is in process. 
 
While in process, an error has occured. 
 
 

Connection 
diagnosis 

Dialog box 

Protocol of 
Procedures 

 

 

 



Manual VIPA System 500S SPEED7 Chapter 7   Deployment PLC-Tool 

HB145E - CPU - RE_517-4NE02 - Rev. 10/23  7-9 

 
 
When clicking Options > create link you reach a dialog box setting up a 
link. By starting the program via that link the PLC-Tool is being started and 
is automatically setting up the stored connection. 
 

 
 
 
It’s possible to enter the following inputs for the link which has to be 
created. 
 
By clicking on the arrow a list with different options is being opened – it 
contains various directories out of the start menu as well as the desk top. 
Choose the requested file for the link with your mouse. 
Via entry „another folder“ you can insert any other file for the link. For this, 
a standard dialog for a new folder is being opened. 
 
Via this selection-list you can see the connections already set up. This list 
is equivalent to the list in menu CPU. 
In this selection-list you can find the connections already set up. You can 
also find this list in the connection-dialog box. 
 
In the menu options > language various languages are listed. Via selection 
list you have the option to choose one of these languages you prefer for 
the link and confirm it by mouse click. 
 
By clicking this option it is reached that the program, when started via the 
link, will not me maximized but will only be started as icon in the tool bar. 
 

Create link 

Dialog box 

Link directory 

Adapter 

Language 

Hidden (as icon 
shown in the tool 
bar) 
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This option enables this program, when being started via the link, always to 
be atop all other programs on the monitor. 
 
Note! 
By saving your link in autostart (all users) with a setting „hidden“ the  PCL-
Tool is being started and secured as tray icon on the tool bar as soon your 
windows system is getting started. 
 

 
 
 
The effective operation mode is indicated by LEDs.  
The effective position of the operating mode switch on the CPU is 
visualized by a graphic in the PLC-Tool. 
 
The switch has the following positions: 
 
The CPU is in run modus. 
 
The CPU is in stop modus. 
 
M-Res (overall reset) – the CPU is in overall reset modus. 
 
 
Next to the operating mode switch there are three push buttons with which 
the CPU can be positioned into the proper operation mode. 
 
The following push buttons can be operated: 
 
The CPU will be set into run modus. 
 
The CPU will be set into run modus. 
 
The CPU will be set into overall reset modus. 
 
 
Note! 
The push buttons are released or disabled for operation depending on the 
current operating mode (LED) and the effective position of the operating 
mode switch. Thereby, you can only use the push buttons which are 
suggestive for the current situation at a time. 
 

Always on top 

 

Change of 
operating mode 

Operating mode 
switch 

 

 

 

Push buttons 
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Each entity of the program installs itself after starting as tray icon located in 
the windows-toolbar. When having finished the program, the tray icon will 
be deleted. 
 
The tray icon has the following formats, according to the operating 
mode of the CPU: 
 
CPU is in run modus 
 
CPU is in start-up (changing from stop into run). 
 
CPU is in stop modus 
 
Status of CPU unknown (no connection). 
 

When strolling over the tray icon with the mouse a small information 
window (tool tip) with the name of the adapter will be displayed. 
The dialog is being opened by double-clicking on the symbol. 
Right mouse click onto the symbol opens a menu via which the dialog can 
be called.  
Besides, finishing of the program is offered via the menu. 
 

Tray-Icon 

 

 

 

 

 

Tool tip 
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For status indication, the PLC-Tool has LED-rows for the CPU and for the 
Profibus master. Use and the proper colors are to be found in below 
mentioned columns. For a detailed description of the LEDs, please refer to 
the manual for the respective CPU! 
 
Not all LEDs listed below have to be always indicated. In fact, the PLC-Tool 
indicates the LEDs only which enable the PLC-Tool to read information 
from the CPU. 
 

Description 
 

Color 
 

Meaning 
 

PWR yellow CPU is supplied with voltage. 
RUN green CPU is in run-status. If LED flashing, CPU is 

in start up. 
STOP red CPU is in STOP status. 
SF red Lights up when system error occurs 
MMC red Flashes when access to MMC 
FRCE yellow Lights up as soon as variables are fixed. 
DESL yellow Indicates Profibus slave activity as long as the 

integrated Profibus master is activated. 
 

Description 
 

Color 
 

Meaning 
 

RUN green Profibus master in operation. If LED flashes, 
Profibus master in start-up. 

ERR red Lights up when breakdown of slave 
DE yellow DE (Data exchange) indicates communication 

via Profibus 
IF red Initializing error when parameterization is faulty 
 
 
 

Status indication 

LEDs 

Status LEDs CPU 

Status of LEDs 
Profibus master 
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Chapter 8  WinPLC7 
 

In this chapter the programming and simulation software WinPLC7 from 
VIPA is presented. WinPLC7 is suited for every with Siemens STEP®7 
programmable PLC. 
Besides the system presentation and installation here the basics for using 
the software is explained with a sample project. 
More information concerning the usage of WinPLC7 may be found in the 
online help respectively in the online documentation of WinPLC7. 
 

 

Topic     Page 
Chapter 8 WinPLC7 .......................................................................... 8-1 

System presentation............................................................................. 8-2 
Installation............................................................................................ 8-3 
Example project engineering ................................................................ 8-4 

 

 
 
 
 
 

Overview 

Content 
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System presentation 
 

WinPLC7 is a programming and simulation software from VIPA for every 
PLC programmable with Siemens STEP®7. 
This tool allows you to create user applications in FBD, LAD and STL. 
Besides of a comfortable programming environment, WinPLC7 has an 
integrated simulator that enables the simulation of your user application at 
the PC without additional hardware. 
This “Soft-PLC” is handled like a real PLC and offers the same error 
behavior and diagnosis options via diagnosis buffer, USTACK and 
BSTACK. 
 
Note! 
Detailed information and programming samples may be found at the online 
help respectively in the online documentation of WinPLC7. 
 

There is also the possibility to use the Siemens SIMATIC manager instead 
of WinPLC7 from VIPA. Here the proceeding is part of this manual. 
 

• Pentium with 233MHz and 64Mbyte work space 
• Graphics card with at least 16bit color - we recommend a screen 

resolution of at least 1024x768 pixel. 
• Windows 98SE/ME, Windows 2000,  

Windows XP (Home and Professional), Windows Vista 
 

You may receive a demo version from VIPA. Without any activation with 
the demo version the CPUs 11x of the System 100V from VIPA may be 
configured.  
To configure the SPEED7 CPUs a license for the "profi" version is 
necessary. This may be online received and activated. 
There are the following sources to get WinPLC7: 
 
At www.vipa.de in the service area at Downloads a link to the current demo 
version and the updates of WinPLC7 may be found. 
 
Order no. Description 
SW211C1DD WinPLC7 Single license, CD, with documentation in german
SW211C1ED WinPLC7 Single license, CD, with documentation in english
SW900T0LA ToolDemo 

VIPA software library free of charge respectively demo 
versions, which may be activated 

 

General 

     

Alternatives 

System 
requirements 

Source 

Online 

CD 
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Installation 
 

The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is 
only possible using an activated "Profi" version of WinPLC7.  
 
 
The installation and the registration of WinPLC7 has the following 
approach:   
• For installation of WinPLC7 start the setup program of the 

corresponding CD respectively execute the online received exe file. 
• Choose the according language. 
• Agree to the software license contract.  
• Set an installation directory and a group assignment and start the 

installation. 
 
• Start WinPLC7. A "Demo" dialog is shown. 
• Press the <q> key. The following dialog for activation is shown: 

 

 
 

• Fill in the following fields: 
Email-Addr., Your Name und Serial number. The serial number may be 
found on a label at the CD case. 

• If your computer is connected to Internet you may online request the 
Activation Key by [Get activation key via Internet]. Otherwise click at 
[This PC has no access to the internet] and follow the instructions. 

• With successful registration the activation key is listed in the dialog 
window respectively is sent by email. 

• Enter the activation key and click to [OK]. Now, WinPLC7 is activated as  
"Profi" version. 

 

To find a station via Ethernet (accessible nodes) you have to install the 
WinPCAP driver. This driver may be found on your PC in the installation 
directory at WinPLC7-V4/WinPcap_4_0.exe.  
Execute this file and follow the instructions. 

Preconditions 

Installation 
WinPLC7  
Demo 

Activation of the  
"Profi" version 

Installation of 
WinPCAP for 
station search via 
Ethernet 
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Example project engineering 
 

In the example a FC 1 is programmed, which is cyclically called by the 
OB 1. By setting of 2 comparison values (value1 and value2) during the FC 
call, an output of the PLC-System should be activated depending on the 
comparison result. 
 
For the output in the simulator the following should apply:  
if value1 = value2 activate output Q 124.0  
if value1 > value2 activate output Q 124.1  
if value1 < value2 activate output Q 124.2  
 
• You have administrator rights for your PC. 
• WinPLC7 is installed and activated as "Profi" version. 
 
For the exclusive deployment in the simulator no hardware configuration is 
necessary. 
 

The PLC programming happens by WinPLC7. 
• Start WinPLC7 ("Profi" version) 
• Create and open a new project by File > Open/create a project. 
 
• Choose File > Create new block.  
• Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is 

called. 
 
In the upper part of the editor there is the parameter table. In this example 
the 2 integer values value1 und value2 are to be compared together. Since 
both values are read only by the function, these are to be defined as "in".   
• Select the "in   -->" row at the parameter table and enter at the field 

Name "value1". Press the [Return] key. The cursor jumps to the column 
with the data type. 

• The data type may either directly be entered or be selected from a list of 
available data types by pressing the [Return] key. Set the data type to 
INT and press the [Return] key. Now the cursor jumps to the Comment 
column.  

• Here enter "1. compare value" and press the [Return] key. A new "in -->" 
row is created and the cursor jumps to Name. 

• Proceed for value2 in the same way as described for value1. 
• Save the block. 
 

Job definition 

Project 
engineering for 
deployment in 
the simulator 

Precondition 

Hardware 
configuration 

Programming of 
the FC 1 

Creating block FC 1 

Creating 
parameters 
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The parameter table shows the following entries, now: 

 
 
As requested in the job definition, the corresponding output is activated 
depending on the comparison of value1 and value2. For each comparison 
operation a separate network is to be created.  
• The program is to be created as FBD (function block diagram). Here 

change to the FBD view by clicking at FBD.  

 
• Click to the input field designated as "empty". 

The available operations may be added to your project by drag&drop 
from the hardware catalog or by double click at them in the hardware 
catalog. 

• Open in the catalog the category "Comparator" and add the operation 
"CMP==I" to your network. 

  
• Click to the input left above and insert value1. Since these are block 

parameters a selection list of block parameters may be viewed by 
entering "#". 

• Type in "#" and press the [Return] key. 
• Choose the corresponding parameter and confirm it with the [Return] 

key. 
• Proceed in the same way with the parameter value2. 

Parameter table 

Enter the program 
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The allocation to the corresponding output, here Q 124.0, takes place with 
the following proceeding: 
• Click to the output at the right side of the operator. 

 
 
• Open in the catalog the category "Bit logic" and select the function 

"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7]. 
• Insert the output Q 124.0 by clicking to the operand. 

  
Network1 is finished, now.  
 
For further comparisons the operations "CMP>I" at Q 124.1 and "CMP<I" 
at Q 124.2 are necessary. Create a network for both operations with the 
following proceeding: 
 
• Move your mouse at an arbitrary position on the editor window and 

press the right mouse key. 
• Select at the context menu "Insert new network". A dialog field is 

opened to enter the position and number of the networks. 
• Proceed as described for "Network 1". 
• Save the FC 1 with File > Save content of focused window respectively 

press [Strg]+[S]. 

Adding a new 
network 
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After you have programmed the still missing networks, the FC 1 has the 
following structure: 
 

 
 

FC 1 
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The FC 1 is to be called from the cycle OB 1.  
• To create the OB 1 either you select File > Create new block or click to 

button [Display OB 1] and create the OB 1. 
• Change to the STL view. 
• Type in "Call FC 1" and press the [Return] key. The FC parameters are 

automatically displayed and the following parameters are assigned: 

 
• Save the OB 1 with File > Save content of focused window respectively 

press [Strg]+[S]. 
 

With WinPLC7 there is the possibility to test your project in a simulator.  
• Here select "Target: Simulator".  

 
• Transfer the blocks to the simulator with PLC > Send all blocks. 
• Switch the CPU to RUN, by clicking to the photo "Switch/Operating 

mode" and select in the dialog window the button [Warm restart]. The 
displayed state changes from STOP to RUN. 

• To view the process image select View > Display process image 
window.  

• Double click to the process image and enter at "Line 2" the address 
PQB124. Confirm with [OK]. A value marked by red color corresponds to 
a logical "1". 

• Open the OB 1 with the button [Display OB 1]. 
• Change the value of one variable, save the OB 1 and transfer it to the 

simulator. According to your settings the process image changes 
immediately. The status of your blocks may be displayed with Block > 
Monitoring On/Off.  

 

Creating the block 
OB 1 

Test the PLC 
program in the 
Simulator 
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A further component of the simulator is the PLC mask. Here a CPU is 
graphically displayed, which may be expanded by digital and analog 
peripheral modules. 
As soon as the CPU of the simulator is switched to RUN state, inputs may 
be activated by mouse and outputs may be displayed. 
• Open the PLC mask with view > PLC mask. A CPU is graphically 

displayed.  
• By clicking the right mouse button within the PLC mask the context 

menu is opened. Choose for this example "Insert 16-port digital input 
module". The module is displayed at the right side of the CPU. 

• Double-click to the output module, open its properties dialog and enter 
the Module address 124. 

• Switch the operating mode switch to RUN by means of the mouse. Your 
program is executed and displayed in the simulator, now. 

 

 
 
 

Visualization via 
PLC mask 
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For the output in the CPU 51xS the following should apply:  
if value1 = value2 activate bit memory M 124.0  
if value1 > value2 activate bit memory M 124.1  
if value1 < value2 activate bit memory M 124.2  
 

• You have administrator rights for your PC. 
• WinPLC7 is installed and activated as "Profi" version. 
• Your CPU 51xS is installed and the PG/OP channel may be accessed 

via Ethernet. 
• WinPCap for station search via Ethernet is installed. 
• The power supply of the CPU and the I/O periphery are activated and 

the CPU is in STOP state. 
 

• Start WinPLC7 ("Profi" version). 
• Create and open a new project by File > Open/create a project. 
• For the call of the hardware configurator it is necessary to set WinPLC7 

from the Simulator-Mode to the Offline-Mode. For this and the communi-
cation via Ethernet set "Target: TCP/IP Direct". 

 

• Start the hardware configurator with . Please regard an object is 
selected with a double click at an object in the hardware configurator.  

• Choose in the register Select PLC-System the parameter 
"VIPA SPEED7" and click to [Create]. A new station is created. 

• Save the empty station. A station name and a comment may be entered 
before saving. 

• By double click choose the according VIPA CPU in the hardware catalog 
at CPU SPEED7. 

• For output place a digital output module and assign the start address 124. 
• Save the hardware configuration. 

Project 
engineering for 
deployment in 
the CPU 51xS 

Precondition 

Hardware 
configuration 
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• Open the CP343 properties by double clicking to the CPU at slot 2 in the 
hardware configurator and selecting [Ethernet CP properties (PG/OP 
channel)] respectively by double clicking at "SPEED7 Ethernet (CP343)" 
slot 11 at UR3. 

• Chose the register Common Options. 
• Click to [Properties Ethernet]. 
• Choose the subnet "PG_OP_Ethernet". 
• Enter a valid IP address-and a subnet mask. You may get this from your 

system administrator. 
• Close every dialog window with [OK]. 
• Select, if not already done, "Target: External TCP/IP direct".  
• Open with Online > Send configuration to the CPU a dialog with the 

same name. 
• Click to [Accessible nodes]. Please regard to use this function it is 

necessary to install WinPCap before!  
• Choose your network card and click to [Determining accessible nodes]. 

After a waiting time every accessible station is listed. Here your CPU 
with IP 0.0.0.0 is listed, too. To check this the according MAC address 
of the CPU is also listed. 

• For the temporary setting of an IP address select you CPU and click to 
[Temporary setting of the IP parameters]. Please enter the same IP 
parameters, you configured in the CPU properties and click to [Write 
Parameters]. 

• Confirm the message concerning the overall reset of the CPU. The IP 
parameters are transferred to the CPU and the list of accessible stations 
is refreshed. 

• Select you CPU and click to [Confirm]. Now you are back in the dialog 
"Send configuration". 

 
• Choose your network card and click to [Send configuration]. After a 

short time a message is displayed concerning the transfer of the 
configuration is finished. 

 

Note! 
Usually the online transfer of the hardware configuration happens within 
the hardware configurator.  
With File > Save active station in the WinPL7 sub project there is also the 
possibility to store the hardware configuration as a system file in WinPLC7 
to transfer it from WinPLC7 to the CPU. 
 

The hardware configuration is finished, now and the CPU may always be 
accessed by the IP parameters as well by means of WinPLC7. 
 

Online access via 
Ethernet PG/OP 
channel  

Transfer hardware 
configuration 
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The PLC programming happens by WinPLC7. Close the hardware 
configurator and return to your project in WinPLC7. 
The PLC program is to be created in the FC 1.  
 
• Choose File > Create new block.  
• Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is 

called. 
 
In the upper part of the editor there is the parameter table. In this example 
the 2 integer values value1 und value2 are to be compared together. Since 
both values are read only by the function, these are to be defined as "in".   
• Select the "in   -->" row at the parameter table and enter at the field 

Name "value1". Press the [Return] key. The cursor jumps to the column 
with the data type. 

• The data type may either directly be entered or be selected from a list of 
available data types by pressing the [Return] key. Set the data type to 
INT and press the [Return] key. Now the cursor jumps to the Comment 
column.  

• Here enter "1. compare value" and press the [Return] key. A new "in -->" 
row is created and the cursor jumps to Name. 

• Proceed for value2 in the same way as described for value1. 
• Save the block. 
 
The parameter table shows the following entries, now: 

 
 
As requested in the job definition, the corresponding output is activated 
depending on the comparison of value1 and value2. For each comparison 
operation a separate network is to be created.  
• The program is to be created as FBD (function block diagram). Here 

change to the FBD view by clicking at FBD.  

 
• Click to the input field designated as "empty". 

The available operations may be added to your project by drag&drop 
from the hardware catalog or by double click at them in the hardware 
catalog. 

 

Programming of 
the FC 1 

Creating block FC 1 

Creating 
parameters 

Enter the program 
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• Open in the catalog the category "Comparator" and add the operation 
"CMP==I" to your network. 

  
• Click to the input left above and insert value1. Since these are block 

parameters a selection list of block parameters may be viewed by 
entering "#". 

• Type in "#" and press the [Return] key. 
• Choose the corresponding parameter and confirm it with the [Return] 

key. 
• Proceed in the same way with the parameter value2. 
The allocation to the corresponding bit memory, here M 124.0, takes place 
with the following proceeding: 
• Click to the output at the right side of the operator. 

 
 
• Open in the catalog the category "Bit logic" and select the function 

"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7]. 
• Enter the bit memory M 124.0 by clicking to the operand. 

  
Network1 is finished, now.  
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For further comparisons the operations "CMP>I" at M 124.1 and "CMP<I" 
at M 124.2 are necessary. Create a network for both operations with the 
following proceeding: 
 
• Move your mouse at an arbitrary position on the editor window and 

press the right mouse key. 
• Select at the context menu "Insert new network". A dialog field is 

opened to enter the position and number of the networks. 
• Proceed as described for "Network 1". 
• Save the FC 1 with File > Save content of focused window respectively 

press [Strg]+[S]. 
After you have programmed the still missing networks, the FC 1 has the 
following structure: 
 

 
 

Adding a new 
network 
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The FC 1 is to be called from the cycle OB 1.  
• To create the OB 1 either you select File > Create new block or click to 

button [Display OB 1] and create the OB 1. 
• Change to the STL view. 
• Type in "Call FC 1" and press the [Return] key. The FC parameters are 

automatically displayed and the following parameters are assigned: 

 
• Save the OB 1 with File > Save content of focused window respectively 

press [Strg]+[S]. 
 

• For transfer to the CPU set the transfer mode to "Target: TCP/IP-
Direct". 

• For presetting the Ethernet data click to [...] and click to  
[Accessible nodes]. 

• Choose your network card and click to [Determining accessible nodes]. 
After a waiting time every accessible station is listed.  

• Choose your CPU, which was provided with TCP/IP address parameters 
during the hardware configuration and click to [Confirm]. 

• Close the "Ethernet properties" dialog with [OK]. 
• Transfer the blocks to your CPU with PLC > Send all blocks. 
• Switch your CPU to RUN state. 
• Open the OB 1 with the button [Display OB 1]. 
• Change the value of one variable, save the OB 1 and transfer it to the 

CPU. According to your settings the process image changes imme-
diately. The status of your blocks may be displayed with Block > 
Monitoring On/Off.  

 

Creating the block 
OB 1 

Transfer PLC 
program to CPU 
and its execution 
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